
OMNIC Paradigm
光谱仪软件

版本 2.2

用户手册
269-335812 修订版 A 2023年1月



© 2023 Thermo Fisher Scientific Inc.保留所有权利。

Microsoft、Windows和 Excel 是 Microsoft Corporation 在美国和 /或其他国家 /地区的商标或注册商标。所有

其他商标都是 Thermo Fisher Scientific Inc.及其子公司的资产。

如需技术支持，请联系：www.thermofisher.com

Thermo Fisher Scientific Inc.为购买产品的客户提供本文档，供客户在操作产品时使用。本文档受版权保

护，未经 Thermo Fisher Scientific Inc.书面许可，严禁复制本文档或本文档中的任何部分。

本文档的内容可能随时更改，恕不另行通知。本文档中的所有技术信息仅供参考。本文档中的系统配置和

规格将取代购买者先前获得的所有信息。

Thermo Fisher Scientific Inc. 不保证本文档的完整性和准确性，而且对于可能因使用本文档( 即使是在正

确遵循本文档中的说明信息的情况下) 而导致的任何错误、疏忽、损害或损失，赛默飞世尔科技概不负

责。

本文档不构成 Thermo Fisher Scientific Inc.和购买方之间的任何销售合约。任何情形下，都不得使用本文

档来取代或修改任何“销售条款与条件”，若两份文档信息发生冲突，则以“销售条款与条件”中的信息为

准。



1. 目录

1. OMNIC Paradigm软件使用入门 6

1.1 欢迎使用 OMNIC Paradigm软件 7

从控制面板管理新的和最近的工作 7

在Spectra View( 光谱视图) 中Process( 处理) 、Analyze( 分析) 和Explore Spectra( 探索光

谱) 8

使用工作流自动化重复任务 9

远程共享您的工作 10

1.2 OMNIC Paradigm 2.2 的新功能 11

Time Series Analysis(时间系列分析) 11

1.3 安装 OMNIC Paradigm软件 12

准备工作 12

安装 OMNIC Paradigm软件 12

设置和连接 OMNIC Paradigm软件 12

1.4 关键概念和功能 14

OMNIC Paradigm软件基本知识 14

后续步骤 17

OMNIC Paradigm软件选项 18

2. 配置您的系统 22

2.1 连接到光谱仪 23

使用 USB连接连接到仪器 23

使用以太网或无线网络连接连接到仪器 23

使用以太网电缆直接连接到仪器 25

2.2 将仪器连接到 Thermo Fisher Connect帐户 32

2.3 配置数据库 34

连接到远程数据库 34

2.4 设置 OMNIC Paradigm选项 35

自定义光谱显示设置 36

设置位数 36

配置自动基线校正 36

将定制徽标添加到报告中 36

3. 教程和演示 38



3.1 使用 ATR 鉴别未知样品 39

准备 ATR 附件 39

设置分析 39

考虑您的谱库 40

测量和分析样品 41

我的样品中有什么？ 44

如果没有明确的( 单一) 匹配怎么办？ 47

如何改进我的分析结果？ 48

如何指定分析的光谱区域 49

3.2 使用透射鉴别未知样品 50

准备透射附件 50

设置分析 50

考虑您的谱库 51

测量和分析样品 52

我的样品中有什么？ 56

如果没有明确的( 单一) 匹配怎么办？ 58

如何改进我的分析结果？ 59

如何指定分析的光谱区域 59

3.3 使用 QCheck验证样品成分 62

执行 QCheck分析 62

改进您的结果 66

从谱库提取光谱 66

后续步骤 66

3.4 定量样品成分 67

执行定量分析 67

改进您的结果 69

后续步骤 69

3.5 创建和运行您的第一个工作流 71

创建工作流 71

将磁贴添加到工作流中 78

关于创建工作流的提示 87

4. 操作指南 90

4.1 管理数据 91

管理谱库 92

备份和还原数据库 95

使用数据库清理工具删除不需要的测量 97

查找测量和报告 98

查看测量历史记录 101

恢复测量 102

复制测量 102



4.2 光谱学 105

测量样品 105

处理数据 119

分析数据 133

创建报告 140

4.3 时间系列分析 147

了解时间系列分析 147

关于时间系列分析 147

创建时间系列分析 149

处理时间系列数据 151

应用方案 151

创建时间系列报告 153

管理时间系列分析 154

4.4 显微镜 156

查看样品 156

准备测量设置 160

捕获拼接图 165

分析样品 168

报告您的显微镜分析结果 176

4.5 使用工作流 178

关于工作流 178

密码保护工作流 182

创建模板工作流 184

工作流磁贴参比 189

4.6 自定义解决方案 209

自定义解决方案 209

创建或编辑工作包 211

Operator Administrator( 操作员管理员) 214

4.7 保护您的数据 216

使用 OMNIC Paradigm软件确保数据的安全性和完整性 217



1. OMNIC Paradigm软件使用入

门
欢迎使用 OMNIC Paradigm软件。了解如何安装和更新您的软件，探索软件选项，以及了解使用 OMNIC Paradigm
软件测量和分析光谱的基本知识。

在本节中：

1.1 欢迎使用 OMNIC Paradigm软件 7

1.2 OMNIC Paradigm 2.2 的新功能 11

1.3 安装 OMNIC Paradigm软件 12

1.4 关键概念和功能 14
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1. OMNIC Paradigm 软件使用入门

1.1 欢迎使用 OMNIC Paradigm软件

用于桌面和触摸屏的 Thermo Scientific™ OMNIC™ Paradigm软件是 FTIR 光谱仪和显微镜的高级软件包，设计用于

简化您采集、处理和解读数据的方式，并帮助您远程工作并与全球同事协作。

从控制面板管理新的和最近的工作

使用 OMNIC Paradigm软件中的新控制面板，可以设置和保存您的测量设置、测量新样品、恢复您最近的工作或运

行自动化工作流，所有这些都可以在同一个便捷的屏幕上进行。

在触摸屏界面中，主屏幕在更加精简、直观的界面中提供了许多相同的工具和功能，从而让操作员可以专注于他

们的工作和他们需要的工具。
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更多内容

l "设置并保存测量选项"

l "测量样品"

l "创建和运行您的第一个工作流"

在Spectra View( 光谱视图 ) 中Process( 处理 ) 、Analyze( 分析 ) 和Explore

Spectra( 探索光谱 )

使用Spectra View( 光谱视图) 可深入处理、分析或探索您的数据。您可以在此处处理数据、查找和标记峰以及优

化视图，以便更轻松地比较或分析光谱。

结果窗格允许您从主视图中快速添加或删除光谱，探索每个光谱的详细信息，或查看所选光谱的更改历史记录。

更多内容

l "使用 ATR 鉴别未知样品"

l "使用透射鉴别未知样品"
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1. OMNIC Paradigm 软件使用入门

使用工作流自动化重复任务

使用工作流自动化您的任务，可确保每次都以完全相同的方式收集和处理测量值。只需在工作流编辑器中拖放磁

贴即可编辑或创建工作流，然后单击按钮运行工作流。

操作员可以使用用于触摸屏的 Paradigm，直接从主屏幕导入和运行我们工厂安装的性能测试之一或自定义工作

流。

更多内容

l "创建和运行您的第一个工作流"

l "工作流磁贴参比"
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远程共享您的工作

将您的数据上传到云端，并使用 OMNIC Anywhere 可通过任何连接的 PC、Apple 计算机、Android 或 iOS设备查

看、分析或共享您的数据。

使用免费的 Connect帐户，可在教室或实验室测量样品，将数据上传到您的 Connect帐户，然后在宿舍或工作区

的另一台设备上查看、探索或共享数据。

更多内容

l 使用 OMNIC Anywhere 应用程序查看数据
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1. OMNIC Paradigm 软件使用入门

1.2 OMNIC Paradigm 2.2的新功能

Time Series Analysis(时间系列分析 )

时间系列分析有助于探索样品测量值如何随时间变化。例如，您可以使用时间序列分析来探索样品在 TGA-IR 或

GC-IR 实验过程中如何演变，或者您可以打开标准测量集合来查看您的测量值在给定的一周或一个月内是否保持一

致，帮助您确认测量值变化的时间。

您还可以通过工作流期间获得的一组重复测量值创建时间系列分析。例如，您可以使用 Repeat( 重复次数) 磁贴

和 Delay( 延迟) 磁贴在给定的时间内重复测量相同的样品，例如每 60 秒测量一次，持续测量一个小时。之后，

您可以在时间系列分析中打开测量，探索样品在工作流期间的变化。

时间系列分析可作为 OMNIC Paradigm软件的附加项提供。有关购买时间系列分析的详细信息，请联系赛默飞世尔

科技。有关创建和使用时间系列分析的详细信息，请参阅"了解时间系列分析"。
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1.3 安装 OMNIC Paradigm软件

OMNIC Paradigm软件预装在 Thermo Scientific™ Nicolet™ Summit光谱仪上，可以随时与连接的触摸屏显示器或通

过 Mini DisplayPort连接的外部显示器一起使用。

将 OMNIC Paradigm软件安装在您的台式机、笔记本电脑或其他设备上，可以通过以太网、WiFi 或 USB连接连接

到 Summit光谱仪或其他仪器，例如 Nicolet iS5 或 iS50 光谱仪。连接到仪器可以测量样品，断开连接可以允许其

他操作员在您分析数据或开发工作流时使用该仪器。

本指南将引导您安装 OMNIC Paradigm软件。

准备工作

您的系统应满足下面列出的建议系统要求才能运行和使用 OMNIC Paradigm软件。

安装 OMNIC Paradigm软件

安装 OMNIC Paradigm软件只需几分钟。

❖ 安装 OMNIC Paradigm软件

1. 插入提供的安装媒体( DVD 或闪存驱动器) 。

2. 运行安装程序。

a. 打开文件并运行 start.exe 文件。

b. 按照屏幕上的提示安装 OMNIC Paradigm软件。

设置和连接 OMNIC Paradigm软件

默认情况下，数据会保存到本地设备上的数据库中。如果连接到 Nicolet Summit光谱仪，可以继续使用您的本地数

据库，或者可以连接到仪器上的数据库或位于您网络上的另一个数据库。

❖ 连接到默认数据库

1. 打开 OMNIC Paradigm软件。

2. 选择 Configure > Database( 配置 >数据库) 。
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1. OMNIC Paradigm 软件使用入门

3. 在 Database Engine( 数据库引擎) 列表中，选择 Thermo Scientific Built-in Database( Thermo Scientific内置

数据库) 。

4. 输入您数据库的服务器地址或 URL。服务器地址或 URL 是您要在网络上连接的仪器的名称。

有关设置数据库的更多信息，请参阅"配置数据库"
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1.4 关键概念和功能

本节介绍使用 OMNIC Paradigm软件的核心概念。本节所提供的信息将可帮助您对 OMNIC Paradigm软件有一个基

本的了解，以便您可以充分利用所有功能和工具来分析您的样品。

OMNIC Paradigm软件基本知识

了解使用 OMNIC Paradigm软件的核心概念将有助于您更有效地收集、分析和报告光谱数据。

您可能并不总是执行以下流程的每一步，并且您可以自定义 OMNIC Paradigm软件来满足您的特定需求，但一般而

言，您可能会遵循一个通用流程：

规划您的项目

开始使用该软件之前，考虑您的项目目标很重要。提前计划将可帮助您决定哪种类型的处理和分析适合您的工

作、哪些测量设置将产生最佳数据，以及如何最有效地执行您的程序。

采集数据之前，您应该能够回答以下问题：

l 我的项目目标是什么？

例如，您是要鉴别未知样品还是要验证您的样品是否符合您的标准。使用 OMNIC Paradigm软件，您可以根据

您使用数据的方式运行不同的流程和分析步骤。常见的目标包括：

l 鉴别纯样品

l 鉴别混合物的组分

l 验证样品是否符合您的规格

l 定量样品的组分

l 我将如何测量我的样品？

OMNIC Paradigm软件支持多种光谱仪采样附件和测量技术。
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1. OMNIC Paradigm 软件使用入门

如需有关如何为您的特定工作选择最佳采集方法的完整讨论，请参阅 FTIR Spectroscopy Academy提供的“FTIR
样品处理技术”。

l 我是否只需规划几个测量，或者这将是一个例行的、重复的程序？

如果您想自动化一个例行程序，您可以创建一个工作流。使用工作流，您可以指定用于收集数据的设置、为

操作员提供说明，以及提前定义数据处理、报告和存档。然后，您或其他操作员即可使用工作流来执行程

序，并且知道每次都将采取完全相同的步骤。

有关新建工作流的分步指南，请参阅"关于工作流"。

采集数据

一旦制定了收集和处理数据的计划，您就可以开始测量样品。通常情况下，要测量样品并收集数据，您将遵循以

下步骤：

1. 准备好光谱仪、采样附件和要测量的样品。

通常，在开始之前，您应该确保您的光谱仪、采样附件和样品已准备就绪。这可能意味着确保光谱仪已预热

并运行良好，已安装采样附件，以及已准备好样品。

设置光谱仪和附件的具体步骤会根据仪器和样品而有所不同。有关准备光谱仪的详细信息，请参阅仪器的用

户指南和教程。或者，参阅 FTIR Spectroscopy Academy，了解有关处理和测量样品的更多信息。

请注意，您必须在没有样品的情况下测量背景。采集背景谱图的最佳时间会根据您要测量的样品类型而有所

不同。

2. 选择或编辑您的测量设置。

仪器准备就绪后，您可以调整软件收集和处理数据的方式，以及设置光谱仪的设置。从控制面板上的菜单中

选择您保存的设置，或个别编辑单个测量的设置。

如需有关如何编辑和保存测量设置的讨论，请参阅"设置并保存测量选项"。

3. 测量背景。

测量样品时，光谱仪会记录样品以及光谱仪中环境的数据。为确保您的样品光谱仅代表您的样品，而没有来

自背景环境的任何数据，您必须测量背景。然后将背景谱图与样品光谱进行比较( 或与其成比例) ，并考虑

来自背景的任何数据，只留下来自样品的数据。

如需有关何时及如何采集背景谱图的完整讨论，请参阅"测量背景"。

4. 测量样品。

最后，您可以测量样品。在测量过程中，您可以预览光谱并优化您的测量设置然后再继续。如果您在设置中

指定了分析类型，数据将在收集后自动处理。

收集数据后，您将可以在光谱视图中查看和探索光谱。
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处理数据

测量样品后，处理数据通常很有帮助，可以更轻松地分析或与其他光谱进行比较。OMNIC Paradigm软件可以帮助

您校正的常见光谱问题包括：

l 倾斜、弯曲、偏移或其他不需要的基线

l 峰被数据中的噪音遮蔽

l 来自 ATR 测量的穿透深度变化

l 来自太厚样品的完全吸收峰

l 大气中 CO2 或 H2O导致的问题

分析样品

OMNIC Paradigm软件具有设计用于帮助您执行常见分析和深入探索光谱数据的工具。常见的分析类型包括：

l 鉴别未知样品或混合物

要鉴别未知样品或混合物的组分，可将样品的光谱与存储在谱库中的参比谱图进行比较。谱库是光谱的集

合，通常包含有关所存储化合物的附加信息。可以创建也可以购买谱库。运行相关性或多组分搜索时，软件

将搜索存储的谱库并查找与样品光谱相似的光谱，以及指示光谱匹配的程度。

有关谱库的更多信息，请参阅"管理谱库"。

有关鉴别未知样品的更多信息，请参阅"使用 ATR 鉴别未知样品"。

l 验证样品的成分

您可以使用 QCheck快速验证样品是否符合您的规格。使用 QCheck，您可以比较两个选定的光谱或将一个或

多个光谱与参比谱图或光谱组进行比较。QCheck结果将光谱之间的相似程度显示为从 0.0( 无相似性) 到 1.0
( 光谱相同) 的匹配值。

l 查找样品中组分的浓度

您在 TQ Analyst软件中创建的定量分析方法可用于 OMNIC Paradigm软件。您可以选择这些定量方法并从

OMNIC Paradigm控制面板运行定量分析。

l 执行自定义的深入分析
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1. OMNIC Paradigm 软件使用入门

OMNIC Paradigm软件具有许多工具，可帮助您进一步探索光谱。例如，Find Peaks( 峰查找) 工具可让您快

速鉴别和标记峰，或者您可以从另一个光谱中减去一个光谱或使用谱图数学运算执行其他运算。

生成报告和保存数据

收集、处理或分析数据后，您可能想要存储或共享这些数据。使用 OMNIC Paradigm软件，您可以自定义存储或导

出数据的方式。

l 导出报告

需要共享数据时，您可以使用模板来自动生成报告。模板可以包括来自谱库搜索、QCheck、定量方法等的结

果，也可以用于将数据直接发送到 Microsoft Word、Excel 或 PowerPoint。

l 存储数据

默认情况下，该软件配置为将数据存储在 MariaDB Server数据库中，但您也可以将该软件配置为用于其他数

据库，例如 Oracle 数据库或 Microsoft SQL Server。

此外，可以将设置、光谱和工作流导出为可以备份、存储或共享的文件。

如需有关 OMNIC Paradigm软件中数据安全选项的讨论，请参阅“21 CFR 第 11 部分合规性”。

后续步骤

您可能并不总是遵循本指南中所描述流程的每一步，但一般而言，了解使用 OMNIC Paradigm软件的整体流程和功

能，将可以让您获得更好的结果。

接下来，开始测量您的第一个样品、查看光谱仪的设置，或创建工作流来自动化例行程序。
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OMNIC Paradigm软件选项

OMINIC Paradigm软件具有三个界面以适合您的设备或任务，并与其他 Thermo Scientific软件搭配，让您能够开发

和运行定量方法或保护和审计您的数据。

OMNIC Paradigm软件界面

可以随时在 OMNIC Paradigm软件的触摸屏和桌面界面之间切换，从而与您的设备和目标完美配合。

触摸屏界面

图 1-1:触摸屏界面具有简化界面，用于简化分析。

触摸屏界面针对小屏幕进行了优化，例如 Thermo Scientific™ Nicolet™ Summit光谱仪的可选触摸屏设备。

使用触摸屏界面可测量和分析样品或在简化界面中运行工作流。
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1. OMNIC Paradigm 软件使用入门

桌面界面

图 1-2:桌面界面包含更广泛的功能和工具，用于更复杂的测量和分析。

在较大屏幕上工作和需要触摸屏界面中没有的附加功能( 例如工作流编辑器以及选择光谱处理和分析工具) 时，

请使用桌面界面。

将您的 Summit光谱仪连接到外部显示器及 USB鼠标和键盘，可以获得使用桌面界面的最佳体验。

OPERATOR( 操作员 ) 界面

Operator( 操作员) 界面用于运行从工作包加载的工作流以及管理工作包。打开工作包后，操作员会看到一个简化

的界面，用于运行工作包工作流。
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有关使用 Operator( 操作员) 界面和开发自定义解决方案的详细信息，请参阅"自定义解决方案"。

在界面之间切换

尽管桌面和触摸屏软件针对不同的任务和设备进行了优化，但可以随时在界面之间切换。

❖ 在触摸屏界面和桌面界面之间切换

l 要从桌面切换到触摸屏，请选择 Configure > View > Touchscreen( 配置 >视图 >触摸屏) 。

软件将短暂关闭然后重新打开并显示触摸屏界面。

l 要从触摸屏切换到桌面，请从主屏幕的菜单中选择 Switch to Desktop( 切换到桌面) 。

软件将短暂关闭然后重新打开并显示桌面界面。

将 OMNIC Paradigm与其他 Thermo Scientific软件搭配

OMNIC Paradigm软件与其他 Thermo Scientific软件兼容，可增加灵活性以及定量分析和数据安全性。

定量分析软件

将 OMNIC Paradigm软件与 TQ Analyst™软件版本 9.8 或更高版本搭配，可以开发和运行可在 OMNIC Paradigm软

件中使用的定量分析方法。

l TQ Analyst EZ版

l TQ Analyst专业版
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1. OMNIC Paradigm 软件使用入门

有关详细信息，请参阅 thermofisher.com上的 “TQ Analyst™ Pro Edition Software”。

数据安全软件

使用 Thermo Scientific™ OMNIC™ Security Suite 软件版本 2.2 或更高版本可确保数据的安全性和完整性。Security
Suite 软件可确保符合 21CFR 第 11 部分，包括以下内容：

l Security Administration( 安全管理) ，针对控制系统访问、处理安全策略，以及制定有关责任和数据完整性的

数字签名

l Audit Manager( 审计管理器) ，用于创建和管理完整的审计跟踪

l Thermo Software IQ工具，用于验证您的安全安装
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2. 配置您的系统
在 OMNIC Paradigm软件中，您可以配置仪器连接和数据库、设置数据库的备份计划、更新软件或自定义显示设置

和其他选项。

在本节中：

2.1 连接到光谱仪 23

2.2 将仪器连接到 Thermo Fisher Connect 帐户 32

2.3 配置数据库 34

2.4 设置 OMNIC Paradigm选项 35
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2. 配置您的系统

2.1 连接到光谱仪

可以通过三种方式将您的笔记本电脑或其他设备连接到您的光谱仪。您选择的连接取决于仪器。

l USB

l 网络连接

l 局域网

l 无线网络

l 直接以太网连接

有关设置、安装和连接到其他设备的更多信息，请参阅仪器的用户指南和帮助内容。

使用 USB 连接连接到仪器

可以使用 USB连接来连接某些仪器。例如，Nicolet iS5 和 Nicolet Summit LITE光谱仪就使用这种类型的连接。

❖ 使用 USB连接连接到仪器

1. 使用 USB电缆，将光谱仪连接到运行 OMNIC Paradigm软件的计算机。

2. 在 OMNIC Paradigm软件中，转到 Configure( 配置) 并选择 Connectivity( 连接) 。

3. 从仪器列表中选择光谱仪并单击 Connect( 连接) 。

使用以太网或无线网络连接连接到仪器

您可以使用以太网或无线网络连接连接到 Nicolet Summit、Summit PRO或 Summit OA光谱仪。连接到仪器之前，

请确保您了解数据库使用情况和用户身份验证。

数据库使用情况

连接到仪器时，您将始终使用客户端系统配置的数据库。

例如，如果您在笔记本电脑上使用 OMNIC Paradigm软件并连接到 Summit光谱仪，您将继续使用笔记本电脑上的

软件配置的数据库。断开与光谱仪的连接时，笔记本电脑上的软件仍会显示连接到光谱仪时收集的数据。如果您

随后直接在 Summit光谱仪上工作，您将看不到使用笔记本电脑收集的任何数据。

若使用共享远程数据库，可见的数据将取决于您使用的系统。例如，如果多台 Summit光谱仪与在笔记本电脑上运

行的 OMNIC Paradigm软件共享一个远程数据库，您可以使用笔记本电脑查看任何仪器收集的数据。但是，任何单

独的光谱仪将只显示在该机器上收集的数据，而不是从任何其他光谱仪收集的数据。

有关配置数据库的更多信息，请参阅"配置数据库"。
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用户身份验证

连接到 Summit光谱仪时，光谱仪需要对您的设备进行身份验证，确保连接安全可靠。

许多组织使用 Windows域来管理设备之间的身份验证。域是一组共享用户帐户信息和安全设置的计算机。管理员

可以使用域来从称为域控制器的单个服务器管理许多设备、帐户和策略。此功能经常允许您使用相同的用户名和

密码登录域中的许多设备。

从笔记本电脑连接到光谱仪时，光谱仪和笔记本电脑都会与域控制器进行通信，确保连接安全可靠。如果任一设

备不在域中，您将无法建立连接。

如果两个设备都由同一个域管理，请使用本地或无线网络连接连接到光谱仪。

❖ 连接到局域网或无线网络上的 Nicolet Summit 光谱仪

如果您的计算机和光谱仪属于共享域( 推荐) ，则使用 WiFi 或以太网连接。开始之前，请确保 Summit光谱仪和

计算机位于同一以太网或 WiFi 网络上。

1. 在 OMNIC Paradigm软件中，转到 Configure( 配置) 并选择 Connectivity( 连接) 。

2. 选择一个光谱仪并单击 Connect( 连接) 。

如果您的光谱仪没有出现在可用仪器列表中，您也可以输入仪器的 IP地址或主机名，然后单击 Connect( 连

接) 。

如果尝试连接时光谱仪已在使用中，则连接可能会被拒绝。有两个原因会导致请求可能被拒绝：

l 仪器正忙于测量样品或处理数据，无法中断。
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l 另一个用户正在操作仪器并选择不放弃控制。

如果当前用户在请求后 30 秒内没有响应，则自动允许连接。

如果请求被自动拒绝或被当前用户拒绝，您可以返回Workstation mode( 工作站模式) ，连接到另一台仪器，

或再次尝试连接。

使用以太网电缆直接连接到仪器

您还可以使用以太网电缆直接连接到光谱仪。

若使用直接连接，需要在光谱仪上编辑本地安全策略。使用此配置时，由于仪器无法与域控制器通信来进行用户

身份验证，因此您必须修改安全策略以允许仪器与计算机之间进行通信。

注释修改安全策略可能会给您的组织带来安全风险。请遵循贵组织的安全策略。
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❖ 使用直接连接

1. 修改仪器上的安全策略

a. 在 Nicolet Summit光谱仪上，打开 Local Security Policy( 本地安全策略) 应用程序。

b. 导航至 Security Settings > Local Policies > Security Options( 安全设置 >本地策略 >安全选项) 。

c. Network access: Let Everyone permissions apply to anonymous users( 网络权限：让 Everyone [每个人 ]权
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限适用于匿名用户) 设为 Enabled( 启用) 。

2. 使用以太网电缆将计算机直接连接到光谱仪。

3. 在 OMNIC Paradigm软件中，如果软件没有自动识别仪器，请转到 Configure > Connectivity( 配置 >连接) 然

后连接到光谱仪。

防止来自不安全设备的连接

如果您的光谱仪使用 Thermo Scientific Security Suite 软件来保护和保护您的数据，您可能需要阻止来自不安全设备

的连接。例如，在默认设置下，如果将不受“安全管理”软件和“审计管理器”软件管理的笔记本电脑连接到安全光谱

仪，则不会管理或记录在笔记本电脑上执行的任何操作。

要防止来自不安全设备的连接，您必须编辑安全光谱仪上的防火墙设置。禁用属于 RabbitMQ 组或 OMNIC
Paradigm的所有入站规则。有关这些规则的附加详细信息，请参阅"防火墙设置"。

下列程序说明了禁用 Windows Defender防火墙中的入站规则。您的组织可能会使用其他应用程序来管理防火墙设

置。

❖ 禁用 Windows Defender防火墙中的入站规则

1. 打开 Windows Defender Firewall with Advanced Security。
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2. 在左窗格中，导航至 Inbound Rules( 入站规则) 。

3. 在主窗格中的 Inbound Rules( 入站规则) 下，选择要禁用的规则。

4. 在 Actions( 措施) 窗格中，单击 Disable Rule( 禁用规则) 。

您选择的规则的 Enabled( 启用) 列变成 No( 否) 。

要重新启用规则，请在 Actions( 措施) 列中，单击 Enable Rule( 启用规则) 。

故障排除

仪器未出现在可用连接中

如果转到 Configure > Connectivity( 配置 >连接) 时您的光谱仪没有自动出现在可用仪器列表中，请检查您的网络

连接。

光谱仪和进行连接的计算机必须在同一网络上，仪器名称才能出现在列表中。例如，如果贵组织有多个无线网

络，请确保光谱仪和计算机在同一网络上。

如果光谱仪的名称没有出现在仪器列表中，您可以通过输入光谱仪的 IP地址尝试连接。

更改计算机名称后无法与服务通信

如果在更改计算机名称后 System Status( 系统状态) 对话框显示系统无法与任何服务通信，则必须修复 OMNIC
Paradigm Prerequisites安装。

有关如何修复安装的说明，请参阅 Microsoft有关如何修复 Windows中的应用程序和程序的支持信息。按照说明修

复 OMNIC Paradigm Prerequisites。

高级故障排除

如果无法连接到光谱仪，则可能需要检查防火墙设置。只有贵组织的 IT或网络管理员可编辑防火墙设置。
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防火墙设置

安装 OMNIC Paradigm软件后，您的防火墙设置将更新以允许光谱仪和 OMNIC Paradigm Workstation 软件之间的连

接。如果您遇到连接问题，请检查光谱仪和所连接计算机上的防火墙设置，确认下列端口允许流量。

下表反映了 Windows Defender防火墙中设置的入站规则。取决于贵组织用于管理网络防火墙设置的应用程序，可

用字段可能会有所不同。

名称 说明和使用的端口

密码管理 (NB-Name-In)

说明：用于密码管理的入站规则，以允许 NetBIOS名称解析。

组：Thermo Scientific密码管理

程序：系统

端口：UDP 137

操作：Allow( 允许)

方案：域、私有、公用

密码管理 (NB-Session-In)

说明：用于密码管理的入站规则，以允许 NetBIOS会话服务连接。

组：Thermo Scientific密码管理

程序：系统

端口：TCP 139

操作：Allow( 允许)

方案：域、私有、公用

密码管理 (SMB-In)

说明：用于密码管理的入站规则，以允许通过命名的管道传输和接收服务器消息

块。

组：Thermo Scientific密码管理

程序：系统

端口：TCP 445

操作：Allow( 允许)

方案：域、私有、公用

表 2-1:所需的入站规则
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名称 说明和使用的端口

Thermo Scientific仪器发现

说明：允许客户端发现此仪器

组：OMNIC Paradigm

程序：C:Program Files\Thermo Scientific\IR Instrument
Engine\Instrument.IR.Engine.Service.exe

端口：UDP 50123

操作：Allow( 允许)

方案：域、私有、公用

ThermoScientificWeb
API Server

说明：允许客户端访问 Web API

组：OMNIC Paradigm

程序：系统

端口：TCP 9004

操作：Allow( 允许)

方案：域、私有、公用

RabbitMQ -对等发现

(EPMD)

组：RabbitMQ

程序：C:\Program Files\erl9.3\erts-9.3\bin\epmd.exe

端口：TCP 4369

操作：Allow( 允许)

方案：域、私有、公用

RabbitMQ -客户端连接

(erl)

组：RabbitMQ

程序：C:\Program Files\erl9.3\erts-9.3\bin\erl.exe

端口：TCP 5671、TCP 5672

操作：Allow( 允许)

方案：域、私有、公用

RabbitMQ -管理控制台

(erl)

组：RabbitMQ

程序：

C:\Program Files\erl9.3\erts-9.3\bin\erl.exe

C:\Program Files\erl9.3\bin\erl.exe

端口：TCP 15672

操作：Allow( 允许)

方案：域、私有、公用
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名称 说明和使用的端口

Thermo Scientific历史

WebAPI

组：OMNIC Paradigm

程序：系统

端口：TCP 9002

操作：Allow( 允许)

方案：域、私有、公用

Thermo Scientific工作流引

擎

组：Thermo Scientific工作流引擎

程序：系统

端口：TCP 9090

操作：Allow( 允许)

方案：域、私有、公用
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2.2 将仪器连接到 Thermo Fisher Connect帐户

将仪器连接到您的 Thermo Fisher Connect帐户，可以远程查看和管理仪器和数据。

有关 Thermo Fisher Connect和管理所连接仪器的更多信息，请参阅 Thermo Fisher Connect应用程序中的帮助指

南。

准备工作

要将您的仪器连接到 Thermo Fisher Connect，您需要一个 Thermo Fisher Connect帐户。要创建帐户，请访问

https://www.thermofisher.com/us/en/home/digital-science/thermo-fisher-connect.html。

❖ 将您的仪器连接到您的 Thermo Fisher Connect 帐户

1. 使用 OMNIC Paradigm软件的桌面界面，从 Dashboard( 控制面板) ，转到 Acquire Data > Diagnostics >
Instrument Health( 采集数据 >诊断 >仪器状态) 。

2. 可选：Opt-in( 选择) 以共享仪器健康数据。

3. 单击 Link Instrument( 链接仪器) 。

4. 要完成连接，可使用移动设备上的 Thermo Fisher Instrument Connect应用程序扫描二维码或使用 6 位代码。

l 使用 6 位代码

a. 单击 Copy( 复制) 将代码复制到剪贴板。

b. 在 Web 浏览器中转到 Thermo Fisher Connect。
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c. 在 Thermo Fisher Connect网络应用程序的控制面板中，在 My Instruments( 我的仪器) 下，粘贴或输

入 6 位代码，然后单击 Link( 链接) 。

仪器现在显示在 Thermo Fisher Connect的 InstrumentConnect部分。

l 扫描二维码

a. 在您的移动设备上打开 Instrument Connect应用程序。

b. 点按屏幕右上角的 +图标以添加仪器。

c. 选择 QR Code( 二维码) 。

d. 使用您的设备扫描二维码。

仪器已链接并显示在移动应用程序和线上。
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2.3 配置数据库

当您第一次安装 OMNIC Paradigm软件时，默认数据库已在本地设备上设置并可供使用。您可以继续使用本地数据

库或连接到网络上其他位置的远程数据库。使用远程数据库可在设备之间轻松共享测量、设置和其他数据。

连接到远程数据库

连接到远程数据库可在设备之间轻松共享测量、设置和其他数据。随时更改数据库配置以适应您的工作。

❖ 连接到远程数据库

1. 使用 OMNIC Paradigm软件的桌面界面，转到 Configure( 配置) 并选择 Database( 数据库) 。

2. 从 Database( 数据库) 列表中选择数据库类型。默认选择为 Thermo Scientific内置。要连接到自定义数据库，

请输入数据库类型、版本、名称和端口。您可能还需要输入用户名和密码。

3. 输入数据库服务器的 IP地址或 URL。

4. 单击 Test Connection( 测试连接) 检查软件是否可以连接到服务器。

5. 如果测试报告有效连接，单击 OK( 确定) 连接到远程数据库。

软件会在连接期间重新启动。

检查控制面板上的 Measurements( 测量) 组，确认您正在查看来自远程数据库的数据，或返回 Configure >
Database( 配置 >数据库) 菜单查看您当前的连接。
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2.4 设置 OMNIC Paradigm选项

使用 Options( 选项) 对话框可自定义光谱显示，设置用于峰面积、峰高和峰位的位数，以及配置自动基线校正。

❖ 设置并保存 OMNIC Paradigm选项

1. 打开 Options( 选项) 对话框。

l 桌面界面：打开 Configure( 配置) 菜单并选择 Options( 选项) 。

l 触摸屏界面：打开设置并导航至 Options( 选项) 选项卡。

2. 选择 New( 新建) 。

3. 输入新选项的名称，然后单击 Save( 保存) 。

4. 编辑您的设置。

5. 完成编辑设置后，单击 Save( 保存) 以保存您的更改。

6. 选择 Close( 关闭) 返回上一个屏幕。

图 2-1:Options( 选项) 对话框
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自定义光谱显示设置

Spectral Display( 光谱显示) 组用于设置光谱视图中光谱的颜色和线宽。

l Line Weight( 线宽) ：确定用于绘制光谱的线的粗细。适用于光谱视图中显示的所有光谱。

l Selected Spectrum Color( 选择光谱颜色) ：确定用于突出显示当前选定光谱的颜色。

可使用附加颜色来设置未选择的光谱颜色。

设置位数

使用 Number of Digits( 位数) 组可设置小数点分隔符后的位数限制。该限制适用于以下各项：

l Peak area( 峰面积)
l Peak height( 峰高)
l Peak location - X value( 峰位 - X值)
l Peak location - Y value( 峰位 - Y值)

请注意，此设置仅适用于调整设置后进行的操作。光谱信息中的数字保持记录时使用的设置，不会更新以反映新

设置。例如，如果您使用指定 3 位数的设置执行峰查找操作，则光谱信息显示为 3 位数。如果您随后将设置更改

为仅使用小数点后的 1 位数字，则先前峰查找操作中的光谱信息仍将显示 3 位数字。

配置自动基线校正

使用 Process( 处理) 菜单中的 Automatic Baseline Correct( 自动基线校正) 可自动校正倾斜或弯曲的基线。

设置多项式阶次和迭代次数可指定公式的阶次和迭代次数以用于自动校正基线。

将定制徽标添加到报告中

在报告和模板报告上使用您自己的徽标。图像显示在标准报告和您使用工作流中的模板报告磁贴创建的报告上。

报告图像必须是 PNG文件，并自动调整为 120 像素 x 75 像素。
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3. 教程和演示
本节提供的教程将可帮助您了解用于 OMNIC Paradigm软件的一些最常用技术，包括鉴别、定量和验证样品，以及

创建和运行工作流以自动化您最常用的任务。

这些教程旨在让 OMNIC Paradigm软件的新手尽可能轻松地访问这些教程。如果您更喜欢自己开始，请参阅"测量

背景"以开始测量您的样品。如果您更喜欢更具概念性的概述，请参阅"关键概念和功能"。

在本节中：

3.1 使用 ATR 鉴别未知样品 39

3.2 使用透射鉴别未知样品 50

3.3 使用 QCheck验证样品成分 62

3.4 定量样品成分 67

3.5 创建和运行您的第一个工作流 71
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3. 教程和演示

3.1 使用 ATR鉴别未知样品

您的 FTIR 光谱仪和 OMNIC Paradigm软件可以帮助您确定未知样品的成分。本文演示了如何使用衰减全反射

(ATR)采样技术来测量和分析样品。这是从样品材料中采集 FTIR 数据的一种常见且“无干扰”的技术。本文包含许多

示例，可帮助您建立解读分析结果的信心。

您将学习如何：

l 准备 ATR 附件

l 设置和运行分析，以及

l 评估和确认结果

按照这些说明使用 ATR 采样技术测量和分析未知的纯样品。

准备 ATR 附件

首先，确保您的 ATR 附件已插入光谱仪样品室并安装了合适的晶体。每种晶体材料都提供某种采样优势，例如更

宽的光谱范围、更高的能量吞吐量或更高的耐用性。正确的选择取决于可用的晶体、哪种晶体最适合您的样品材

料，以及哪种晶体能产生所需的信息。有关更多信息，请参阅 ATR 附件随附的信息。

这是 Thermo Scientific™ Everest ATR 附件，带有安装在 Nicolet™ Summit FTIR 光谱仪中的钻石晶体。

确保晶体干净，以便光谱仪在准备就绪时可以进行准确的背景测量。要清洁水晶，请用软布轻拍。如果晶体需要

更严格的清洁，请参阅 ATR 附件随附的用户指南。该指南应列出适用于每种晶体类型的清洁溶剂。

设置分析

下一步是设置 OMNIC Paradigm软件。打开软件后，您会在主窗口中看到控制面板。重要的测量设置位于顶部。
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首先，确保 Sampling Accessory( 采样附件) 读数显示安装的附件。如果没有，请重新安装附件。请注意，该配件

的出厂预设显示在“Settings”( 设置) 下方。

然后输入测量名称，或者您可以保留建议的名称，即测量的确切日期和时间。

接下来，确保将 Analysis Type( 分析类型) 设为 Search( 搜索) 。这将执行样品光谱与 FTIR 谱库光谱的逐点比

较。输出的质量取决于所选谱库中光谱的光源和质量。

最后，检查采集设置( 样品扫描、分辨率和最终格式) 。上面显示的设置都是此分析的良好起始值。

需要注意的是，您采集的样品数据质量会影响分析结果。例如，通过测量较少的扫描来加快分析，或降低分辨率

可能会导致分析结果不太确定。

考虑您的谱库

默认情况下将自动选择所有现有的谱库。在 Identify( 鉴别) 菜单中选择 Search Setup( 搜索设置) 查看或更改您

的谱库选择。
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3. 教程和演示

在本演示中，我们使用 OMNIC Paradigm软件提供的免费谱库。

选择 Cancel( 取消) 关闭 Search Setup( 搜索设置) 窗口。

您还可以使用同一菜单中的 Library Manager( 谱库管理器) 轻松创建谱库。您创建的任何谱库都应该来自代表您

期望在未知样品中所找到成分的纯材料。

谱库光谱的质量通常与样品光谱相同或更高。如果使用相同的采样技术( 本实例为 ATR) 采集这些光谱，这也很

有帮助。如果使用透射技术采集您的谱库光谱，OMNIC Paradigm软件具有可应用于样品光谱的校正来改善结果。

您将在本文后面了解更多相关信息。

执行搜索之前，无需对样品数据执行最终格式、分辨率或光谱范围等转换 -软件会为您完成这些转换。

测量和分析样品

要开始分析，请单击 Preview and Measure Sample( 预览并测量样品) 。
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将从测量背景开始进行分析。ATR 背景的唯一要求是确保晶体干净。背景谱图用于消除样品数据中由光谱仪、

ATR 晶体或背景环境产生的任何信号。

软件在光谱窗格中显示当前背景谱图的预览。下面显示的背景形状是典型的钻石晶体。

单击 Start Background Measurement( 开始背景测量) 。

完成背景测量后，其图像会出现在结果面板和光谱窗格中。
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3. 教程和演示

如果您的样品是液体，请升高压力塔架并将它旋转到一边。用干净的移液管在晶体上滴一滴。请记住，晶体类型

的大小各不相同，有些可能需要更多样品。使用刚好足以完全覆盖晶体的样品。

图 3-1:使用 ATR 测量液体

对于固体样品，逆时针旋转压力塔架上的旋钮将臂升高。然后将样品放在晶体上并顺时针旋转旋钮将臂降下。继

续旋转旋钮直到发出咔嗒声。在本演示中，我们测量的是一张塑料卡片。
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图 3-2:使用 ATR 测量固体

样品就位后，单击 Preview Sample( 预览样品) ，在光谱窗格中预览样品数据。如果预览光谱中的峰非常小，请

使用浓度更高的液体样品。如果您测量的是固体，请将样品重新放置在 ATR 晶体上并重新施加压力。

如果光谱没有样品峰，检查样品材料是否在光谱的红外区域吸收能量。如果在光谱中观察到额外的峰，请确保晶

体干净。

当您准备好继续时，选择 Start Sample Measurement( 开始样品测量) ( 见上图) 并等待进度条完成。软件会快速

将样品光谱与所选谱库光谱进行比较并显示结果。

我的样品中有什么？

光谱窗格显示样品光谱以及来自所选谱库的最佳匹配光谱。两个光谱以相同的 Y轴刻度重叠，因此您可以直观地

比较结果。( 如果光谱非常相似，就像本实例中的一样，还有其他视图会突出显示差异。我们稍后会详细讨

论。) 结果面板会显示 5 个最佳匹配光谱的列表，以及它们的匹配值。
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3. 教程和演示

图 3-3:使用相同的 Y轴刻度一起显示的样品和最佳搜索结果

1. 样品谱图( 红色)

2. 最佳匹配( 黄色)

3. 结果面板

匹配值告诉您每个谱库光谱与未知样品的匹配程度。该值越接近 100，匹配越好。

在此示例中，最佳匹配的匹配值大于 90，这表示匹配良好。列表中下一个光谱的匹配值远低于该值。
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图 3-4:显示明确最佳匹配的匹配值

观察光谱窗格中的叠加光谱，主峰的位置沿 X轴排列，它们仅在峰高上有所不同。

图 3-5:显示明确匹配的叠加光谱

单击 Stack( 分层) 按钮可查看两个缩放以填充每个 Y轴的光谱。同样，除了样品光谱的低频区域基线略微升高

外，光谱匹配良好。因此，我们可以得出结论，样品是聚乙烯，并且分析已完成。
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图 3-6:显示低频区域微小差异的分层谱图

要获取有关匹配列表中谱图的更多信息，包括它来自的谱库及其标识号，请将光标悬停在结果面板中谱图的灰色

箭头上。

图 3-7:谱库光谱的 Information( 信息) 按钮

如果没有明确的 ( 单一 ) 匹配怎么办？

如果分析结果显示多个匹配项都具有相似的匹配值，如本例所示，按住 Shift键并单击结果面板中的三个匹配项，

将所有三个光谱添加到光谱窗格中。
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图 3-8:显示数个相似匹配的分层谱图

如何改进我的分析结果？

如果没有出现明确的匹配，则可以考虑多种可能改进结果的选项。( 调整某些设置将需要新的背景测量。)

图 3-9:显示带有可更改测量设置的搜索结果
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3. 教程和演示

首先，您可以返回控制面板并调整未知样品的 Resolution( 分辨率) 设置。例如，您可以通过使用较低的

Resolution( 分辨率) 设置来以较高的分辨率采集光谱。如果样品峰更尖锐或更多，您可能会获得更好的分析结

果。

您还可以采集更多扫描( 请参阅上图) 以减少光谱噪声，这也会影响结果。然后通过选择 Identify( 鉴别) ( 菜

单) > Correlation Search( 相关性搜索) 或单击工具栏上的 Search( 搜索) 按钮来重新开始分析。

如果样品光谱具有倾斜或弯曲的基线，请尝试对样品光谱应用 Automatic Baseline Correction( 自动基线校正)
( Process [处理 ]菜单) ，然后重新开始分析。

如果需要搜索透射光谱，可尝试使用 Advanced ATR Correction( 高级 ATR 校正) ( Process [处理 ]菜单) ，然后重

复分析。此校正将会调整 ATR 光谱，使其看起来更像透射光谱，从而可以改进结果。

如何指定分析的光谱区域

如果样品光谱中有一个峰超出 Y轴刻度，您可能需要从分析中排除该峰。示例：

图 3-10:完全吸收峰示例

这些“平顶”峰被称为“完全吸收”峰，可能包含过多的光谱噪声，从而影响分析结果。要排除完全吸收峰，可打开搜

索设置，取消选择 Use full spectral range( 使用全光谱范围) ，然后指定要搜索的区域以排除完全吸收区域。
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3.2 使用透射鉴别未知样品

您的 FTIR 光谱仪和 Thermo Scientific™ OMNIC Paradigm软件可以帮助您鉴别未知样品的化学成分。本文演示了如

何使用红外透射来测量和分析样品。“透射”是指红外光束直接穿过样品。透射是采集 FTIR 数据的常用技术。本文

包含许多示例，可帮助您建立解读分析结果的信心。

您将学习如何：

l 准备透射附件

l 设置和运行分析，以及

l 评估和确认结果

准备透射附件

首先，确保您的透射附件或样品架已插入光谱仪样品室。这是我们的 Nicolet™ Summit FTIR 光谱仪中的 Thermo
Scientific™ iD1 透射附件。

从您的附件或样品架中取出任何样品，以便光谱仪在准备就绪时即可进行准确的背景测量。 iD1 附件盖可以打开或

关闭。( 如果您的透射附件使用干燥空气或氮气吹扫，除了添加或取出样品，请保持盖子关闭。)

设置分析

下一步是设置 OMNIC Paradigm软件。打开软件后，您会在主窗口中看到控制面板。重要的测量设置位于顶部。
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3. 教程和演示

首先，确保 Sampling Accessory( 采样附件) 读数显示安装的附件。如果没有，请重新安装附件。请注意，该配件

的出厂预设显示在“Settings”( 设置) 下方。

然后输入测量名称，或者您可以保留建议的名称，即测量的确切日期和时间。

接下来，确保将 Analysis Type( 分析类型) 设为 Search( 搜索) 。

这将执行样品光谱与 FTIR 谱库光谱的逐点比较。输出的质量取决于所选谱库中光谱的光源和质量。

最后，检查采集设置( 样品扫描、分辨率和最终格式) 。上面显示的设置都是此分析的良好起始值。

需要注意的是，您采集的样品数据质量会影响分析结果。例如，通过测量较少的扫描来加快分析，或降低分辨率

可能会导致分析结果不太确定。

考虑您的谱库

默认情况下将自动选择所有现有的谱库。在 Identify( 鉴别) 菜单中选择 Search Setup( 搜索设置) 查看或更改您

的谱库选择。在本演示中，我们使用 OMNIC Paradigm软件和 Nicolet Summit Pro 光谱仪提供的免费谱库。
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选择 Cancel( 取消) 关闭 Search Setup( 搜索设置) 窗口。

您还可以使用同一菜单中的 Library Manager( 谱库管理器) 轻松创建谱库。您创建的任何谱库都应该来自代表您

期望在未知样品中所找到成分的纯材料。

谱库光谱的质量通常与样品光谱相同或更高。如果使用相同的采样技术( 本实例为透射) 采集这些光谱，这也很

有帮助。执行搜索之前，无需对样品数据执行最终格式、分辨率或光谱范围等转换 -软件会为您完成这些转换。

测量和分析样品

要开始分析，请单击 Preview and Measure Sample( 预览并测量样品) 。
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3. 教程和演示

将从测量背景开始进行分析。透射背景的唯一要求是从红外光束路径中取出任何样品。背景谱图用于消除样品数

据中由光谱仪、透射附件或样品架或背景环境产生的任何信号。

软件在光谱窗格中显示当前背景谱图的预览。下面的示例显示了使用未用干燥空气或氮气吹扫和已吹扫的透射附

件进行透射分析的典型背景谱图。

图 3-1:来自未吹扫的透射附件的背景谱图

图 3-2:来自已吹扫的透射附件的背景谱图

单击 Start Background Measurement( 开始背景测量) 。
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完成背景测量后，其图像会出现在结果面板和光谱窗格中。

要安装已安装的薄膜样品，请打开透射附件的盖子，然后将样品或样品架滑入最适合样品或样品架宽度的槽中。

如果您的样品或支架允许，请选择一个靠近光束焦点的槽( 对于 iD1 附件，该槽大概位于样品室的中心) 。在本

演示中，我们测量的是安装在样品卡上的塑料薄膜。
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3. 教程和演示

图 3-3:iD1 透射附件光束焦点

样品就位后，单击 Preview Sample( 预览样品) ，在光谱窗格中预览样品数据。

55 OMNIC Paradigm软件用户指南 ThermoScientific



如果预览光谱中的峰非常小，则尝试使用较厚的样品。如果光谱没有样品峰，检查样品材料是否在红外光谱中传

输能量。

当您准备好继续时，选择 Start Sample Measurement( 开始样品测量) ( 见上图) 并等待进度条完成。软件会快速

将样品光谱与所选谱库光谱进行比较并显示结果。

我的样品中有什么？

光谱窗格显示样品光谱以及来自所选谱库的最佳匹配光谱。两个光谱以相同的 Y轴刻度重叠，因此您可以直观地

比较结果。( 如果光谱非常相似，就像本实例中的一样，还有其他视图会突出显示差异。我们稍后会详细讨

论。) 结果面板会显示 5 个最佳匹配光谱的列表，以及它们的匹配值。

图 3-4:使用相同的 Y轴刻度一起显示的样品和最佳搜索结果

1. 样品谱图( 红色)

2. 最佳匹配( 蓝色)

3. 结果面板

匹配值告诉您每个谱库光谱与未知样品的匹配程度。该值越接近 100，匹配越好。

在此示例中，最佳匹配的匹配值大于 85，这表示匹配良好。列表中下一个光谱的匹配值远低于该值。
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图 3-5:显示明确匹配的匹配值

观察光谱窗格中的叠加光谱，主峰的位置沿 X轴排列，它们仅在峰高上有所不同。

图 3-6:显示明确匹配的叠加光谱

单击 Stack( 分层) 按钮可查看两个缩放以填充每个 Y轴的光谱。同样，除了样品光谱的低频区域基线略微升高

外，光谱匹配良好。因此，我们可以得出结论，样品是聚乙烯，并且分析已完成。
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图 3-7:显示明确匹配的分层谱图

要获取有关匹配列表中谱图的更多信息，包括它来自的谱库及其标识号，请将光标悬停在结果面板中谱图的灰色

箭头上。

图 3-8:谱库光谱的 Information( 信息) 按钮

如果没有明确的 ( 单一 ) 匹配怎么办？

如果分析结果显示多个匹配项都具有相似的匹配值，如本例所示，按住 Shift键并单击结果面板中的三个匹配项，

将所有三个光谱添加到光谱窗格中进行详细比较。
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图 3-9:显示数个相似匹配的分层谱图

如何改进我的分析结果？

如果没有出现明确的匹配，则可以考虑多种可能改进结果的选项。( 调整某些设置将需要新的背景测量。)

首先，您可以返回控制面板并调整未知样品的 Resolution( 分辨率) 设置。例如，您可以通过使用较低的

Resolution( 分辨率) 设置来以较高的分辨率采集光谱。如果样品峰更尖锐或更多，您可能会获得更好的分析结

果。您还可以采集更多扫描以减少光谱噪声，这也会影响结果。

如果样品光谱具有倾斜或弯曲的基线，请尝试对样品光谱应用 Automatic Baseline Correction( 自动基线校正)
( Process [处理 ]菜单) 。然后通过选择 Identify( 鉴别) ( 菜单) > Correlation Search( 相关性搜索) ，或单击工

具栏上的 Search( 搜索) 按钮来重新开始分析。

如何指定分析的光谱区域

如果样品光谱中有一个峰超出 Y轴刻度，您可能需要从分析中排除该峰。示例：
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图 3-10:完全吸收峰示例

这些“平顶”峰被称为“完全吸收”峰，可能包含过多的光谱噪声，从而影响分析结果。

要排除完全吸收峰，选择 Identify( 鉴别) ( 菜单) > Search Setup( 搜索设置) 并使用工具选择要搜索的区域。

首先，取消选中 “Use Full Spectral Range”( 使用全谱图范围) 复选框以启用区域工具。

图 3-11:用于选择要搜索的区域的工具
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然后放置垂直条以选择要搜索的第一个区域。

要添加搜索区域，单击 Add( 添加) 按钮并使用第二组垂直条选择下一个区域。在这里，我们使用第一组垂直条

来选择完全吸收峰左侧的区域。然后我们添加一个区域并使用第二组垂直条选择完全吸收峰右侧的区域。

完成选择区域后，单击 Save( 保存) 返回 Dashboard( 控制面板) 视图，然后单击工具栏上的 Search( 搜索) 按

钮重新运行搜索。
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3.3 使用 QCheck验证样品成分

使用 QCheck分析验证样品质量。使用 QCheck，可以将您的样品与已知参比进行比较，并在结果中报告您的样品

与参比之间的相关性值，让您快速验证您的样品是否符合您的规格。

本指南将引导您完成一个示例 QCheck分析。

先决条件

本指南假设您已经设置好仪器和采样附件。有关安装采样附件的说明，请参阅仪器随附的文档。

您还需要至少一个谱图用作参比。您可以指定数据库中的任何光谱作为参比谱图。要使用谱库中的谱图，首先从

谱库中提取谱图，使其在数据库中可用。有关详细信息，请参阅"从谱库提取光谱"

执行 QCheck分析

运行 QCheck分析需要设置分析和测量设置、测量背景、测量样品并解读结果。最后，完成分析后，可以创建并保

存报告。

❖ 使用 QCheck验证样品成分

1. 设置分析。

测量样品之前，查看您的分析设置。

a. 导航至 Identify > Qcheck Setup( 鉴别 > QCheck设置) 。

b. 查看 QCheck Setup( QCheck设置) 选项。
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设置 说明

High Sensitivity( 高灵敏度)
在与参比谱图非常相似的样品之间选择高灵敏度以获得更精确的结果。如果测量

具有某些自然变化的样品，您可能需要取消选择高灵敏度。

Pass/fail threshold( 通过 /失败

阈值)

设置通过或失败的阈值。输入 0 到 100 之间的整数。

相关性值为 100 表示完美匹配。

如果取消选择此选项，所有结果都将显示 Pass( 通过) 。

Maximum spectra in QCheck
results( QCheck结果中谱图

的最大数量)

设置结果面板中显示的结果数。例如，如果将该值设为 2，结果面板中将仅显示

两个最佳匹配项。

Prompt for reference( 提示参

比谱图)

选择此项可在测量期间选择参比谱图。取消选择此项可预先指定一个或多个参比

谱图。如果您计划将多个样品与相同的参比谱图进行比较，提前设置它们会很方

便，可避免每次测量样品时都必须选择相同的参比谱图。

Blank diamond ATR region
(2200 - 1955)( 金刚石 ATR 区

域 (2200 - 1955)生成空白)

选择此项可排除从 2200 波数到 1955 波数的区域中的数据，其中金刚石 ATR 晶

体吸收辐射。

Blank CO2 region (2390 -
2240)( CO2 区域 (2390 -
2240)生成空白)

选择此项可排除从 2390 波数到 2240 波数的区域中的数据，其中二氧化碳吸收

辐射。

Use full spectral range( 使用

全谱图范围)

选择此项可在分析中使用全范围。

取消选择此项可以仅指定用于分析的有限范围。
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c. 要保存您的设置并返回控制面板，请单击 Save( 保存) 。

d. 在控制面板上，查看您的测量设置，并确认列出的采样附件与您使用的附件匹配。

e. 从 Analysis Type( 分析类型) 列表中，选择 QCheck。

对您的测量和分析设置感到满意后，您已准备就绪可以测量背景。

2. 测量背景。

测量样品之前，您需要对背景进行当前测量。

背景谱图用于消除样品数据中由光谱仪、采样附件或背景环境产生的任何信号。

a. 单击 Preview and Measure Background( 预览并测量背景) 。

b. 单击 Start Background Measurement( 开始背景测量) 。完成背景测量后，光谱将添加至结果面板中。

3. 测量您的样品。

a. 加载您的样品。有关加载样品的说明，请参阅仪器或采样附件随附的文档。

b. 单击 Preview Sample( 预览样品) 。Sample Preview( 样品预览) 显示样品光谱的预览。预览让您有机会

在测量样品之前纠正任何潜在问题。

c. 准备好继续时，单击 Start Sample Measurement( 开始样品测量) 。

如果在分析设置中选择了 Prompt for Reference( 提示参比谱图) ，将会在完成测量后打开 Select
Reference Spectrum( 选择参比谱图) 。

d. 选择要在分析中使用的一个或多个参比谱图并单击 OK( 确定) 。

按住 Ctrl 并单击可将光谱添加到您的选择中。

按住 Shift并单击可将一组光谱添加到选择中。

4. 解读您的结果。

完成测量和分析后，您的结果将显示在结果面板中。将光标悬停在灰色箭头上可获取附加详细信息。
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5. 创建报告

完成分析后，创建报告以将结果导出到 Microsoft™ Word™、PowerPoint™或 Excel™，或者打印或保存您的结果。

a. 导航至 File > Create Report( 文件 >创建报告) 。

b. 为您的报告提供一个标题。

c. 从 Format( 格式) 列表中选择一个格式，然后选择 QCheck模板。右侧面板将显示报告的预览。

d. 单击 Create( 创建) 。
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改进您的结果

如果您的相关性值低于预期，可以考虑多种可能会改善结果的选项。

l 返回控制面板并为您的测量调整 Resolution( 分辨率) 设置。例如，您可以通过选择较小的值( 例如 1 或 2)
来以较高的分辨率测量样品。如果样品峰更尖锐或更多，您可能会获得更准确的分析结果。

l 增加测量中的扫描次数，可能会降低光谱噪音。

l 如果样品光谱具有倾斜或弯曲的基线，请尝试对样品应用 Automatic Baseline Correction( 自动基线校正) ，然

后从 Identify( 鉴别) 菜单重新开始分析。

l 从分析中排除选定的区域。如果样品光谱中有一个峰超出 Y轴刻度，您可能需要从分析中排除该峰。这些“平
顶”峰被称为“完全吸收”峰，并且可能会影响分析结果。打开 QCheck Setup( QCheck设置) ，取消选择 Use
Full Spectral Range( 使用全光谱范围) ，然后选择排除了样品光谱的完全吸收峰的区域。然后，返回 QCheck
分析。

从谱库提取光谱

从谱库中提取光谱可在 QCheck分析中将它用作参比谱图。从商业谱库中提取的光谱可用于分析，但不能重命名、

标记或导出。

❖ 从谱库中提取光谱

1. 从 OMNIC Paradigm软件桌面界面的控制面板，导航至 Identify > Library Manager( 鉴别 >谱库管理器) 。

2. 选择要提取的化合物。

3. 单击 Extract( 提取) 。将显示一条确认消息说明已成功提取光谱。

后续步骤

在本指导中，您设置并运行了 QCheck分析以验证您的样品匹配预设阈值内的已知参比。

接下来，请参阅"创建和运行您的第一个工作流"获取有关使用工作流创建常规、可重复程序的指导教程。
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3.4 定量样品成分

使用 Quantify( 定量) 分析查找样品中组分的浓度。Quantify( 定量) 分析使用先前创建的定量分析方法并报告样

品中组分的浓度或其他类型的信息，例如峰高或匹配值。

本指南将引导您使用 OMNIC Paradigm软件的桌面界面设置和运行 Quantify( 定量) 分析。

先决条件

本指南假设您已经设置好仪器和采样附件。有关安装采样附件的说明，请参阅仪器随附的文档。

您还需要一个保存为 QNT文件的有效定量方法。定量分析方法必须使用 Thermo Scientific TQ Analyst软件进行校

准。有关校准定量分析方法的信息，请参阅该软件随附的文档。

执行定量分析

运行定量分析需要导入 QNT文件，查看您的测量设置，测量背景，最后测量您的样品。完成分析后，您可以创建

报告以保存或共享您的结果。

❖ 执行定量分析

1. 设置分析。

a. 在 OMNIC Paradigm软件桌面界面的控制面板上，确认设置显示您的采样附件。

b. 导航至 Identify > Quantify Setup( 鉴别 >定量设置) ，然后浏览您要在分析中使用的 QNT文件。

文件浏览器将显示有关您选择的 QNT文件的附加信息，例如方法标题、方法类型以及方法是否已校准。

c. 要导入方法，请单击 Open( 打开) 。

d. 在 Analysis type( 分析类型) 列表中，选择 Quantify( 定量) 。符号表示您已导入有效的 QNT文件。带有

X的红色圆圈 [ ]表示尚未导入有效方法。

选择 QNT文件时，文件浏览器将会显示附加信息来帮助您进行选择，包括方法标题和类型以及方法是否

已校准。只有经过 TQ Analyst软件校准的方法才有效。
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2. 测量背景。

测量样品之前，您需要对背景进行当前测量。

背景谱图用于消除样品数据中由光谱仪、采样附件或背景环境产生的任何信号。

a. 单击 Preview and Measure Background( 预览并测量背景) 。

b. 单击 Start Background Measurement( 开始背景测量) 。完成背景测量后，光谱将添加至结果面板中。

3. 测量样品。

a. 加载您的样品。有关加载样品的说明，请参阅仪器或采样附件随附的文档。

b. 单击 Preview Sample( 预览样品) 。Sample Preview( 样品预览) 显示样品光谱的预览。预览让您有机会

在测量样品之前纠正任何潜在问题。

c. 准备好继续时，单击 Start Sample Measurement( 开始样品测量) 。

4. 解读您的结果。

完成样品测量后，Quantify( 定量) 对话框将会显示分析结果。显示的结果取决于分析中使用的定量分析方法

设置。下面显示的结果显示仅表示通过值的测量结果。
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单击 OK( 确定) 关闭 Quantify( 定量) 对话框后，您可以通过单击结果面板中光谱旁边的信息图标 [ ]来
查看分析结果。在 Spectrum Information( 光谱信息) 对话框中，导航至 History( 历史记录) 选项卡，查看

Quantify Results( 定量结果) 部分。

5. 创建报告

完成分析后，创建报告以将结果导出到 Microsoft™ Word™、PowerPoint™或 Excel™，或者打印或保存您的结

果。

a. 导航至 File > Create Report( 文件 >创建报告) 。

b. 为您的报告提供一个标题。

c. 从 Format( 格式) 列表中选择一个格式，然后选择 Quantify( 定量) 模板。右侧面板将显示报告的预览。

d. 单击 Create( 创建) 。

改进您的结果

如果您的结果不清楚或有问题，可以考虑多种可能改进您的数据的选项。

l 返回控制面板并为您的测量调整 Resolution( 分辨率) 设置。例如，您可以通过选择较小的值( 例如 1 或 2)
来以较高的分辨率测量样品。如果样品峰更尖锐或更多，您可能会获得更准确的分析结果。

l 增加测量中的扫描次数，可能会降低光谱噪音。

l 如果样品光谱具有倾斜或弯曲的基线，请尝试对样品应用 Automatic Baseline Correction( 自动基线校正) ，然

后从 Identify( 鉴别) 菜单重新开始分析。

后续步骤

在本指导中，您设置并运行了 Quantify( 定量) 分析。
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接下来，请参阅"创建和运行您的第一个工作流"获取有关使用工作流创建常规、可重复程序的指导教程。
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3.5 创建和运行您的第一个工作流

本教程介绍了一种在 OMNIC Paradigm软件中创建工作流的简单方法。有关工作流的基本信息以及工作流功能和编

辑工具的简要说明，请参阅 OMNIC Paradigm在线帮助中标题为“关于工作流”的文章。

注释用于创建工作流的软件操作仅在 OMNIC Paradigm软件的桌面版本( 不是触摸屏版本) 中可用。

您可以通过多种方式创建工作流。某些方法可能比其他方法更有效，具体取决于您尝试自动化的步骤以及您希望

如何开始。例如，您可以通过以下方式创建新工作流：

l 从头开始构建工作流

l 编辑某人给您的工作流

l 复制随软件提供的示例工作流

l 执行您想要自动化的测量任务，并让软件从光谱的历史记录信息创建工作流。

本文展示了该软件如何根据所采集光谱的历史记录自动创建工作流。它还演示了如何：

l 从工作流编辑器或控制面板运行工作流

l 鉴别工作流生成的光谱

l 通过添加磁贴来编辑工作流，以及

l 修复常见的工作流错误

最后部分提供了创建和编辑工作流的有用提示。

创建工作流

❖ 从采集的光谱创建新工作流

1. 从 OMNIC Paradigm控制面板，采集样品材料的光谱。

您使用何种材料或采样技术并不重要。如果软件需要新的背景测量，请先执行此操作。完成样品测量后，样

品光谱将显示在光谱视图中。

这是光谱视图中显示的示例光谱( 使用衰减全反射或 ATR 附件测量的塑料袋) ：
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2. 确保在光谱窗格中选择了光谱，然后执行您想要的任何处理或分析步骤( 例如，减、基线校正、相关搜索

等) 。

这是应用 Advanced ATR Correction( 高级 ATR 校正) 和 Automatic Baseline Correction( 自动基线校正) ，然

后执行 Correlation Search( 相关性搜索) 后的示例光谱。
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3. 为您的光谱指定一个描述性名称( 软件会将此名称用作所创建工作流的默认名称，或者您可以为工作流指定一

个新名称) 。

a. 右击结果面板中原始光谱的图像，然后选择 Rename Spectrum( 重命名谱图) 。

b. 用工作流的描述性名称替换默认名称，然后选择 OK( 确定) 。这是重命名的示例光谱。
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4. 完成处理和分析步骤后，单击结果面板中的 History( 历史记录) 按钮。

历史记录面板按执行顺序显示在所选光谱上执行的所有任务。这是示例光谱的历史记录信息。
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5. 在历史记录面板的底部，单击 Create Workflow( 创建工作流) 。

软件会创建一个包括您刚刚执行的所有步骤的工作流。该工作流显示在工作流编辑器中。每项执行的任务都

由一个彩色磁贴表示。取决于您执行的步骤，您的工作流可能与我们的以下示例有所不同：
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6. 要保存您的新工作流，请单击工具栏上的 Save( 保存) 按钮。

7. 要运行工作流，请单击工具栏上的 Run( 运行) 按钮。

工作流以完全相同的顺序执行您手动完成的相同任务。在我们的实例中，我们测量了光谱，执行了 Advanced
ATR Correction( 高级 ATR 校正) ，校正了光谱基线，并执行了相关性搜索。

完成工作流后，软件将返回工作流编辑器。

8. 单击工具栏上的 Dashboard( 控制面板) 按钮，查看“工作流”列表中您新创建的工作流。

工作流根据用于创建它的光谱名称自动命名。这是 Workflows( 工作流) 列表中我们新创建的示例工作流和预

览框中的工作流预览。
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9. 工作流生成的光谱出现在 Measurements( 测量) 列表中。
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我们的示例工作流创建了四个光谱：测量的背景谱图、测量的样品谱图、ATR 校正的样品光谱，以及带有搜

索结果的 ATR 和基线校正的样品光谱。工作流生成的光谱以其相关工作流磁贴的 Tile Name( 磁贴名称) 属性

命名。

将磁贴添加到工作流中

本节演示了如何使用工作流编辑工具将磁贴添加到自动生成的工作流中。

1. 从控制面板，右击工作流名称并选择 Edit( 编辑) 。

工作流在工作流编辑器中打开。
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2. 将 Tag Spectrum( 标记谱图) 磁贴添加到工作流中。

工作流生成的光谱连同手动采集的任何数据保存在 OMNIC Paradigm数据库中。让我们标记工作流光谱以将它

们与我们的工作流关联。如此即可在往后轻松打开和查看它们。

a. 在工作流编辑器中，将 Tag Measurement( 标记测量) 磁贴从选择

栏拖动到画布上，使鼠标光标悬停在 Measurement( 测量) 和 ATR Correction( ATR 校正) 磁贴之间的灰

色箭头 上 。

灰色箭头变成加号。
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b. 释放鼠标按键。

磁贴将添加到工作流中的该位置，其设置框在画布下方打开。
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c. 在 Tag Settings( 标记设置) 中，为工作流生成的光谱输入基本名称，例如“ATR Search Spectra”，确保将

Select Spectrum( 选择光谱) 设为您的测量光谱( “Measurement - Sample”( 测量 -样品) ) ，然后选择

OK( 确定) 。

Tag Measurement( 标记测量) 磁贴会自动将“ATR Search Spectra”( ATR 搜索光谱) 标签添加到工作流生

成的每个光谱。稍后我们将解释如何搜索这些光谱。

现在让我们探索当我们添加一个标记错误的磁贴时会发生什么情况。

3. 将 Report Template( 报告模板) 磁贴添加到工作流中。

a. 在工作流编辑器中，将光标悬停在 Search( 搜索) 和 End( 结束) 磁贴之间的灰色箭头上( 箭头变成加

号 (+)) ，然后单击鼠标按键。软件将打开 Add Tile( 添加磁贴) 框。( 这是另一个添加磁贴的简单方

式。)
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b. 在 Add Tile( 添加磁贴) 框中，选择 Template Report( 模板报告) ，然后选择 OK( 确定) 。

磁贴将添加到工作流中的该位置，其设置框在画布下方打开。
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请注意，Template Report( 报告模板) 磁贴有一个红色边框，表示工作流现在不会成功运行。如果我们查

看 Template Report( 报告模板) 设置，这些框全部都是空白的。

为了解决这个问题，我们需要为报告指定一个模板以及要包含哪些结果。

c. 将 Template Type( 模板类型) 设为您首选的报告样式( 我们使用的是 Search Results( 搜索结果) 模

板) ，将 Search Results To Display( 要显示的搜索结果) 设为您的工作流的输出( 在我们的示例中为

“Search Result”( 搜索结果) ) ，然后选择 OK( 确定) 。
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请注意，红色边框不再存在。

4. 要保存更新后的工作流，请单击工具栏上的 Save( 保存) 按钮。

5. 要运行工作流，请单击工具栏上的 Run( 运行) 按钮。

工作流将运行所有步骤，然后显示最终报告。

单击箭头按钮结束工作流。
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6. 单击工具栏上的 Dashboard( 控制面板) 按钮返回控制面板。

7. 如果在 Workflows( 工作流) 列表中选择工作流，则预览已更新。
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8. 如果在 Search( 搜索) 框中输入标签，软件将在“测量”列表中显示工作流生成的光谱。
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要在光谱窗格中查看光谱，请使用 Shift +单击以选择 Measurements( 测量) 列表中的所有四个光谱，然后右

击并选择“Open Selected Measurements”( 打开所选测量) 。

9. 要查看工作流生成的报告，请单击此箭头按钮并选择“Reports”( 报告) 。

关于创建工作流的提示

开始创建更多工作流之前，请通读这些关于工作流常见问题的解答以及解决可能出现的任何问题的提示。

l 磁贴在工作流中出现的顺序重要吗？是的，磁贴的顺序很重要。每个工作流磁贴都建立在之前的磁贴上，并且

所有磁贴都通过它们的输入需求和输出结果相互连接。例如，如果添加一个 Measure( 测量) 磁贴，它会创建

一个输出结果( 光谱) ，该结果只能通过工作流中位于 Measure( 测量) 磁贴后面的磁贴访问。如果要校正所

采集光谱的基线，您需要在 Measure( 测量) 磁贴后面添加一个 Processing( 处理) 磁贴，然后将 Processing
( 处理) 磁贴输入设为 Measurement( 测量) 输出( 即光谱) 。否则，Processing( 处理) 磁贴将有一个红色

边框，表示它包含必须在工作流运行之前设置的选项。如果您看到带有红色边框的磁贴，请将光标悬停在该磁

贴上以帮助查找问题的根源。

l 我需要在我的工作流中添加背景测量吗？不需要，除非您希望工作流仅对背景谱图执行操作。如果您只需要一

个背景谱图来处理测量的样品数据，那么您只需要在工作流中添加一个“测量”磁贴并使用“测量”磁贴设置来定

义背景测量。

l 我可以更改工作流磁贴的标题吗？每个工作流磁贴都有一个用于指定磁贴名称的设置。( 在工作流编辑器中双

击该磁贴可打开其关联设置。) Tile Name( 磁贴名称) 设置可用于将详细信息添加到您的工作流中。这可以
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帮助工作流开发人员妥善组织各个项目，特别是在创建包含多个路径或循环或多个相同类型的磁贴( 例如，在

同一工作流中的多个“测量”磁贴) 的工作流时。

运行工作流时，磁贴名称也可用于命名输出文件。这里为您提供一些示例：

n Measure( 测量) 磁贴。此磁贴用于采集背景和样品光谱。运行工作流时，样品光谱将连同其关联的

Measure( 测量) 磁贴的磁贴名称一起保存。

n ATR Correction Tile( ATR 校正磁贴) 、Process Tile( 处理磁贴) 等 ..对采集的光谱进行操作的磁贴会生

成输出光谱，并在运行工作流时连同最终样品光谱一起保存。每个临时“已处理”光谱都连同生成它的工作

流磁贴的磁贴名称一起保存。

n Report( 报告) 磁贴。此磁贴用于创建样品报告。运行工作流时，报告将连同其关联的 Report( 报告)
磁贴的磁贴名称一起保存。

l 每个工作流都应该有一个 Export( 导出) 磁贴吗？这个问题的答案是“否”。从工作流生成的任何光谱和报告，

都会连同使用光谱仪手动创建的所有其他光谱和报告( 即，不是来自工作流) 自动保存在 OMNIC Paradigm数

据库中。如果要将工作流生成的光谱和报告保存为可以存档或在其他地方打开的文件( 例如，从您的 OMNIC
Paradigm工作站软件) ，请使用 Export( 导出) 磁贴自动创建这些文件。

l 为什么我的工作流没有运行？运行新创建的工作流之前，请确保没有带有红色边框的磁贴。示例：

如果工作流包含带有红色边框的磁贴，它将不会运行完成。
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如果您的工作流有一个红色边框的磁贴，请将光标悬停在磁贴上，获取有关如何解决问题的提示。通常，红

色边框表示磁贴包含尚未设置的必需选项。但是，这也可能意味着该磁贴是“非法的”。例如，如果您在工作流

中将一个 Processing( 处理) 磁贴放在 Measure( 测量) 磁贴的前面，Processing( 处理) 磁贴将有一个红色

边框，并且工作流将包含一个无法解决的错误，因为没有可用于基线校正的输出光谱。
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4. 操作指南

4.1 管理数据

OMNIC Paradigm软件包括用于简化查找和管理数据的工具，包括测量、报告和工作阶段。

管理谱库 92

备份和还原数据库 95

使用数据库清理工具删除不需要的测量 97

查找测量和报告 98

查看测量历史记录 101

恢复测量 102

复制测量 102
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管理谱库

谱库包含化合物和相关信息的列表，可以购买或从您自己的数据创建。执行相关性或多组分搜索时，分析会将样

品光谱与存储在搜索设置所指定谱库中的化合物进行比较。

使用谱库管理器可查看有关谱库和所存储化合物的信息，以及创建或删除谱库。

新建谱库

新建谱库可管理您的光谱数据并搜索您自己的测量数据。

❖ 在桌面界面中新建谱库

1. 从菜单栏，选择 Identify > Library Manager( 鉴别 >谱库管理器) 。

2. 在 Library Manager( 谱库管理器) 中，选择 New Library( 新建谱库) 。

3. 输入谱库的名称并添加任何可选字段。

可选字段用于将光谱添加到谱库时。

图 4-1:在 New Library( 新建谱库) 视图中命名您的谱库并自定义可选字段。

4. 单击 Save( 保存) 以新建谱库。

新谱库列在谱库管理器的 Libraries( 谱库) 列中。

❖ 在触摸屏界面中新建谱库

1. 从主屏幕，打开 [ ]菜单并选择 Library Manager( 谱库管理器) 。

2. 从工具栏中选择 New Library( 新建谱库) 。

3. 在 New Library( 新建谱库) 视图中，输入谱库的名称并添加任何可选字段。

可选字段用于将光谱添加到谱库时。
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图 4-2:在 New Library( 新建谱库) 视图中命名您的谱库并自定义可选字段。

4. 点按 Save( 保存) 以保存新谱库。

将光谱添加到谱库

将光谱添加到谱库可在其他“搜索”分析中使用您自己的样品数据。

❖ 在桌面界面中将光谱添加到谱库

1. 在光谱视图中，选择要添加到谱库的光谱。

2. 从菜单栏，选择 Identify > Add to Library( 鉴别 >添加到谱库) 。

3. 从谱库列表中，选择要添加光谱的谱库。

4. 对光谱信息进行任何调整并设置化合物的名称。默认名称将是测量样品时使用的测量名称。

5. 单击 Save( 保存) 。您的光谱现已可在谱库中使用，您可以在谱库管理器中查看该光谱。

❖ 在触摸屏界面中将光谱添加到谱库

1. 在光谱视图中，选择要添加到谱库的光谱。

2. 从菜单中选择 Add to Library( 添加到谱库) 。

3. 在 Add to Library( 添加到谱库) 视图中，从 Libraries( 谱库) 列中选择一个谱库。

4. 命名化合物，指定任何可选字段然后点按 Save( 保存) 。该光谱现在将可在您所选的谱库中使用。

从谱库中提取光谱

从谱库中提取光谱可将它们用作分析或工作流中的参比。提取的光谱与您的测量值一起存储在数据库中，但不能

重命名、标记或导出。
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❖ 从谱库中提取光谱

1. 导航至 Library Manager( 谱库管理器) 。

2. 选择要提取的化合物。

3. 在工具栏中，选择 Extract( 提取) 。将显示一条消息确认已成功提取光谱。查看您的测量结果以找到提取的

光频。

删除谱库和化合物

若删除化合物，该化合物将不再用于搜索分析并在化合物列表中被划掉。将保留谱库中其他化合物的索引位置。

您只能删除或编辑您创建的谱库。不能删除商业谱库及其化合物。

注释删除的谱库和化合物无法恢复。

❖ 从谱库中删除化合物

l 使用桌面界面

1. 在 Library Manager( 谱库管理器) 中，导航至您要删除的化合物。

2. 右击该化合物并选择 Delete( 删除) 。在对话框中，单击 Yes( 是) 以确认。

l 使用触摸屏界面

1. 在 Library Manager( 谱库管理器) 中，选择要删除的化合物。

2. 在 Spectrum( 光谱) 窗格中点按 Delete( 删除) 。

❖ 删除谱库

l 使用桌面界面

1. 在 Library Manager( 谱库管理器) 中，选择要删除的谱库。

2. 在工具栏中，单击 Delete( 删除) ，然后单击 Yes( 是) 以确认。

l 使用触摸屏界面

1. 在 Library Manager( 谱库管理器) 中，选择要删除的谱库。

2. 在主工具栏中，点按 Delete( 删除) 。

添加谱库位置

使用 Search Setup( 搜索设置) 中的 Library Locations( 谱库位置) 选项卡可指定其他谱库位置。如果将谱库存储

在共享位置( 例如网络驱动器) ，此功能将非常有用。添加位置后，您可以使用该位置中的谱库进行 Search( 搜

索) 、QCheck和其他分析。
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❖ 添加谱库位置

1. 使用桌面界面，打开 Identify( 鉴别) 菜单并选择 Search Setup( 搜索设置) 。

2. 导航至 Library Locations( 谱库位置) 选项卡。

3. 单击 Add Location( 添加位置) 。

4. 浏览至附加谱库的位置，然后单击 Open( 打开) 。

5. 单击 Save( 保存) 。

备份和还原数据库

定期备份您的数据库，以确保在硬盘驱动器发生故障时可以还原数据。使用 OMNIC Paradigm软件中的数据库维护

工具，您可以直接从该软件轻松备份和还原您的数据。

备份您的数据库

如果硬盘驱动器发生故障，请将您的数据库备份到独立的设备上。例如，将数据备份到独立的计算机或外部硬盘

驱动器或远程网络位置上。

❖ 备份您的数据库

1. 使用 OMNIC Paradigm软件的桌面界面，转到 Configure > Database Maintenance( 配置 >数据库维护) 并选

择 Back Up( 备份) 。

2. 选择用于保存备份数据库的备份位置。

3. 要计划备份，请设置第一次备份的日期和时间。

a. 确保选择了 Repeat( 重复次数) ，并从列表中选择一个重复次数选项。

b. 单击 Save( 保存) 。

3. 要在没有计划的情况下手动备份数据库，请单击 Back Up Now( 立即备份) 。
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要在备份前设置新的备份位置，请先更改位置并保存更改，然后重新打开 Database Maintenance - Back Up
( 数据库维护 -备份) 窗口并单击 Back Up Now( 立即备份) 。

4. 单击 Close( 关闭) 返回控制面板。

注意：数据库备份工具仅备份一部分工作阶段数据。工作阶段数据包含两个部分：其中一个部分的工作阶段存储

在数据库中，另一个部分的工作阶段保存在磁盘驱动器上的文件中。OMNIC Paradigm软件中的数据库备份工具仅

备份存储在数据库中的数据。

为确保可以还原数据，您必须使用个别的备份实用程序来备份存储在以下目录中的文

件：C:\Users\Public\Documents\thermo scientific\omnic paradigm\Sessions

要备份工作阶段数据，请如常使用数据库备份工具，并使用个别的备份实用程序( 例如操作系统中的备份和还原

工具) 备份 C:\Users\Public\Documents\thermo scientific\omnic paradigm\Sessions中的文件。

要还原工作阶段数据，请使用备份和还原实用程序还原工作阶段目录中的文件，然后还原数据库。

从备份中还原数据库

使用 OMNIC Paradigm软件中的还原工具可从先前保存的备份中还原您的数据库。

注释此操作将永久删除数据库中当前的全部数据，并将其替换为所选备份中的数据。

❖ 还原您的数据库

1. 使用 OMNIC Paradigm软件的桌面界面，转到 Configure > Database Maintenance( 配置 >数据库维护) 并选

择 Restore( 还原) 。

2. 单击 Browse( 浏览) 并选择备份数据库的位置。

如果在 Summit光谱仪上使用 OMNIC Paradigm软件，并且正在从与其他光谱仪共享的远程备份进行还原，您

可以从使用备份的任何单个光谱仪还原数据。

要仅备份来自单个光谱仪的数据，请从主机名列表中选择一个光谱仪。

3. 单击 Confirm( 确认) 。
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使用数据库清理工具删除不需要的测量

使用 Database Maintenance( 数据库维护) 中的 Clean Up( 清理) 可自动删除达到指定时限的过去的测量。例

如，为了节省系统空间，您可能希望自动删除超过一个月未修改的任何测量。

要清理数据库，您可以设置在自动删除之前保留该测量的时间长度，或者您可以选择 Clean Up Measurements Now
( 立即清理测量) 以删除任何旧于您所喜欢的测量。

旧测量一旦删除，将无法恢复。

提示要保留选择的测量，请将它们添加到谱库中。您可以在日后从谱库中提取它们并在需要时使用。

❖ 在桌面界面中自动删除旧测量

1. 使用桌面界面，进入 Configure > Database Maintenance > Clean Up( 配置 >数据库维护 >清理) 。

2. 设置您希望保留测量多久。

选择 Forever( 永远) 保留您的测量。

3. 单击 Save( 保存) 。

要立即删除任何比设定时限旧的测量，请选择 Clean Up Measurements Now( 立即清理测量) 。

❖ 在触摸屏界面中自动删除旧测量

1. 从主屏幕，选择 Settings( 设置) 图标。

2. 进入 Database Maintenance( 数据库维护) 选项卡。

3. 选择 Clean Up( 清理) 。

4. 设置您希望保存测量多久。

选择 Forever( 永远) 可以无限期地保留您的测量。

5. 选择 Save( 保存) 。

要立即删除任何比设定时限旧的测量，请选择 Clean Up Measurements Now( 立即清理测量) 。

提示您还可以一次删除所有测量。要删除所有测量，请将过滤器设为显示所有测量，选择所有测量，然后右击

测量并选择 Delete Selected Measurements( 删除所选测量) ，或在触摸屏界面中选择 Delete( 删除) 。
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查找测量和报告

查找保存的测量和报告时，可以使用标签和搜索关键字来过滤测量和报告列表。

搜索

搜索测量时，会根据光谱标签、标题、上次修改日期、鉴别的化合物、自定义字符串、序列号等信息来检查搜索

词。如果搜索报告，用于搜索的字段将包括报告名称、创建日期和模板类型。

提示单击列标题( 例如“Measurement Name(测量名称)“Type(类型)”) 可以对测量进行排序。默认情况下，测量

的排序为首先显示最近修改的项目。

❖ 搜索测量和报告

1. 从列表中选择 Reports( 报告) 或 Measurements( 测量)

2. 选择用于限制搜索结果的时间。

3. 输入搜索词然后单击 Search( 搜索) 。

使用以下搜索技术来精简您的结果。

搜索技术 说明 示例

引号 (“”)
使用引号可以仅返回标签中的完全匹配项。

如果要搜索包含两个词的标签并且不想看到

仅用一个词标记的光谱，这将非常有用。

“red blue”( “红色蓝色”)

返回：只有带有“red blue”标签的光谱。不会

分别返回带有“red”或“blue”标签的光谱。

*( 星号)

在搜索词末尾添加星号 (*)可返回包含星号

前面的文本的所有结果

注：可以将 * 附加到搜索词的末尾，但不能

放在其他词的前面。

Poly*

返回：任何以 poly开头的术语的测量，例如

polystyrene( 聚苯乙烯) 。

AND、OR、
NOT 运算符

这些关键字必须全部为大写字母，如图所

示。

AND：仅返回包含这两个词的结果。

OR：返回包含任一关键字的结果。

NOT：仅返回包含第一个词但不包含 NOT
之后的词的结果。

Sample AND Background( 样品和背景)

返回：仅返回已搜索字段中同时具有样品和

背景的测量。

Sample OR Background( 样品或背景)

返回：返回数据中带有样品或背景的测量。

Sample NOT Background( 样品非背景)

返回：数据中有样品但字词中没有背景的测

量或报告。

Thermo Scientific OMNIC Paradigm 软件用户指南 98

4. 操作指南



4. 操作指南

搜索技术 说明 示例

title:<keyword>
( 标题 :<关键

字>)
用于指定关键字必须在测量或报告标题中。

title:poly( 标题 :poly)

返回：名称中带有 poly的测量，但将忽略其

他地方带有 poly的测量( 例如已鉴别的化合

物) 。

tags:<keyword>
( 标签 :<关键

字>)

用于指定关键字必须在标签中。

如果标签是两个词，则使用下划线而不是空

格。

tags:blue( 标签 :蓝色)

tags:blue_powder( 标签 :blue_powder)

返回：以蓝色为标签的测量，但将忽略其他

地方( 如测量名称) 带有蓝色的测量。

“blue_powder”搜索两个词标签 “blue
powder”。

标记

标签为您提供了另一种在数据库中查找测量和报告的便捷方式。例如，若要采集与单个项目相关的许多测量，可

以使用相同的“项目 A”标签来标记每个测量。稍后，可以使用此标签来过滤测量，以仅显示带有“项目 A”标签的测

量。

❖ 在桌面界面中添加或删除标签

1. 在 Measurements( 测量) 列表中右击一个测量并选择 Manage Tags( 管理标签) 。

当前分配给测量的标签列在 Current Tags( 当前标签) 下。

l 要添加新标签，在 New Tag( 新建标签) 字段中输入文本并单击 Add( 添加) 。新标签将添加到当前标签

中。

l 要删除当前标签，单击该标签右上角的删除图标 ( )。该标签将会立即被移除。

2. 要保存您的更改，请单击 OK( 确定) 。单击 Cancel( 取消) 可退出 Manage Tags( 管理标签) 对话框而不保

存更改。

❖ 在触摸屏界面中添加或删除标签

1. 从 Home( 主页) 屏幕，导航至 Measurements( 测量) 选项卡。

2. 选择一个测量并点按 More( 更多) 选项图标。

3. 点按 Manage Tags( 管理标签) 。

l 要添加标签，在 New Tag( 新建标签) 字段中输入文本并点按 Add( 添加) 。新标签将添加到当前标签列

表中。

l 要删除标签，点按该标签右上角的删除图标 ( )。
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4. 要保存您的更改，请点按 OK( 确定) 。点按 Cancel( 取消) 可退出 Manage Tags( 管理标签) 对话框而不保

存更改。

按签名状态过滤测量

使用签名过滤器根据签名状态快速查找测量、报告和工作阶段。

例如，签名过滤器非常适合查找已使用作者身份原因签署但仍需要批准的测量。

❖ 根据签名状态过滤您的记录

1. 从桌面界面的控制面板，单击 Signature( 签名) 。

2. 选择过滤选项并单击 OK( 确定) 。

对话框将显示所有签署原因的列表。对于每个原因，您可以选择 signed( 已签署) 、unsigned( 未签署) 或 N/A
( 不适用) 。

l Signed( 已签署) ：选择此项可显示使用该原因签署的记录。将显示使用该原因签署的任何记录。

l Unsigned( 未签署) ：选择此项可显示未使用该原因签署的记录。将不会显示带有该签名的任何记录。

l N/A( 不适用) ：过滤时忽略该原因。将显示带有和不带该签名的记录。

在此示例中，这些设置将显示所有仍需要批准的记录。

提示双击列标题( “Signed”[已签署 ]) 可为所有选项选择该列。 .再次双击可将所有选项重置为 N/A( 不适用) 。

提示签名过滤器与时间过滤器一起使用。例如，要查看上个月中需要批准的所有测量，可将时间设为 Past
Month( 上个月) ，并在签名过滤器中将 Approval( 批准) 设为 Unsigned( 未签署) 。

提示要一次签署多个记录，可在过滤这些记录后，选择所有记录并右击，然后选择 Sign( 签名) 。
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查看测量历史记录

查看测量历史记录可直观地比较处理和分析中不同阶段的光谱。例如，应用自动基线校正后，查看测量历史记录

可快速查看光谱的变化情况，

❖ 查看测量历史记录

1. 从光谱视图，导航至 History( 历史记录) 窗格。

2. 右击历史记录中的任何项目并选择 Measurement History( 测量历史记录) 。

历史数据显示了处理和分析中每个阶段的光谱。

l 要创建历史数据报告，请打开 File( 文件) 菜单并选择 Create Report( 创建报告) 。选择 Historical Spectrum
( 历史光谱) 模板，编辑您的报告设置，然后单击 Create( 创建) 。

l 要退出测量历史记录，单击 Close Measurement History( 隐藏测量历史) 。
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恢复测量

在处理或分析测量时，使用 Revert( 恢复) 可撤消一个或多个步骤。例如，如果某个处理步骤降低了测量数据的

质量，请不要重新开始并收集新的样本测量值，而是使用 Revert( 恢复) 返回之前的步骤。

当您恢复到之前的状态时，在您恢复到的步骤之后执行的任何操作都将丢失。换句话说，无法撤消恢复。

如果您处于安全环境中，则 Revert( 恢复) 不可用。但是，您可以改为使用 Duplicate( 复制) 工具来创建测量值

的副本，就像在前面的步骤中一样。然后，您可以使用复制的测量，而无需重新测量样品。请参阅"复制测量"了解

详情。

❖ 恢复到之前的步骤

1. 在光谱视图的 Results( 结果) 窗格中选择您的测量。

2. 单击 图标查看历史记录窗格。

单击历史记录中的任何项目，预览处于该阶段的测量。

3. 在事件列表中，右击要恢复到的步骤。

4. 在上下文菜单中，选择 Revert( 恢复) 。

5. 单击 Yes( 是) 以恢复，或单击 No( 否) 以取消。

复制测量

使用 Duplicate as New Measurement( 作为新测量重复) 创建测量副本。您可以从其当前状态或其历史记录中的较

早步骤复制测量。
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提示可将 Duplicate( 复制) 用作 Revert( 恢复) 的替代方法。例如，“恢复”会丢弃当前数据并将测量值返回较

早的状态，而使用 Duplicate( 复制) ，您可以从较早的状态复制测量并保留当前数据。

您还可以在工作时使用 Duplicate( 复制) 来保存特定阶段的测量副本。例如，您可以在收集数据后立即复制您

的测量以保存测量副本而不进行任何进一步处理，然后仅使用一个测量副本。

复制测量时，并非所有测量信息都会复制到新测量中。大多数信息是复制的，但也有一些差异：

l 如果原始测量有标签，这些标签将不会复制到新测量中。

l 将会复制测量历史记录，但光谱视图中的历史记录面板不会显示复制测量之前的任何步骤。打开 Measurement
Information( 测量信息) 并查看 History( 历史记录) 选项卡，即可查看测量历史记录。

❖ 复制测量

l 从控制面板

从控制面板复制可复制处于其当前状态的测量。

1. 在 Measurements( 测量) 窗格中右击一个测量。

2. 选择 Duplicate as New Measurement( 作为新测量重复) 。

3. 输入新测量的名称或保留默认名称。

4. 单击 OK( 确定) 。
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l 从测量历史记录复制

从光谱视图复制可从上一个点复制测量。

1. 在光谱视图的 Results( 结果) 窗格中，选择该测量。

2. 选择测量后，导航至历史记录窗格。

单击历史记录中的任何项目，预览处于该点的光谱。

3. 右击要复制测量的步骤。

未更改谱图的事件，例如 Add to Library( 添加到谱库) 或 Create Report( 创建报告) ，不能作为新测量

重复。

4. 选择 Duplicate as New Measurement( 作为新测量重复) 。

5. 输入新测量的名称或保留默认名称。

6. 单击 OK( 确定) 。
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4.2 光谱学

本节描述 OMNIC Paradigm软件的核心功能，包括以下主题：

测量样品 105

处理数据 119

分析数据 133

创建报告 140

测量样品

要使用 OMNIC Paradigm软件采集新数据，请设置并保存您的测量设置，采集背景谱图，最后测量样品。
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设置并保存测量选项

Measurement( 测量) 设置允许您指定如何测量样品以及在采集光谱后如何处理数据。您的设置可以控制仪器和采

样附件如何测量样品以及 OMNIC Paradigm软件如何处理数据。

调整测量设置后，您可以立即使用它们或保存它们以备稍后使用。

本指南描述了如何设置、保存和使用常用测量选项。有关高级设置的讨论，请参阅"高级测量设置"。

设置测量选项

开始测量之前，设置并保存您的测量设置或使用先前保存的设置。

在用于触摸屏的 OMNIC Paradigm软件中，测量样品之前编辑个别设置或导入设置文件 (.expx)。要编辑或查看测

量设置，请从主屏幕选择一个分析类型。

图 4-1:在 Summary( 摘要) 、Details( 详细信息) 和 Background( 背景) 选项卡中查看测量设置

使用桌面界面时，可以从控制面板设置并保存您的测量设置，或在预览样品谱图时更新一些选项。

Thermo Scientific OMNIC Paradigm 软件用户指南 106

4. 操作指南



4. 操作指南

图 4-2:在 New Measurement( 新建测量) 窗格中编辑测量设置。

下表描述了您将最常使用的设置。

选项 说明 默认设置

Measurement
name( 测量

名称)

您的样品数据名称。该名称将会在您保存或打开此数据时显示，以及在生成的任何

报告中显示。默认名称为采集的日期和时间。

Date and
Time( 日期

和时间)

Number of
sample scans
( 样品扫描

次数)

测量期间扫描样品的次数。产生的数据反映所有扫描的平均值。

更多次的扫描将会产生更准确的数据，但也需要更长的时间进行测量。
10

Resolution
(cm-1)( 分辨

率 (cm-1))

就像照片或视频的分辨率一样，更好的分辨率意味着光谱数据中的细节更精细。例

如，更好的分辨率可以区分两个非常接近的峰，而较差的分辨率可能会将它们组合

在一起。

值越小，分辨率越高( 更好) ，但测量时间也更长。

通常，分辨率 4 用于固体和液体样品。对于气体样品，则使用分辨率 1 或 0.5。

4

Analysis type
( 分析类

型)

通过用于触摸屏的 OMNIC Paradigm，您可以从主屏幕中选择分析类型，而不是从列

表中进行选择。

允许您在收集数据后自动处理数据。

使用 None( 无) 可测量没有附加分析的样品。

Search( 搜索) 将执行相关性搜索。使用搜索可鉴别未知样品。搜索设置可在

Search Setup( 搜索设置) 视图中进行编辑。

QCheck结果表示您的样品和参比之间的匹配值。使用 QCheck可验证未知样品的成

分。可在 QCheck Setup( QCheck设置) 视图中编辑 QCheck设置。

Quantify( 定量) 用于使用预先选择的定化方法对样品的成分进行定量。选择 Identify
> Quantify Setup( 鉴别 >定量设置) 可指定定量方法。

None
( 无)

Tag( 标签) 允许您将标签添加到谱图中。以后搜索谱图时可以使用标签。

Final format
( 最终格

式)

决定用于所收集数据的单位。采集数据后，您可以在 View/Display( 视图 /显示) 菜

单中将数据转换为另一个 Y轴单位。

Absorbance
( 吸光度)
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选项 说明 默认设置

Sampling
accessory
( 采样附

件)

采样附件用于测量样品。智能附件将会自动被检测。

保存您的测量设置

您只能在使用桌面界面时保存、编辑或删除您的测量设置。

命名并保存您的测量设置，从而可以在稍后需要使用时轻松从控制面板中选择这些设置。Search( 搜索) 、

QCheck和 Quantify( 定量) 分析的设置不会保存在这些设置中。

❖ 保存您的测量设置

1. 对设置进行任何所需的更改。

2. 单击控制面板顶部 Settings( 设置) 菜单附近的 New( 新建) 。

3. 输入设置的名称，然后单击 Save( 保存) 。

保存的设置将会添加到 Settings( 设置) 列表中以备稍后使用。

❖ 更改保存的设置

1. 从 Settings( 设置) 菜单中选择要更新的已命名设置。

2. 编辑设置

3. 单击 Save( 保存) 。

您的新设置现在保存在旧设置名称下，并可在 Settings( 设置) 菜单中使用。

❖ 删除保存的设置

1. 从 Settings( 设置) 菜单中选择要删除的已命名设置。

2. 单击 Delete( 删除) 。

3. 在确认对话框中，单击 OK( 确定) 永久删除已命名的设置。

导入和导出保存的设置

导入设置文件可自动将您当前的测量设置更新为您先前保存的设置。导入设置时，您可以导入 OMNIC 实验文件

(.exp)或 OMNIC Paradigm设置文件 (.expx)。

OMNIC Paradigm软件与使用 OMNIC 软件创建的 .exp 文件兼容。但是，使用 OMNIC Paradigm，您只能导出 .expx
文件，这些文件与早期版本的 OMNIC 软件不兼容。

导入 OMNIC 实验文件会更新您的测量设置，但不会更改您的分析设置，例如 Search Setup( 搜索设置) 或

QCheck Setup( QCheck设置) 。
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❖ 导入设置文件

l 如果您使用触摸屏界面

a. 从主屏幕，选择一个分析类型。

b. 查看 Summary( 摘要) 选项卡时，打开菜单并选择 Open Settings( 打开设置) 。

c. 选择要导入的 OMNIC 实验文件 (.exp)或 OMNIC Paradigm设置文件 (.expx)并点按 Open( 打开) 。

l 如果您使用桌面界面

a. 在工具栏中，单击 Settings( 设置) 。

b. 选择要导入的文件并单击 Open( 打开) 。

❖ 导出设置文件

设置只能从桌面界面导出。设置文件将以 .expx文件扩展名保存。

1. 从 Settings( 设置) 列表中选择要导出的设置

2. 选择 Acquire Data > Export Settings( 采集数据 >导出设置) 。

3. 输入设置文件的名称，选择用于保存该文件的目录，然后选择 Save( 保存) 。

设置文件现已保存并可供将来使用。
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高级测量设置

使用高级测量设置可控制切趾、零填充、范围限制、仪器特定设置等。

这些高级设置通常应保持默认状态。只有在极少数或特定情况下才编辑这些设置。

要在触摸屏界面中查看或编辑高级设置，请打开 Details( 详细信息) 选项卡。

图 4-1:Details( 详细信息) 选项卡显示高级测量设置。

要在桌面界面中查看或编辑高级设置，请在 New Measurement( 新建测量) 窗格中单击 More( 更多) 。
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图 4-2:控制面板提供了高级测量设置

高级测量设置

下表介绍了每个高级设置。

选项 说明 默认设置

Detector( 检测器)

检测器是光谱仪内部的一个装置，它响应照射它的红外线光束

而产生电信号。

检测器设置会根据您的光谱仪设置自动更新。

Nicolet Summit：DTGS。

Nicolet Summit Pro：TEC DTGS。

Optical velocity( 动镜速

率)

确定干涉仪中的动镜速率。默认值取决于您使用的检测器类

型，并且只能更改某些光谱仪上的默认值。

在 Nicolet Summit光谱仪上，默认值为 0.4747 并且不能更改。

Zero fill( 零填充)

所收集数据点之间的插值数据点。这不会增加数据的实际分辨

率，但可以平滑锐利的特征并改善光谱的线形。

使用相同的零填充设置采集样品和背景谱图。

选项

None( 无) ：不执行零填充。

1：在每个收集的数据点之间添加一个数据点

2：在每个收集的数据点之间添加三个数据点

2
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选项 说明 默认设置

Source( 光源)

光谱仪内部的组分，它发出射放到检测器的红外辐射。

光源类型取决于您的光谱仪设置。有关光源的详细信息，请参

阅您的光谱仪用户指南。

Apodization( 切趾)

切趾是指应用于单光束数据的数学函数，以减少或移除由于干

涉图不是无限数据集而可能出现的峰旁波束。

强切趾可减少更多噪声，但也会降低数据的分辨率并增宽峰。

如果您正在测量具有非常窄峰的光谱( 例如高分辨率气体光

谱) ，您可能需要考虑较弱的切趾，例如箱形。

有关每种切趾类型的说明，请参阅"切趾函数"。

Norton-Beer Strong
( Norton-Beer强)

Automatic Atmospheric
Suppression( 自动大气抑

制)

抑制水蒸气和二氧化碳对您所采集光谱的影响。

一般而言，最好使用当前的背景谱图来控制大气条件。如果经

常测量背景或大气条件变化缓慢，则无需使用此功能。

只有不经常测量背景或大气条件迅速变化时才使用此功能。

Deselected( 取消

选择)

Range Limits( 范围限制) 设置所采集光谱中包含的频率范围的限制( 以波数表示) 。
最大值：4,000

最小值：400

Aperture( 光阑)

控制到达样品的红外辐射强度。

只有在使用具有可调光阑的光谱仪时才能更改光阑。

一般而言，较大的光阑会产生更好的信噪比，而较小的光阑会

产生更好的稳定性和精度。小光阑更适合高分辨率测量。

您可能需要使用小光阑来采集真正的高分辨率光谱。

切趾函数

切趾是指应用于单光束数据的数学函数，以减少或移除由于干涉图不是无限数据集而可能出现的峰旁波束。

强切趾可减少更多噪声，但也会降低数据的分辨率并增宽峰。

有关切趾的一般介绍，请参阅 FTIR Spectroscopy Academy。

下表介绍了可用的切趾类型：

设置 说明

Boxcar
( 箱形)

未加权干涉图；也就是说，在开始和结束时截断数据。当您测量气体样品、想要获得最大分辨率并

且不在乎振铃效应( 旁波束) 时，请使用此类型。这种类型会出现最大数量的振铃。

Cosine
( 余弦)

此设置可抑制旁波束，并且只会适度降低谱图分辨率。此设置类似于 Happ-Genzel 和“Norton-Beer
中”切趾。Cosine( 余弦) 通常仅用于重现使用它的其他实验的结果。

Happ-
Genzel

比 Triangular( 三角形) 类型更有效地抑制旁波束，并且分辨率的降低也比该类型少。( 它导致的分

辨率降低比箱形类型多。)
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设置 说明

Norton-
Beer
Weak
( Norton-
Beer弱)

与 Norton-Beer Medium( Norton-Beer中) 和 Norton-Beer Strong( Norton-Beer强) 类型相比，此设

置对数据的平滑效果不那么明显，并且分辨率降低的程度也低于这些类型。旁波束出现在峰的两

侧，对于更尖锐的峰更明显。

只有在需要可能的最佳分辨率时才使用此设置。一般上不推荐使用此设置，通常仅用于重现使用它

的其他实验的结果。

Norton-
Beer
Medium
( Norton-
Beer中)

此类型对数据的平滑效果介于 Norton-Beer Weak( Norton-Beer弱) 和 Norton-Beer Strong( Norton-
Beer强) 类型之间。由于它只能适度降低光频分辨率，因此它只会尽可能地抑制旁波束。旁波束抑

制比 Norton-Beer Weak( Norton-Beer弱) 切趾更显著。此设置适用于大多数正常样品；它给出的结

果与使用 Happ-Genzel 获得的结果几乎相同。

Norton-
Beer
Strong
( Norton-
Beer强)

Norton-Beer Strong( Norton-Beer强) 是 Nicolet Summit和 Summit Pro 光谱仪的推荐切趾。

与 Norton-Beer Weak( Norton-Beer弱) 和 Norton-Beer Medium( Norton-Beer中) 类型相比，此设置

对数据的平滑效果更大，并且会更多地降低频谱分辨率。旁波束抑制比 Norton-Beer Medium
( Norton-Beer中) 切趾更显著。

Triangular
( 三角

形)

对干涉图数据进行数学加权以减少振铃效应( 旁波束) ，产生的分辨率低于使用箱形和 Happ-Genzel
类型所获得的分辨率。这种类型通常会出现一些振铃。此设置通常仅用于重现使用它的其他实验的

结果。

Blackman-
Harris

4 项 Blackman-Harris函数是一种强大的切趾函数，在抑制旁波束方面优于其他任何函数。然而，它

导致比其他任何一种都更大的线增宽。在实践中，它具有减少谱图中的随机噪声同时导致样品带增

宽的效果。
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测量背景

准确的样品光谱需要准确和当前的背景测量。

当您采集背景光谱时，您是在没有样品的情况下采集光谱仪中环境的测量值，包括检测器和光谱仪内部大气的特

征。然后，使用此背景谱图消除样品光谱中由光谱仪或背景环境产生的任何信号。如果不测量背景，就无法知道

您看到的是来自测量的样品还是来自背景环境的数据。

何时测量背景

由于光谱仪中的背景环境会随着时间的推移而变化，因此您应该经常更新背景谱图。

除了随着环境的变化定期采集新的背景谱图外，还需要在发生以下任何一种情况后采集新的背景：

l 您更换光谱仪中的硬件，包括更换采样附件

l 您更改测量样品的设置

背景设置

测量背景的时间和方式有多种选择。这些选项将决定何时以及是否提示您采集新的背景测量值。

要在触摸屏界面中选择不同的背景选项，请选择一个分析选项并打开 Background( 背景) 选项卡。

要在桌面界面中选择不同的背景选项，请在控制面板的 New Measurement( 新建测量) 窗格中单击 More( 更多)
并滚动至 Background( 背景) 组。
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图 4-1:在触摸屏界面的 Background( 背景) 选项卡中选择一个背景设置。

图 4-2:在桌面界面的 Background( 背景) 窗格中选择一个背景设置。

下表介绍了背景设置。

设置 说明

Background scans
( 背景扫描)

背景将测量多少次。产生的谱图代表所有扫描的平均值。更多次的扫描将产生更准确的

光谱，但也需要更长的采集时间。默认值为 10 次。

Measure before
every sample( 采

集样品前测量)

如果选择此选项，系统会在每次测量样品之前提示您采集新的背景谱图。如果您只需要

测量几个样品，这将是一个很好的选择，因为它不但可以确保当前的测量，还可以减慢

测量过程。

Measure every __
_ min( 每 ___ 分

钟测量一次)

允许您使用相同的背景谱图测量多个样品。您可以输入 1 到 1024 之间的任何整数值，但

请注意，背景环境可能会随着时间的推移而变化，并且您的样品光谱可能会随着时间的

推移而变得不那么准确。
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设置 说明

Smart background
( 智能背景)

“智能背景”功能将自动测量背景，让您无需手动测量背景，即可始终拥有当前测量值。

Use previous
background( 使用

指定背景)

允许您选择指定的背景谱图。只有在极少数和异常情况下使用此选项( 例如，如果不改

变系统环境就无法加载或移除样品) 。在这种情况下，您将使用尽可能接近测量样品条

件的条件来提早采集和保存背景谱图。

测量背景

只需几个简单的步骤即可完成测量背景。如果您尝试在没有当前背景谱图的情况下测量样品，系统将会提示您在

继续之前测量背景。

❖ 在桌面界面中测量背景

1. 从采样附件中移除任何样品。

2. 从控制面板，选择 Preview and Measure Background( 预览并测量样品) 。

将打开 Background Preview( 背景预览) 窗口，让您可以在继续采集之前预览背景。

3. 若要继续，选择 Start Background Measurement( 开始背景测量) ，或单击工具栏中的 Dashboard( 控制面

板) 以取消并返回控制面板。

在测量过程中，您可以暂停、重新开始或停止采集。如果停止採集，将使用部分数据。例如，如果您计划採

集 8 次扫描，但您在 4 次后停止，则背景谱圖将仅用于 4 次扫描。

採集背景谱圖后，您可以预览样品光谱并对样品测量设置进行任何必要的更改，或者您可以返回控制面板。

❖ 在触摸屏界面中测量背景

1. 从主屏幕，选择一个分析类型。

2. 打开 Background( 背景) 选项卡，编辑或查看您的背景设置。

3. 要开始测量，点按 Measure Background( 测量背景) 。

将打开 Background Preview( 背景预览) ，让您可以在继续之前预览背景。

4. 若要继续，点按 Start Background Measurement( 开始背景测量) 。

在测量过程中，您可以暂停、重新开始或停止采集。如果停止採集，将使用部分数据。例如，如果您计划採

集 8 次扫描，但您在 4 次后停止，则背景谱圖将仅提供 4 次扫描的数据。

测量背景谱图后，您可以预览样品光谱并对样品测量设置进行任何必要的更改，或者您可以在菜单中选择

Home( 主页) 以返回主屏幕。
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测量样品

若要测量样品，需要准备样品、设置并保存您的测量设置、测量背景谱图，最后测量样品。

❖ 使用用于触摸屏的 OMNIC Paradigm软件测量样品

1. 准备样品

准备样品的方式取决于光谱仪和采样附件。有关准备和加载样品的详细信息，请参阅采样附件的用户指南。

2. 选择可反映您正在执行的分析的分析类型。要测量没有附加分析的样品，选择 Measure( 测量) 。

选择分析类型后，将打开设置摘要视图。

图 4-1:Summary( 摘要) 选项卡显示常用测量设置。

3. 查看并编辑您的测量设置。

打开 Details( 详细信息) 选项卡可查看附加测量设置，或打开 Background( 背景) 选项卡调整背景测量方式

的设置。根据您的背景设置，系统可能会提示您在测量样品之前测量新背景。

有关每个设置的说明，请参阅"设置并保存测量选项"。

有关设置分析的详细信息，请参阅"使用 ATR 鉴别未知样品"。
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4. 对设置感到满意后，点按 Measure Sample( 测量样品) 。将打开 Sample Preview( 样品预览) 并显示光谱的

实时预览。

5. 若要继续，点按 Start Sample Measurement( 开始样品测量) 。

在测量过程中，您可以暂停、重新开始或停止并保存您的测量。例如，如果您觉得您的数据已足够并且不想

等待更多扫描，可点按 Stop( 停止) 按原样保存和使用数据。点按 Restart( 重新开始) 可清除所有数据并从

头开始扫描。

测量样品后，可以在光谱视图中处理或分析该样品，也可以测量另一个样品。要从光谱视图测量另一个样品，请

点按 Measure New Sample( 测量新样品) 。

❖ 使用用于桌面的 OMNIC Paradigm软件测量样品

1. 准备样品

准备样品的方式取决于光谱仪和采样附件。有关准备和加载样品的详细信息，请参阅采样附件的用户指南。

2. 要编辑 Search( 搜索) 、QCheck或 Quantify( 定量) 分析的设置，打开 Identify( 鉴别) 菜单并打开相应的设

置选项。

3. 设置并保存您的测量设置。

要使用先前保存的设置，请从 Settings( 设置) 列表中选择该设置。

图 4-2:Settings( 设置) 列表显示您先前保存的设置

有关每个设置的说明，请参阅"设置并保存测量选项"。

有关设置分析的详细信息，请参阅"使用 ATR 鉴别未知样品"。

4. 在 New Measurement( 新建测量) 窗格中，单击 Preview and Measure Sample( 预览并测量样品) 。

根据您的背景设置，系统可能会提示您测量新背景。如果是这样，请按照屏幕上的提示测量新背景。

测量样品时，您可以暂停、重新开始或停止并保存您的测量。例如，如果您觉得您的数据已足够并且不想等

待更多扫描，可单击 Stop( 停止) 按原样保存和使用数据。单击 Restart( 重新开始) 可清除所有数据并从头

开始扫描。

测量样品后，可以在光谱视图中处理或分析该样品，也可以测量另一个样品。要从光谱视图测量另一个样品，请

单击 More( 更多) 查看常用测量设置，然后单击 Measure New Sample( 测量新样品) 来开始。
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后续步骤

只需几个简单的步骤即可使用 OMNIC Paradigm软件测量样品。测量样品之前，查看您的测量设置并确保您有使用

最近的背景谱图。

测量光谱后，您就可以鉴别、验证或定量光谱。有关使用谱库搜索来鉴别样品的指南，请参阅“"使用 ATR 鉴别未

知样品"”。

处理数据

使用 OMNIC Paradigm软件中的处理工具可以更好地了解您的数据。
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将基本公式应用至采集的数据

您可以对采集的样本光谱执行基本公式( 加、减、乘和除) 。您可能需要执行这些操作的原因有很多，尤其是在

减去参比谱图的情况下。有关更多信息，请参阅以下部分。

执行谱图数学运算

要执行谱图数学运算，样品和参比谱图必须具有相同的光谱分辨率并使用相同的 Y轴单位。如果不是，软件会自

动转换选定的参比谱图以匹配选定的样品光谱。若要对光谱执行减去、相乘或相除，两个光谱的谱图范围( X轴)
的至少一部分必须重叠。

❖ 在光谱上执行任何谱图数学运算

1. 采集或打开样品的光谱，并确保在光谱视图中选择该谱图。

2. 选择 Process( 处理) ( 菜单) > Spectral Math( 谱图数学运算) 。

软件将打开 Spectral Math( 谱图数学运算) 设置窗口，左窗格显示样品光谱，右窗格留出空间用于参比谱

图。

图 4-1:Spectral Math Setup( 谱图数学运算设置) 窗口

3. 使用两个窗格之间的设置列表来选择谱图数学运算( Subtract( 减) 、Add( 加) 、Multiply( 乘) 或 Divide
( 除) ) 。
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4. 使用 Select Reference( 选择参比谱图) 列表在当前项目、另一个项目或谱库中搜索光谱。

5. 单击 Subtract( 减) ( Add( 加) , Multiply( 乘) 、Divide( 除) ) 开始运算。

软件将打开 Spectral Math( 谱图数学运算) 窗口，其中包含两个原始光谱( 底部) 和带有系数滑动条( 顶

部) 的当前结果。以下示例显示减法结果：

1. 当前减法结果

2. 系数

3. 样品

4. 参比

6. 根据需要调整或输入一个系数，增加或减少结果光谱中参比的强度。

有关调整每个数学运算类型的系数的提示，请参阅以下部分。

注释使用底部栏更改 Factor( 系数) 的可调范围。

7. 选择 Save( 保存) 。

软件将在光谱面板和结果面板顶部显示带有减法结果的光谱视图，原始样品和参比谱图位于其正下方。
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从另一个光频中减去一个光频 (A-B)

使用 Subtract( 减) 可从另一个光频中减去一个光频。减去光谱在各种情况下都很有用。这里为您提供一些示例：

l 如果您测量溶解在溶剂中的样品，光谱将包含由于该溶剂而产生的峰。通过从样品光谱中减去纯溶剂的光谱，

可以消除溶剂峰并生成样品材料的“干净”光谱。

l 当您测量由两种或多种组分混合而成的样品时，理论上光谱是所有组分的光谱之和。通过从样品光谱中减去纯

组分的光谱，可以生成去除了该组分的更简单混合光谱。然后，可以根据谱库搜索该光谱以鉴别剩余的组分。

( 在这种情况下，您可能想尝试改用 Multi-Component Search( 多组分搜索) 选项。)

l 如果您测量含有未知污染物的样品，光谱将包含由于该污染物而产生的峰。通过从第一个光谱中减去未受污染

样品材料的光谱，可以生成污染物的残留光谱。然后，可以根据谱库搜索该光谱以鉴别污染物。

l 如果采集光谱来监控正在生产的材料的质量，可以通过从下一个样品光谱中减去一个样品光谱( 反之亦然) ，

而不是仅通过视觉比较光谱，从而更轻松地检测从一个批次到下一个批次的变化。

关于减去光谱的提示

l 要确定减法系数，请在更改系数时观察共有峰的变化。结果谱图中的共有峰应该变小。最佳系数是在减法结果

中生成归零的共有峰值而不减去其他重要光谱谱信息的系数。如果使用正确的系数，结果中出现的峰将完全取

决于目标样品材料。

l 从显示的区域自动计算初始减法系数。如果显示不同的光谱区域并再次执行减法，差异光谱可能会因为减法系

数改变而有所不同。

l 从样品光谱中减去参比谱图时，将同时减去基线区域与包含峰的区域。如果样品光谱的基线不平坦且处于零吸

光度( 或 100% 透过率) ，则减法结果的基线将具有相同的不良特征。如果首先校正基线，则可以获得“干净”
的减法，其中相应的峰被减去，结果中没有基线问题。
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l 从混合物的光谱中减去纯参比材料的光谱时，可能不会完全减去峰。这是因为参比谱图没有考虑由于与混合物

中其他组分的分子相互作用或组分相对浓度的差异而可能发生的任何变化。这些条件可能会导致一些峰轻微移

动或改变形状。

将两个光谱相加 (A+B)

使用 Add( 加) 可以将两个光谱相加。添加光谱在以下情况下很有用：

l Add( 加) 可用于将不同光谱范围的两个光谱连接在一起。

l 通过将两个纯组分光谱相加，可以生成一个理论复合光谱，即两个组分光谱的和。该理论复合光谱可以与定量

分析中的未知混合物光谱进行比较。

关于添加光谱的提示

l 使用 Factor( 系数) 设置可在将参比谱图添加到样品光谱之前将它放大或缩小。

l 如果只有其中一个光谱包含光谱区域中的数据点，则在添加光谱时，另一个光谱的 Y值在该区域中被视为

零。

将一个光谱与另一个光谱相乘 (A*B)

使用 Multiply( 乘) 可以将两个光谱相乘。大多数人在大多数应用中使用除法而不是乘法。但是光谱相乘对于重新

处理具有不同背景的光谱很有用。例如，如果测量粘附在基质上的样品，可以获得仅基质的单光束光谱，以及使

用该光谱抵消原始背景并将其替换为新背景。公式如下所示：

S * B1/B2

其中：

S =样品谱图( 用原始背景处理)
B1 =原始背景

B2 =新背景

将两个光谱相除 (A/B)

使用 Divide( 除) 可将两个光谱相除。相除光谱可用于重新处理具有不同背景的光谱。例如，如果测量粘附在基

质上的样品，可以获得仅基质的单光束光谱，以及使用该光谱抵消原始背景并将其替换为新背景。公式如下所

示：

S / (B2/B1)

其中：

S =样品谱图( 用原始背景处理)
B1 =原始背景

B2 =新背景

关于相除光谱的提示

l 在原始样品光谱中具有零吸光度值的数据点将在结果光谱中产生非常强的吸光度值。

123 OMNIC Paradigm软件用户指南 ThermoScientific



使用数据安全软件执行 SPECTRAL MATH( 谱图数学运算 )

如果在 Thermo Scientific Security Suite 中启用了“Require reason for change for Spectral Math”( 要求更改谱图数学运

算的原因) ，Spectral Math( 谱图数学运算) 将会要求提供更改原因和签名才能保存结果，并且会在审计日志中记

录以下更改事件：

l 日期和时间

l 执行的运算：加、减、乘、除

l 样品光谱标题

l 参比谱图标题

l 系数
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高级谱图数学运算

Advanced Spectral Math( 高级谱图数学运算) 提供比标准谱图数学运算更多的灵活性和功能。虽然标准谱图数学

运算支持使用单个参比谱图进行谱图的加、减、乘、除，但 Advanced Spectral Math( 高级谱图数学运算) 允许您

使用多达 10 个参比谱图并使用更广泛的操作来构建自定义公式。

对于许多应用，在谱图数学运算中使用标准的加、减、乘、除函数既简单又足够。但是，如果您的分析需要更复

杂的公式，则可能需要 Advanced Spectral Math( 高级谱图数学运算) 。

两种形式的谱图数学运算仅在 OMNIC Paradigm软件的桌面界面中可用。

在这两种方法之间进行选择时，请考虑以下差异以决定哪种工具适合您：

l Standard Spectral Math( 标准谱图数学运算)

l 仅支持使用带有滑块来调整系数的单个参比谱图进行加、减、乘、除。

l Advanced Spectral Math( 高级谱图数学运算)

l 灵活的公式构建器，可使用基本加、减、乘、除以及导数、指数等

l 公式中可包含多达十个不同的参比谱图

执行高级谱图数学运算

使用 Advanced Spectral Math( 高级谱图数学运算) 时，您通常会添加您将在公式中使用的谱图，构建您的公式，

预览结果，最后在光谱视图中查看结果。

❖ 执行高级谱图数学运算

1. 在光谱视图中，选择要在 Advanced Spectral Math( 高级谱图数学运算) 中使用的测量。

2. 打开 Process( 处理) 菜单并选择 Advanced Spectral Math( 高级谱图数学运算) 。将打开公式构建器。
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图 4-1:Advanced Spectral Math( 高级谱图数学运算) 视图

3. 在公式中添加要使用的参比谱图。

您可以添加多达 10 个谱图，并且不需要使用您打开的每个谱图。您可能会觉得先添加光谱以便在运行公式时

可以使用这些光谱会比较轻松，或者您可能会更喜欢只在需要时添加光谱。

a. 选择参比谱图或谱库光谱。添加光谱时，将会自动打开一个选项卡。

l 如果您在公式中使用商业( 锁定) 谱库中的光谱，则无法导出结果。

4. 构建公式。

a. 单击一个运算符，将其加入公式中。

b. 添加运算符后，您可以单击任何开放的 空间以插入光谱或另一个运算符。

l 要添加光谱，请选择开放空间，然后选择光谱并 并单击 Insert into Equation( 单击插入公式中) 。

l 要添加运算符，请单击该运算符。如果已经选择了一个开放的 空间，运算符将会自动插入该位置。如

果没有选择任何空间，新的运算符将环绕当前公式。

l 您还可以保存公式或加载先前的公式。

l 要保存公式，只需单击 Save( 保存) 即可。该公式将会添加到可用公式列表中。

l 要加载先前的公式，必须先打开公式中使用的正确数量的光谱。例如，如果公式使用 3 个光谱( A、B
和 C) ，则打开至少 3 个光谱。您打开的光谱将自动插入公式的相应位置，但可以根据需要编辑公式

或替换光谱。

c. 对公式感到满意后，单击 Calculate( 计算) 以预览结果。

5. 预览结果。
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图 4-2:顶部显示结果，底部显示您的参比谱图。

结果预览显示公式产生的光谱以及公式中使用的每个光谱。结果显示在顶部窗格中，您的参比谱图显示在底

部窗格中。

l 要编辑公式，请单击 Cancel( 取消) 返回上一个屏幕。

l 要保存公式的结果，请输入结果光谱的名称或保留默认值并单击 Save( 保存) 。

6. 在光谱视图中查看结果。

结果光谱列在 Results( 结果) 窗格中。公式中使用的光谱显示在结果光谱下方的子窗格中，并带有一个标

签，表明它们在公式中的用途。

高级谱图数学运算中可用的函数

函数 说明

k 常数
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函数 说明

? + ? 加

? - ? 减

? * ? 乘

? / ?  除

log(?) 对数。返回基数为 10 的对数

exp(?) 返回常数 e (2.7182818)是指定值的次幂的结果

sqrt(?) 值的平方根

deriv(?) 导数

savderiv(?) Savitsky-Golay导数

norderiv(?) Norris导数

重新处理光谱

您可以使用 Reprocess( 重新处理) 通过新的设置转换光谱的原始干涉图数据。

将您的光谱与参比谱图进行比较时，如果两个光谱都使用相同的设置进行处理，将可以获得更准确的比较。例

如，如果您的光谱使用比参比谱图更宽的范围进行采集，或者如果它使用了不同的切趾技术，那么您的比较可能

不准确。重新处理功能允许您转换原始数据以匹配参比谱图，从而使您的相关性、QCheck或量化分析产生更好的

结果。

重新处理后的分辨率不能比最初使用的更精细。重新处理功能可以转换您的数据，但不能填充从未采集过的数

据。

如果您重新处理多个光谱，则选项将仅显示它们共享的值。例如，如果以更精细的分辨率测量一个光谱，则可以

只选择共享的较低分辨率进行重新处理。这也适用于范围。您可以将 Truncate( 截断) 的最大值和最小值设为仅

共享的重叠范围。

❖ 重新处理您的光谱

重新处理功能仅在软件的 Desktop( 桌面) 视图中可用。

1. 在 Spectra( 光谱) 视图中，选择一个或多个光谱。

2. 进入 Process( 处理) 菜单并选择 Reprocess( 再处理) 。Reprocess( 再处理) 对话框将显示用于重新处理的

设置和结果光谱的预览。如果重新处理多个光谱，预览将仅显示第一个光谱。
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3. 更改再处理设置。要使用不同的背景谱图来重新处理光谱，请选择 Replace background spectrum( 更换背景

谱图) 然后选择要使用的新光谱。

4. 单击 Apply( 应用) 重新处理光谱。

您可以通过查看 History( 历史记录) 面板并恢复到较早的状态来撤消重新处理。如果重新处理了多个光谱，则必

须个别恢复每个光谱。

空白光谱中的区域

使用 Process( 处理) 菜单中的 Blank Regions( 空白区域) 可清除光谱区域中的数据。您还可以使用( 处理) 磁

贴来空白工作流中的区域。

Blank Regions( 空白区域) 工具是消除会干扰分析的多噪音数据的好方法。例如，在以下情况下空白区域会有所

帮助：

l 由于样品太厚，您的光谱具有完全吸收峰。当您根据谱库搜索光谱或者量化或减去光谱时，这些峰顶部的随机

噪音会导致结果不佳。

l 您的光谱包含低于 MCT检测器( 约 700 个波数) 截止或衰减全反射 (ATR)晶体截止的区域。这些区域仅包含

噪音，因为不存在光谱信息。如果您不排除这些区域，它们将会干扰谱库搜索和光谱处理。

空白区域

您可以空白一个或多个光谱上的区域。
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1. 选择包含您要空包的区域的光谱。按住 CTRL 并单击可选择多个光谱或按 CTRL + W选择所有光谱。

2. 进入 Process( 处理) 菜单并选择 Blank Regions( 空白区域) 。如果您选择了多个区域，它们将显示在叠加视

图中。

3. 使用区域选择器选择您要删除的区域。单击 Add Region( 添加光谱区域) 以删除多个区域，然后单击 Apply
( 应用) 使这些区域空白。

要撤消更改，请查看光频的历史记录并恢复到先前的状态。

计算平均和标准偏差光谱

要找出光谱的平均值或标准偏差，请使用 Process( 处理) 菜单中的 Statistical Spectra( 统计光谱) 工具。

对于光谱的每个 X值，您可以找到 Y值的平均值或标准偏差。这会创建一个新的光频。

l Average(平均值)：找出每个数据点的 Y值的算术平均值。如果您对样品材料进行了多次测量，则可以计算平

均光谱以减少测量变化的影响。平均光谱也可用作参比光谱，因为它可能比任何单一测量更能代表化合物。

l Standard Deviation(标准偏差)：找出每个数据点的 Y值的标准偏差。通过比较峰的方差，您可以检测是否在生

产过程中引入了杂质。

您还可以使用标准偏差来比较您在不同时间测量的标准样品的光谱。这是测试测量重复性的有用方法。

您只能在软件的 Desktop( 桌面) 视图中计算统计光谱。使用 Processing( 处理) 磁贴可计算工作流中的统计光

谱。
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❖ 计算统计光谱

1. 从 Spectra( 光谱) 视图，选择要用于计算的 2 个或更多光谱。

2. 进入 Process( 处理) 菜单并选择 Statistical Spectra( 统计光谱) 。

3. 选择要执行的计算和用于计算的数据格式，然后选择 Calculate( 计算) 。结果光谱将添加到 Results( 结果)
窗格中。您可以在新光谱的测量信息中查看用于生成新光谱的光谱。

通过平滑光谱减少噪音

使用 Process( 处理) 菜单中的 Smooth( 平滑) 可消除随机噪音并改善光谱形状。平滑功能使用 Savitsky-Golay算
法。

可使用两种类型的平滑操作：

l 自动平滑：自动平滑通常会实现令人满意的结果，并且比手动平滑更快。

l Savitzky-Golay平滑：手动设置算法中使用的点数。使用更多点会产生更大程度的平滑。

这些图像显示了将最激进的 Savitzky-Golay平滑应用于噪音多光谱的结果。这是光谱的放大部分，以便更容易显示

差异。

平滑前的光谱

应用平滑功能后的光谱

平滑具有窄实际样品峰的光谱时务必小心，因为这些特征也会被平滑。平滑会降低数据的有效光谱分辨率，并且

可以去除( “平滑”) 小的光谱特征。

131 OMNIC Paradigm软件用户指南 ThermoScientific



通常，最好使用更多扫描和更好的分辨率来测量样本，而不是使用平滑。

平滑应用于当前选定的光谱，不会创建新的结果光谱。

桌面界面

❖ 应用自动平滑

1. 在 Spectra( 光谱) 视图中打开您的光谱。

2. 选择光谱后，进入 Process > Smooth Spectrum > Automatic( 处理 >平滑光谱 >自动) 。

系统将会自动应用平滑功能。要撤消平滑，可通过查看测量历史记录进行。

❖ 应用 Savitsky-Golay平滑

1. 在 Spectra( 光谱) 视图中打开您的光谱。

2. 选择光谱后，进入 Process > Smooth Spectrum > Savitzky-Golay( 处理 >平滑光谱 > Savitzky-Golay) 。

3. 设置 Savitzky-Golay算法使用的平滑点数。

l 平滑点数用于设置算法中所使用移动窗口的大小。使用更多点会产生更平滑的效果。

4. 单击 Save( 保存) 。

触摸屏界面

❖ 应用自动平滑

1. 在 Spectra( 光谱) 视图中打开您的光谱。

2. 选择光谱后，进入 Spectral Smoothing > Automatic( 光谱平滑 >自动) 。

系统将会自动应用平滑功能。要撤消平滑，可通过查看测量历史记录进行。

❖ 应用 Savitsky-Golay平滑

1. 打开测量。

2. 打开主菜单并选择 Spectral Smoothing > Savitzy-Golay( 光谱平滑 > Savitzy-Golay) 。

3. 设置 Savitzky-Golay算法使用的平滑点数。

l 平滑点数用于设置算法中所使用移动窗口的大小。使用更多点会产生更平滑的效果。

4. 选择 Save( 保存) 。

标准化光谱刻度

使用 Normalize( 标准化) 可将所选光谱的 Y轴刻度更改为“标准”刻度，其中数据点范围的 Y值从最低点的 0 吸光

度单位到最高峰的 1 吸光度单位( 对于类似吸光度的光谱) 或从 10% 到 100% 的透过率( 对于类似透射的光
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谱) 。这些标准刻度是商业光谱库中光谱的典型刻度。

标准化光谱刻度后，除非您知道缩放系数并相应地调整定量结果，否则无法将其用于定量分析。

桌面界面

要标准化桌面界面的刻度，请从 Spectra( 光谱) 视图，进入 Process > Normalize( 处理 >标准化) 。

触摸屏界面

要标准化触摸屏界面的刻度，请从 Spectra( 光谱) 视图，打开主菜单，然后选择 Spectral Corrections > Normalize
Scale( 光谱校正 >标准化刻度) 。

分析数据

OMNIC Paradigm软件中的分析工具可用于鉴别未知样品并验证样品的成分。

鉴别样品和混合物

在 OMNIC Paradigm软件中，您可以使用相关性和多组分搜索来鉴别样品和混合物。在这些类型的分析中，样品的

光谱将与存储在谱库中的光谱进行比较，软件会找到最佳匹配。在相关性搜索中，每个结果都是一个化合物，而

在多组分搜索中，每个结果将显示构成整个复合光谱的几种化合物。

鉴别样品和混合物

要鉴别样品和混合物，请如常测量您的样品。在 Spectra( 光谱) 视图中，进入 Identify( 鉴别) 菜单，选择

Correlation( 相关性) 搜索以查找单个匹配项，或选择 Multi-Component( 多组分) 搜索以鉴别复合匹配项及其构

成光谱的化合物。

搜索设置

使用 Search Setup( 搜索设置) 可配置相关性搜索和多组分搜索的设置。当您从桌面界面的 Identify( 鉴别) 菜单

或触摸屏界面的主菜单中选择 Correlation Search( 相关性搜索) 或 Multi-component Search( 多组分搜索) 时，将

会自动使用这些设置。

使用桌面界面，您还可以使用 Search Setup( 搜索设置) 来指定系统上附加谱库的位置。请参阅"添加谱库位置"了
解详情。

Correlation Search( 相关搜索 ) 设置

相关性搜索会将您的测量结果与谱库中的化合物进行比较，并返回最接近的匹配项。结果包含每个化合物的匹配

值，该值介于 0 和 100 之间，100 表示完美匹配。
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图 4-1:相关搜索设置

设置 说明

Match historical search results( 匹配历史搜索结

果 )

选择此设置可以使搜索结果与旧版 OMNIC 应用程序的搜索结果相匹

配。

OMNIC Paradigm软件中使用的改进算法可缩放大峰以减少完全吸收

光谱的影响。

只有在您将新测量值与使用旧版 OMNIC 软件收集的旧数据进行比较

时才选择此设置。

Maximum spectra in search results( 搜索结果中

的最大谱图数量 )

限制搜索结果的数量。例如，如果最大数量为 5 个，搜索将只返回

5 个最佳匹配项。

您可以输入 1 到 20 之间的值。

Show compoundswithmatch valuesabove ____
( 显示匹配值高于 ____的化合物 )

设置搜索返回匹配项的阈值。例如，如果值为 60，相关性搜索将仅

返回匹配值大于 60 的匹配项。

Search all libraries( 搜索全部谱库 )
选择此设置可搜索全部谱库。清除选择以仅指定用于搜索的特定谱

库。

Use full spectral range( 使用全谱图范围 )

选择此设置可使用全光谱范围进行搜索。清除选择以指定一个或多

个受限搜索范围。

您可以使用多个区域从搜索中排除另一个区域。例如，在完全吸收

峰的任一侧包括一个区域以将其从搜索中排除。
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Multi-Component Search( 多组分搜索 ) 设置

使用多组分搜索可鉴别构成样品的组分。

图 4-2:多组分搜索设置

设置 说明

Maximumnumber of search results( 最

大数量搜索结果 )
限制复合物搜索结果的数量。

Number of components( 组分数量 ) 设置要为每个复合物返回的组分数量。

Search all libraries( 搜索全部谱库 ) 选择此设置可搜索全部谱库。清除选择以仅指定用于搜索的特定谱库。

Use full spectral range( 使用全谱图范

围 )

选择此设置可使用全光谱范围进行搜索。清除选择以指定一个或多个受限搜

索范围。

您可以使用多个区域从搜索中排除另一个区域。例如，在完全吸收峰的任一

侧包括一个区域以将其从搜索中排除。

使用 QCheck验证您的样品

在 QCheck分析中，您的样品将与已知的参比谱图进行比较，软件会提供匹配值和通过或失败结果。QCheck非常

适合快速验证样品是否符合您的内部标准。

有关使用 QCheck的更详细演示，请参阅"使用 QCheck验证样品成分"。
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使用 QCHECK验证样品

要执行 QCheck分析，请如常测量您的样品。然后，在 Spectra( 光谱) 视图中，进入 Identify( 鉴别) 菜单并选择

QCheck。

QCHECK设置

使用“QCheck设置”可配置 QCheck分析。当您在测量样品前选择 QCheck作为分析类型或从 Identify( 鉴别) 菜单

中选择 QCheck时，将自动使用您保存的 QCheck设置。

有关使用 Qcheck的更多信息，请参阅"使用 QCheck验证样品成分"。

图 4-1:QCheck设置屏幕

设置 说明

High Sensitivity( 高灵

敏度)
在与参比谱图非常相似的样品之间选择高灵敏度以获得更精确的结果。如果测量具有某

些自然变化的样品，您可能需要取消选择高灵敏度。

Pass/fail threshold( 通

过 /失败阈值)

设置通过或失败的阈值。输入 0 到 100 之间的整数。

相关性值为 100 表示完美匹配。

如果取消选择此选项，所有结果都将显示 Pass( 通过) 。
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设置 说明

Maximum spectra in
QCheck results
( QCheck结果中谱图

的最大数量)

设置结果面板中显示的结果数。例如，如果将该值设为 2，结果面板中将仅显示两个最

佳匹配项。

Prompt for reference
( 提示参比谱图)

选择此项可在测量期间选择参比谱图。取消选择此项可预先指定一个或多个参比谱图。

如果您计划将多个样品与相同的参比谱图进行比较，提前设置它们会很方便，可避免每

次测量样品时都必须选择相同的参比谱图。

要将谱库中的化合物用作参比谱图，首先提取该化合物，使其在您的数据库中可用。

Blank diamond ATR
region (2200 - 1955)
( 金刚石 ATR 区域

(2200 - 1955)生成空

白)

选择此项可排除从 2200 波数到 1955 波数的区域中的数据，其中金刚石 ATR 晶体吸收

辐射。

Blank CO2 region (2390
- 2240)( CO2 区域

(2390 - 2240)生成空

白)

选择此项可排除从 2390 波数到 2240 波数的区域中的数据，其中二氧化碳吸收辐射。

Use full spectral range
( 使用全谱图范围)

选择此项可在分析中使用全范围。

取消选择此项可以仅指定用于分析的有限范围。

鉴别污染物

如果您有已知物质并且想要检查任何其他意外材料，请使用污染物分析。污染物分析会将已知材料的参比谱图与

实际光谱进行比较，并鉴别潜在的污染物。与 QCheck不同，该工具将您的光谱与单个参比谱图进行比较并报告匹

配值以及通过或失败结果，而污染物分析则可鉴别样品中可能存在的污染物。

污染物分析的结果将为您显示可能存在哪些污染物以及大约数量。

设置和使用污染物分析

桌面和触摸屏界面都有提供污染物分析。

桌面界面中的污染物分析

❖ 使用污染物分析

1. 在 Search Setup( 搜索设置) 中分配一个参比谱图。

a. 进入 Identify > Search Setup( 鉴别 >搜索设置) 。

b. 选择 Contaminant Analysis Search( 污染物分析搜索) 选项卡。

c. 选择一个参比谱图。这是您已知材料的光谱。

d. 查看您的其他设置。
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2. 单击 Save( 保存) 。

3. 在 Spectra( 光谱) 视图中，选择要分析的光谱。

4. 进入 Identify > Search > Contaminant Analysis( 鉴别 >搜索 >污染物分析) 。

片刻之后，光谱视图将会显示分析结果。

触摸屏界面中的污染物分析

❖ 使用污染物分析

1. 在 Search Setup( 搜索设置) 中分配一个参比谱图。

a. 打开主菜单并选择 Search Setup( 搜索设置) 。

b. 选择 Contaminant Analysis Search( 污染物分析搜索) 选项卡。

c. 选择一个参比谱图。这是您已知材料的光谱。

d. 查看您的其他设置。

2. 选择 Save( 保存) 。

3. 在 Spectra( 光谱) 视图中，选择光谱。

4. 打开主菜单并选择 Search > Contaminant Analysis( 搜索 >污染物分析) 。

片刻之后，光谱视图将会显示分析结果。

污染物分析设置

设置 说明

Max number of results( 最

大结果数)
设置返回多少个复合结果。例如，如果您设置 2 个结果，污染物分析将显示 2
个按匹配值排序的可能复合物。

Number of contaminants
( 污染物数)

设置每个复合物的化合物数量。例如，对于 3 种污染物，在您的结果中，每个

复合光谱将包括 3 种可能的污染物。

Search all libraries( 搜索全

部谱库)
选择要在搜索中使用的谱库。使用的谱库越少，分析的速度越快。

Select reference source( 选

择参比源)
指出您的参比谱图是否在谱库中，或者它是否数据库中的独立测量。

Select reference( 选择参

比)
您的已知化合物。在污染物分析结果中，每个复合物都将包括您的已知化合物

和可疑污染物。

Use full spectral range( 使

用全谱图范围)
限制分析中的范围或使用全谱图。
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解读结果

与其他搜索分析一样，污染物分析的结果显示在光谱视图中。Results( 结果) 窗格列出了每种复合物和潜在污染

物。

特性 说明

A 样品光谱和复合光谱

B 复合物中化合物的光谱，包括已知化合物

C 显示或隐藏复合物的详细信息

D 复合物匹配值显示复合光谱与样品的匹配程度，100 表示完美匹配。

E 将鼠标悬停在灰色箭头上可查看每种化合物的详细信息。

每种化合物的详细信息包括：

化合

物名

称

化合物的名称
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累积

累积值显示每个组分对整体复合匹配值的贡献。第一个组分的累积值显示其对整体匹配的贡献，每个

附加组分的贡献都会增加整体匹配值。

例如，考虑匹配值为 80 的复合物，包括累积值为 70 的化合物和累积值为 80 的化合物。

在该例子中，第一个化合物对匹配值的贡献为 70，第二个化合物对匹配值的贡献为另外 10。

复合

物 %

复合物百分比值表示复合物中参比化合物的量。例如，复合物值 55% 意味着该组分对总复合光谱的

贡献为 55%。复合物百分比值的总和始终为 100%。

请注意，复合物百分比值显示化合物对复合物的贡献，而不是对实际样品的贡献。换言之，所找到组

分的 55% 复合物值并不一定意味着样品混合物包含该组分的 55%。

谱库

名称
找到化合物的谱库的名称

索引

号
化合物在谱库中的位置

搜索

的区

域

谱库搜索中使用的光谱区域

创建报告

从模板生成报告，以 Microsoft Word、PowerPoint或 Excel 文件格式快速保存和共享您的数据。或者，导出您的光

谱、工作流和设置以与您的同事共享。
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创建与共享报告和导出数据

从模板生成报告，以 Microsoft™ Word™、PowerPoint™或 Excel™文件格式快速保存或共享您的数据，或者导出您的

光谱、工作流或设置。

❖ 从桌面界面创建报告

1. 从 Spectra( 光谱) 视图，选择 File > Create Report( 文件 >创建报告) 。

2. 输入报告的标题，并选择格式和模板选项。预览将更新以匹配您的选择。

如果选择Save (保存)为您的格式，您的报告将保存到数据库中。

3. 要配置模板，请单击 Options( 选项) 并选择要包含的项目。单击 OK( 确定) 保存您的选择。

4. 单击 Create( 创建) 。

❖ 从触摸屏界面创建报告

1. 从 Spectra( 光谱) 视图，打开菜单并选择 Create Report( 创建报告) 。

2. 输入报告的标题，选择用于保存报告的目录，选择格式，最后选择模板。预览将更新以匹配您的格式和模板选

择。

如果选择Save (保存)为您的格式，您的报告将保存到您的数据库中。

3. 要配置模板，请点按 Options( 选项) 并选择要包含的项目。点按 OK( 确定) 保存您的选择。
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4. 点按 Create( 创建) 。

导出设置、光谱或工作流

使用桌面版 OMNIC Paradigm软件导出设置和工作流。以桌面或触摸屏模式导出光谱。

❖ 导出设置

1. 从 Settings( 设置) 列表中选择要导出的设置。

2. 选择 Acquire Data > Export Settings( 采集数据 >导出设置) 。

3. 命名设置文件并单击 Save( 保存) 。

设置将以 .expx文件扩展名保存。这些设置文件会存储您的测量设置，但不会存储 Search( 搜索) 、QCheck
或 Quantification( 定量) 设置。带有 .expx文件扩展名的设置文件与之前的 OMNIC 软件版本不兼容。

❖ 导出工作流

l 如果您使用桌面界面

a. 在 Workflows( 工作流) 窗格中，右击要导出的工作流并从菜单中选择 Export( 导出) 。

b. 命名工作流文件并单击 Save( 保存) 。

c. 工作流文件将以 .rwfl 文件扩展名保存。
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l 如果您使用触摸屏界面

a. 在 Workflows( 工作流) 选项卡中，选择要导出的工作流并从菜单中选择更多选项。

b. 选择 Export( 导出) 。

c. 命名工作流文件并点按 Save( 保存) 。

d. Workflow( 工作流) 文件将以 .rwfl 文件扩展名保存。

❖ 导出测量

l 如果您使用桌面界面

a. 在 Measurements( 测量) 窗格中，右击要导出的光谱并从菜单中选择 Export( 导出) 。

b. 命名光谱文件并单击 Save( 保存) 。光谱将以 .spa 文件扩展名保存。

l 如果您使用触摸屏界面

a. 从主屏幕，选择 Measurements( 测量) 选项卡。

b. 打开更多选项菜单 [ ]并选择 Export( 导出) 。

c. 点按 Save( 保存) 。光谱将以 .spa 文件扩展名保存。

创建历史光谱报告

Historical Spectrum( 历史光谱) 报告包含有关在您进行处理和分析时，测量如何随时间逐渐变化的详细信息。该

报告显示了历史记录中每个步骤的光谱。

创建测量历史报告类似于创建其他报告，但需要先打开 Historical Data( 历史数据) 视图。如果从标准光谱视图中

打开 Create Report( 创建报告) ，则 Historical Spectrum( 历史光谱) 模板将不可用。

❖ 创建历史光谱模板报告

1. 使用桌面界面，在光谱视图中打开一个测量。

2. 导航至 Measurement History( 测量历史记录) 选项卡。

3. 右击历史记录中的任何项目并选择 Measurement History( 测量历史记录) 。

143 OMNIC Paradigm软件用户指南 ThermoScientific



4. 打开 File( 文件) 菜单并选择 Create Report( 创建报告) 。

5. 在 Create Report( 创建报告) 对话框中，输入报告的标题、选择格式并编辑任何模板选项。只有 Print( 打

印) 和 Save( 保存) 格式可用于 Historical Spectrum( 历史光谱) 报告。

6. 单击 Create( 创建) 。

将标签和注释添加到光谱中

Annotation Tools( 注解工具) 可用于添加自定义标签或突出显示光谱特点。呈现或共享数据时，注释非常适合用

于在报告中添加额外信息。

您只能在桌面界面中创建注释。

❖ 将峰注释添加到光谱

1. 在光谱视图中，选择一个光谱。

2. 右击光谱窗格，选择 Display Tools( 显示工具) ，然后选择 Peak Area( 峰面积) 或 Peak Height( 峰高) 。
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3. 调整峰工具的设置，然后点击 Save( 保存) 。

4. 要移动注释，请点击并拖动文本。

无法使用右击菜单编辑或删除峰高和峰面积注释。要删除它们，请使用历史记录恢复到较早的处理步骤。

❖ 将自定义标签和注释添加到光谱

1. 在光谱视图中，选择一个光谱。

2. 右击光谱窗格，选择 Annotation Tools( 注释工具) ，然后选择一个注释选项。
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3. 要移动注释，请点击并拖动文本，或者对于 Ellipse( 椭圆) 或 Rectangle( 矩形) ，点击并拖动图形的顶部。

右击注释可显示附加自定义选项。
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4.3 时间系列分析

本节描述 OMNIC Paradigm软件中的时间系列分析，包括以下主题：

了解时间系列分析 147

关于时间系列分析 147

创建时间系列分析 149

处理时间系列数据 151

应用方案 151

创建时间系列报告 153

管理时间系列分析 154

了解时间系列分析

本主题概述了与时间系列分析相关的重要概念。如果可用，请按照链接查找有关特定功能和最佳做法的更多详细

信息。

关于时间系列分析

时间系列分析有助于探索样品测量值如何随时间变化。例如，您可以使用时间序列分析来探索样品在 TGA-IR 或

GC-IR 实验过程中如何演变，或者您可以打开标准测量集合来查看您的测量值在给定的一周或一个月内是否保持一

致，提醒您注意测量值变化的时间。

您还可以通过工作流期间获得的一组重复测量值创建时间系列分析。例如，您可以使用 Repeat( 重复次数) 磁贴

和 Delay( 延迟) 磁贴在给定的时间内重复测量相同的样品，例如每 60 秒测量一次，持续测量一个小时。之后，

您可以在时间系列分析中打开测量，探索样品在工作流期间的变化。

时间系列分析仍在开发中，未来版本将提供更多功能。目前，您可以将标准测量和通过工作流测量转换为时间系

列分析，但仍无法直接将采集数据作为基于时间的测量。

提示使用标签组织您的测量，并使其更容易转换为时间系列分析。工作流可以使用 Tag( 标签) 磁贴自动标记

所有测量，单个测量可以在数据采集过程中使用控制面板上的 Tag( 标签) 设置应用标签。

关键概念和术语

l Time Series(时间系列)：时间系列分析包括在一个时间段内绘制的一组 4 个或更多测量。

l 有关如何将测量转换为时间系列分析的说明，请参阅"创建时间系列分析"。

l Profile(方案)：方案是一种系列数据的表示形式，用于显示数据如何随时间变化。每个方案显示了测量数据的
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不同方面，例如峰高或峰面积如何变化。

l 有关每个方案的说明，请参阅"方案类型"。

l 有关如何应用、保存和编辑方案的说明，请参阅"创建和使用方案"。

l History(历史记录)：在时间系列分析中，历史记录包括所有处理和显示转换操作。您可以使用历史记录查看对

数据应用了哪些处理操作，并移除特定操作。

l 有关应用和移除处理操作的说明，请参阅"处理时间系列数据"。

时间系列窗口概述

在时间系列中打开测量时，分析窗口会打开并显示您的数据。

A 方案名称 所显示方案的名称。

B 方案视图 方案视图显示当前所有保存方案的方案曲线。右击更改 x轴单位。

C 十字线 十字线显示方案中当前所选位置。光谱对应所选位置，X值和 Y值显示于屏幕左下

角。

D 时间线 使用时间线可滚动显示测量。光谱窗格显示时间线中当前点的光谱。

选择时间线后，可使用左右箭头键导航至较早和较晚时间的光谱。

E 光谱窗格 光谱窗格显示上述时间线中所选当前时间的光谱。
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F 测量、方案和历

史记录选项卡

Measure( 测量) 、Profile( 方案) 和 History ( 历史记录) 选项卡

l Measure( 测量) 选项卡：显示有关时间系列分析的信息。

l Profile( 方案) 选项卡：使用 Profile( 方案) 选项卡创建、编辑和应用方案。

l History ( 历史记录) 选项卡：History ( 历史记录) 选项卡显示已应用于数据的所

有处理操作和显示转换操作。

G 方案类型选项卡 使用 profile type( 方案类型) 选项卡可在收藏夹方案和时间系列方案之间进行切换。

l Time Series( 时间系列) 方案：这些方案是该时间系列分析所特有的。除非单独

重新创建，否则无法将这些方案与其他分析一起重复使用。

l Favorites( 收藏夹) ：这些方案可与所有时间系列分析共享，并且可以在每次创

建时间系列分析时重复使用。

H 方案设置 设置区域显示所选方案的当前设置。可使用该区域编辑方案。

I 方案操作 编辑或创建方案时，可以预览或保存方案。保存方案后，可以将其添加到收藏夹方案

或单独的时间系列方案中。

l Preview(预览)：更新方案预览，以便使用当前设置显示方案曲线。

l Save(保存)：使用当前设置保存方案。

创建时间系列分析

选择一组测量并在时间系列中打开，创建时间系列分析。

您可以使用标签轻松地筛选测量。如果所需的测量均共享同一个标签，则可以搜索该标签，然后选择所有测量以

创建时间系列分析。工作流中的 Tag( 标签) 磁贴可以自动标记工作流收集的每次测量。

筛选测量列表后，选择一个测量，然后按 CTRL + A选择所有测量。

提示使用“标签”关键字将搜索词限制为仅标签。
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图 4-1:使用标签筛选测量

❖ 创建时间系列分析：

1. 选择一组测量以在时间系列中查看。

选择一个测量后，按住 SHIFT选择一组测量，或按 CTRL + A选择所有测量。

2. 右击测量并选择 Open in Time Series( 在时间系列中打开) 。

打开时间系列分析。
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处理时间系列数据

与标准测量一样，您可以处理时间系列数据以校正基线或考虑 ATR 测量、执行谱图数学运算、平滑数据等。在时

间系列分析中应用处理操作时，需将该操作立即应用于所有光谱。例如，执行自动基线校正将校正分析中每个光

谱的基线。

从 Display( 显示) 菜单中选择一个选项，以将所有光谱转换为该显示格式。例如，如果您的分析包含使用 % 透过

率单位和吸光度单位的不同测量，则选择 Display > Absorbance( 显示 >吸光度) 可确保测量均使用吸光度单位。

您可以在 History( 历史记录) 选项卡中查看或移除过去的处理操作。

将所有光谱转换为相同的 y轴单位

要将所有光谱转换为相同的 y轴单位，从 Display( 显示) 菜单中选择一个选项。在应用任何方案之前，应始终确

保光谱均使用相同的显示单位。如果光谱使用不同的单位，则方案可能会显示不准确或误导性值。

移除处理操作

要移除处理操作，请进入 History( 历史记录) 选项卡并右击该操作。您可以移除单个操作或所有操作。

应用方案

方案是一种随时间绘制测量数据的表示形式。使用方案探索您的样品如何随时间变化，并探索变化如何与外部因

素相关联，例如 TGA-IR 实验中的温度。

方案类型

方案类型 说明

Reconstruct
(重建 )

这是您根据之前的测量创建时间系列分析时的默认显示。“重建”可简单绘制光谱计数随时间的变

化。
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方案类型 说明

Correlation
(相关性 )

“相关性”方案可将每个光谱与参比谱图进行比较，并显示匹配值，如 QCheck分析。方案曲线的

Y轴可显示相关性值，1 表示完美匹配。

选择 Set Correlation Reference( 设置相关性参比) ，将参比设置为当前显示的光谱。

Area
(峰面积)

“峰面积”方案的 Y轴可显示峰面积是如何增大或缩小的。

Peak(峰 ) “峰”方案可显示峰高的变化。

Area Ratio
(面积比)

“面积比”方案可显示一个峰与另一个峰的比值变化。使用此方案，您可以指定两个峰的面积。所

得比值使用第一个峰面积作为分子，第二个峰面积作为分母。

该方案中的“Intensity threshold( 强度阈值) ”是指计算中使用的最小峰面积。如果任一峰面积小

于或等于该最小值，则结果将为 0，而不是计算的比值。这有助于在任一峰面积接近 0 时有效

防止结果出现极大值。

Peak Ratio
(峰比 )

通过“峰比”方案可计算两个峰高的比值。

在“峰比”方案中，“Intensity threshold( 强度阈值) ”是指最小峰高。如果任一峰高小于或等于该

最小峰高，则方案将得到 0，而不是计算比值。这有助于在任一峰高接近 0 时有效防止结果出

现极大值或极小值。

Chemigram
(化学图谱 )

化学图谱方案可显示指定区域的未校正面积。

Peak
position
(峰位 )

峰位方案可显示系列中指定峰偏移的情况，Y轴可显示波数中的峰位置。

该方案中的“Intensity threshold( 强度阈值) ”是指峰高最小值。如果峰值小于或等于该高度，则

返回值为 NaN，表示“不是数字”，在方案曲线中产生小间隙。方案曲线会跳过这些点并连接两

侧的点。如果间隙较大，方案曲线中将出现可见的空白。

Peak
Width
(峰宽)

峰宽方案可测量特定峰的宽度变化。该方案的 Y轴值显示波数中峰的宽度。

高度 % 值确定测量峰的位置。例如，如果高度 % 设定为 75%，则在 75% 峰高( 从基线开始测

量) 处测量峰宽。

该方案中的“Intensity threshold( 强度阈值) ”是指峰高最小值。如果峰值小于或等于阈值，则不

计算宽度，而是方案返回 NaN，表示“不是数字”，且方案曲线会跳过这些值，连接两侧的点。

如果间隙较大，方案曲线中将出现可见的空白区域。

Quant
(定量 )

“定量”方案使用 TQ Analyst定量方法计算方案曲线。Y轴值取决于您正在使用的 QNT文件。

要使用“定量”方案，请进入 Identify > Quant Setup( 鉴别 >定量设置) 然后选择一个 QNT文件。

然后，创建“定量”方案。
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创建和使用方案

有两种类别的方案

l Time Series( 时间系列) 方案：这些方案是该时间系列分析所特有的。除非单独重新创建，否则无法将这些

方案与其他分析一起重复使用。

l Favorites(收藏夹)：这些方案可与所有时间系列分析共享，并且可以在每次创建时间系列分析时重复使用。

❖ 若要创建并应用方案

1. 选择 Time Series( 时间系列) 或 Favorites( 收藏夹) 选项卡。

2. 点击 New( 新建) 。

3. 输入方案名称。该名称可随时更改。

提示最好使用描述性名称，特别是对于定量方案，这有助于您后续理解方案曲线。

4. 选择方案类型。有关每个方案的说明，请参阅"方案类型"。

5. 使用控件编辑相应设置。

6. 单击 Preview( 预览) ，查看方案曲线。

7. 完成以后，点击 Save( 保存) 。

将方案添加到 Time Series( 时间系列) 或 Favorites( 收藏夹) 选项卡中的列表中，并将方案曲线添加到方案视图

中。

选择 Delete( 删除) 以移除或删除方案。

选择 Edit( 编辑) 以变更方案名称、类型或设置。

创建时间系列报告

打印或保存报告，以记录您的分析结果。时间系列分析报告显示以下信息，且每个项目均为可选项。

l Title( 标题) ：报告的标题。

l Profiles( 方案) ：方案部分显示当前应用的所有方案的图像。Report( 报告) 仅显示"Time Series( 时间系

列) "方案或"Favorites( 收藏夹) "方案，具体取决于创建报告时使用的选项卡。

l Spectrum( 光谱) ：光谱部分显示进入 Create Reports( 创建报告) 窗口时显示的光谱。

l Time series information( 时间系列信息) ：本部分显示有关分析的详细信息，例如进行分析的用户名称、分析

日期和时间以及包括的光谱数量。

l Signature box( 签名框) ：包括签名框，可添加签名、日期和附加说明的空间。
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❖ 为时间系列分析创建报告：

1. 从 Time Series analysis( 时间系列分析) 选项卡，进入 File > Create Report( 文件 > 创建报告) 。

2. 输入报告标题并选择报告格式。同时保存打印的报告。

3. 选择 Options( 选项) ，自定义报告中包含的信息。

4. 选择 Create( 创建) 。

在控制面板上查找保存的报告和其他报告。

要查看保存的时间系列报告，请在控制面板上查看Reports( 报告) 。

管理时间系列分析

要查看和管理以前的时间系列分析，请在控制面板上选择时间系列。

您可在此处查看之前的分析或打开、重命名或删除分析。选择More option( 更多) 选项查看其他详情，包括一般

信息、处理历史记录和数字签名详情( 如有) 。
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4.4 显微镜

本节描述 OMNIC Paradigm软件中用于 FTIR 显微镜的功能，包括以下主题：

查看样品 156

准备测量设置 160

捕获拼接图 165

分析样品 168

报告您的显微镜分析结果 176

查看样品

移动载物台并对焦样品

对焦样品的最简单方法是从 Mosaic capture( 拼接图捕获) 列表中选择大致的目标位置，然后选择 Autofocus
before capture( 捕获前自动对焦) 选项。选择这些选项后，当您开始工作阶段时，载物台将自动移到正确位置，

对焦样品，并捕获拼接图。

如果要移动到另一个位置并对焦新区域，您可以使用软件或选配的操纵杆移动载物台并使对焦样品。

使用 OMNIC Paradigm软件或选配的操纵杆移动载物台。切勿尝试用手移动载物台。

使用软件

在 Session( 工作阶段) 视图中，打开 Camera View( 摄像机视图) 查看样品。

l 要水平移动载物台，打开 Camera View( 摄像机视图) 并打开 Stage( 载物台) 工具。

单击样品图像两侧以及上方和下方的箭头以移动载物台。更改移动速度可更改每次单击时载物台移动的距离。
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在实时视频图像内双击，可将载物台居中在该位置。

l 要向上和向下移动载物台，打开 Camera View( 摄像机视图) 并打开对焦设置。单击左箭头和右箭头可上下移

动载物台。
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自动对焦

要自动对焦样品，请单击 Autofocus( 自动对焦) 。软件会上下移动载物台以找到最佳焦点。自动对焦最适合视觉

对比度高的区域。自动对焦可能难以处理一些低对比度的样品和具有多个焦平面的样品。

自动对焦提示
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l 调整照明以获得最佳观看效果。如果照明太高或太低，自动对焦可能没有足够的对比度来找到正确的焦点。

l 如果您将 40 倍物镜与手动对焦环一起使用，请确保将对焦环设为 0 位置。错误定位的对焦环可能会干扰自动

对焦。

使用操纵杆

您可以使用操纵杆水平或垂直移动载物台，并且可通过移动速度控制，快速或小心地移动。使用 Camera View
( 摄像机视图) 或选配的目镜可判断您的位置。

l 要水平移动载物台，向前、向后、向左和向右推动或拉动操纵杆。

l 要向上或向下移动载物台，顺时针旋转操纵杆可向上移动载物台，逆时针旋转可向下移动载物台。

使用速度选择器更改运动速度。

照亮样品

您可以使用软件或选配的操纵杆来控制到达样品的光量。使用反射照明控件设置来自样品上方的光线，使用透射

照明控件设置来自样品下方的光线。

使用软件

要在软件中控制照明，请打开 Camera View( 摄像机视图) 。选择 Transmission( 透射) 或 Reflection( 反射) 并

将滑块拖动到所需的灯光设置。您也可以输入精确值。

自动照明

单击 Autoilluminate( 自动照明) 可以使软件自动优化样品照明。
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使用选配的操纵杆

选配的操纵杆具有两个控制旋钮，用于设置透射和反射照明。使用 Camera View( 摄像机视图) 或选配的目镜可

查看样品照明。旋转旋钮可控制灯光。

调整孔径

可调孔径定义了红外光束与样品相互作用的区域。这可确保 IR 能量仅照射目标区域而不照射相邻样品材料，并确

保通过目标区域边缘的少量衍射辐射不会到达检测器。

在颗粒分析过程中，软件会为所有颗粒找到一组理想的孔径，然后在样品测量期间使用这些孔径。

在控制面板的高级设置区或摄像机视图中手动设置孔径。

❖ 调整孔径的大小、形状和旋转

1. 打开摄像机视图并选择孔径设置。

2. 使用滑块或输入精确值来调整孔径的高度、宽度和旋转。

注释要显示孔径，请调整照明，直到可以看到明亮的蓝色矩形光穿过孔径。

准备测量设置

OMNIC Paradigm软件提供了基本和高级设置，方便您使用 FTIR 显微镜来查看和测量样品。

基本设置经常使用并确定您正在执行的分析类型。高级设置需要较少调整，并且与仪器硬件的配置方式以及如何

处理数据来生成样品光谱的方式有关。
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基本设置

将样品位置设为 FTIR 显微镜后，在 New Measurement( 新建测量) 窗格中查找基本设置。

图 4-1:显微镜的基本测量设置

设置 说明

Autofocus before
capture( 捕获前自

动对焦)

选择此设置可在开始工作阶段时使样品自动对焦。

如果不选择此选项，则应该在开始工作阶段之前使用可选的操纵杆和目镜来手动使样

品对焦，或者将拼接图捕获设置更改为 Custom Mosaic( 自定义拼接图) 。开始工作

阶段后，打开 Camera View ( 摄像机视图) 并在捕获拼接图之前手动将样品对焦。

Session name( 会话

名称)
工作阶段数据的名称。此名称用于保存的数据，如果您安装了 Security Suite 软件，则

用于审核跟踪。默认名称为工作阶段开始的日期和时间。

Final format( 最终

格式)
决定用于所收集数据的单位。采集后，您可以使用 Display( 显示) 菜单中的选项转

换为另一个 Y轴单位。

Sample scans( 样品

扫描)
在每个采样点采集的扫描次数。较少扫描会导致更快的数据采集，但可能会产生噪音

更多的数据。

Mosaic capture
( Mosaic捕获)

指定要在您开始工作阶段时自动捕获的拼接图类型。

要开始工作阶段而不捕获拼接图，请选择 <No Mosaic>( 无拼接图) 。

非常大的拼接图需要大量的硬盘空间来存储并且采集时相当耗时。为了节省磁盘空间

和测量时间，请仅捕获分析所需的样品部分的拼接图。

表 4-1:显微镜的基本测量设置
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设置 说明

Camera profile( 摄

像机方案)

选择最适合您正在分析的样品类型的摄像机方案。摄像机方案可设置亮度、对比度、

白平衡等，以提供样品的最佳图像。

许多样品是在高反射背景上制备的，但它们本身并不高反射。确保选择最适合样品表

面和目标区域的选项。

l High Reflective( 高反射) ：高反射样品在暴露于光源( 如附近的灯光或阳光)
时通常会出现可见的反射。例如，这些样品包括载玻片、光面纸和抛光良好的金

属。

l Matte( 无光泽) ：使用表面粗糙且可见反射率低的深色材料时选择此选项，例如

非常深色的塑料、橡胶、纸板或纸张，或者织物。

l Diffuse( 漫反射) ：使用具有中等或低反射率且浅色的材料时选择此选项。“漫反

射”适用于浅色塑料、无光泽纸、药片或类似材料等样品。

寻找正确的摄像机方案

要检查摄像机方案设置是否适合样品材料，请将样品图像对焦并自动或使用手动控件

调整照明。

照明数应在 15 到 70 之间。

l 如果小于 15，将摄像机设置调整为高反射方案。

l 如果数字大于 70，则将摄像机方案调整为漫反射或无光泽。

Tag( 标签) 将标签添加到工作阶段。标签对于以后查找和过滤已保存的工作阶段很有用。

Resolution( 分辨

率)

就像照片或视频的分辨率一样，更好的分辨率意味着光谱数据中的细节更精细。例

如，更好的分辨率可以区分两个非常接近的峰，而较差的分辨率可能会将它们组合在

一起。

值越小，分辨率越好，但测量时间也更长。

Profile( 方案)
用于在测量区域、线或点集后显示化学数据的默认方案。您可以在测量数据后更改方

案。有关每个方案的更多信息，请参阅“应用方案”。

Analyze using( 使用

以下工具分析：)

用于测量样品的技术。选择的技术将决定工作阶段期间可用的设置。

l 反射

l 透射

l 衰减全反射

Analyze particles
( 分析颗粒)

选择此项可分析颗粒。如果选择此选项，将可在 Session( 工作阶段) 视图中使用颗

粒分析工具。开始工作阶段之前，必须选择此选项。

Enable Polarizer
acquisition( 启用偏振

器采集 )
选择此选项可在数据采集期间使用偏振器和分析仪。您也可以在工作阶段期间启用偏振器。
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设置 说明

Step size( 步长 )
载物台在采样点之间移动的距离，以微米为单位。步长越小，区域中测量样品的点就

越多，但需要更长的时间来测量并且需要更多的空间来保存。

Aperture height and
width( 光阑高度和宽

度 )

光阑用于避免测量样品中不需要的部分，并防止不需要的光到达检测器。

将光阑想象成一个矩形窗口，红外光束会在测量期间穿过该窗口。

您还可以在摄像机视图中设置光阑高度、宽度和旋转角度。

背景和高级设置

背景和高级设置区域提供了额外的选项，适用于您采集和处理数据的方式。

设置 说明

Use the fixed
reference location
on the
RaptIR sample
holder( 使用

RaptIR 样品架上的

固定参比位置 )

RaptIR样品架具有用于透射和反射分析的内置参比点。选择此选项可在捕获初始拼接图后自动

将载物台移动到参比位置。如果您在拼接图捕获列表中选择了自定义拼接图，此选项将不可

用。

Match sample
scans( 匹配样品

扫描)
如果选择此项，用于背景测量的扫描次数将与用于样品的扫描次数相同。

表 4-2:显微镜的背景设置
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设置 说明

Set background
scans( 设置背景

扫描)
选择此项可选择用于背景的不同扫描次数。

Measure
background before
each region( 在每

个区域之前测量背

景 )

如果选择此项，软件将在样品的每个新区域之前测量新背景。例如，如果您的样品测量有三个

区域，选择此选项后，软件将会在每个区域之前采集一个新背景。请注意，使用相同测量设置

的点集将视为单个区域。

Measure
background once for
entire sample( 对整

个样品测量一次背

景 )

选择此选项后，将仅在测量设置更改时采集新背景。例如，若您选择了此选项，如果您在一次

样品采集中测量三个区域并且它们都使用相同的测量设置，则将仅采集一个背景。

以下是高级设置：

设置 说明

Zero fill( 零填充)

所收集数据点之间的插值数据点。这不会增加数据的实际分辨率，但可以平

滑锐利的特征并改善光谱的线形。

使用相同的零填充设置采集样品和背景谱图。

选项

l None( 无) ：不执行零填充。

l 1：在每个收集的数据点之间添加一个数据点

l 2：在每个收集的数据点之间添加三个数据点

Optical velocity (cm/sec)( 动

镜速率 [cm/sec])
确定干涉仪中的动镜速率。默认值取决于您使用的检测器类型，并且只能更

改某些光谱仪上的默认值。

Gain( 增益)
设置检测器信号的放大倍率。较高的增益会增加信号，但也会增加噪音。最

佳增益取决于实验。

Apodization( 切趾)

切趾是指应用于单光束数据的数学函数，以减少或移除由于干涉图不是无限

数据集而可能出现的峰旁波束。

强切趾可减少更多噪声，但也会降低数据的分辨率并增宽峰。

有关每个选项的说明，请参阅"切趾函数"。

Beamsplitter( 分束器)
如果您的仪器安装了多个分束器，可以在此处选择其中一个。如果您的光谱

仪上安装了 ABX，请先配置 ABX，然后在此处选择要使用的分束器。

表 4-3:显微镜的高级测量设置
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设置 说明

Sample spacing( 采样间

隔)

采样间隔是指对干涉图进行采样的频率。

较低的采样间隔设置允许您测量更广泛的频率范围，而较高的采样间隔设置

在以非常快的动镜速度进行测量，镜子移动太快而导致 IR 测量跟不上时非常

有用。

l 0.5：在每个零交叉处以及激光信号波的顶部和底部测量 IR 信号。此设置

允许更广泛的数据范围。

l 1：在激光波长的每个零交叉处测量 IR 信号。用于扩展超过 7899 个波数

的范围。

l 2：在每隔一个零交叉处测量 IR 信号。这在使用非常快的动镜速度时很有

用，但最大测量范围必须低于 7900。

Mapping speed( 测绘速度)
高速适用于大多数应用，但如果您需要提高数据质量，可能需要尝试“标准”速
度。

Detector( 检测器 ) 显示当前安装的显微镜检测器。

Range limits( 范围限制) 设置所采集光谱中包含的频率范围的限制( 以波数表示) 。

Prompt for session name( 提

示输入会话名称)
如果选择此项，软件将会在每个新工作阶段开始时提示输入新工作阶段名

称。

Atmospheric suppression
( 大气抑制)

抑制水蒸气和二氧化碳对您所采集光谱的影响。

一般而言，最好使用当前的背景谱图来控制大气条件。如果经常测量背景或

大气条件变化缓慢，则无需使用此功能。

只有不经常测量背景或大气条件迅速变化时才使用此功能。

捕获拼接图

拼接图是样品表面的视觉图像。摄像机将捕获一系列高分辨率的小图像并将它们拼接成一个拼接图，为您提供可

用于分析的样品表面大图像。拼接图可作为分析工作区，用于探索目标区域并指定要进行 IR 数据收集的区域和

点。

通常，当您分析样品时，您将使用 4 倍或 10 倍物镜采集低放大倍率拼接图像，根据需要调整设置，然后如果需

要，可使用 15 倍或 30 倍物镜捕获更小区域的高放大倍率拼接图像。捕获拼接图后，绘制区域或选择颗粒，然后

开始测量数据。

您可以在开始工作阶段时自动捕获拼接图，也可以从 Session( 工作阶段) 视图手动捕获。

拼接图类型

有两种类型的拼接图：
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l 低放大倍率( 4 倍或 10 倍) 。通过捕获低放大倍率拼接图开始您的分析。这提供了样品表面的更大概览。

l 高放大倍率( 15 倍或 30 倍) 。如果需要，可捕获较小目标区域的高放大倍率拼接图。高放大倍率拼接图可提

供更好的图像，但需要较长的采集时间。

自动和手动捕获

您可以在开始工作阶段时自动捕获拼接图，也可以先优化测量设置，然后手动捕获拼接图。

低放大倍率拼接图

❖ 自动捕获拼接图

1. 在控制面板中，从 Mosaic Capture( 拼接图捕获) 列表中选择一个选项。如果您选择“Custom Mosaic”( 自定义

拼接图) 以外的任何选项，软件将会在您开始工作阶段时自动捕获拼接图。

2. 通常，您应该在开始工作阶段之前选择 Autofocus before capture( 捕获前自动对焦) 。选择此选项后，软件将

会自动对焦样品，并优化照明以获得最佳拼接图。

3. 选择 Start Session( 开始工作阶段) 。工作阶段将开始，软件自动捕获拼接图。

❖ 手动捕获拼接图

1. 如果尚未开始工作阶段，请在控制面板上，从 Mosaic Capture( 拼接图捕获) 列表中选择 Custom Mosaic( 自

定义拼接图) 。然后，单击 Start Session( 开始工作阶段) 。

2. 在 Session( 工作阶段) 视图中，使用 Camera View( 摄像机视图) 并将载物台移动到所需位置。

3. 确保选择了较低放大倍率的物镜。

4. 单击 Capture Mosaic( 捕获拼接图) 。

5. 要添加到您的低放大倍率拼接图，请确保“Capture Mosaic( 捕获拼接图) ”工具显示低放大倍率物镜。

a. 选择 Mosaic( 拼接图) 工具并绘制要捕获的区域。

b. 单击 Capture Mosaic( 捕获拼接图) 。

高放大倍率拼接图

您必须先捕获低放大倍率拼接图，然后才能捕获高放大倍率拼接图。

❖ 捕获高放大倍率拼接图

1. 在 Session( 工作阶段) 视图中，从浮动工具栏中选择 Mosaic( 拼接图) 工具。

2. 单击并拖动，在低放大倍率拼接图上绘制一个矩形。这是将捕获高放大倍率拼接图的区域。

3. 如果尚未选择高放大倍率选项( 通常为 15 倍) ，请单击 Change Objective( 更改物镜) 。

4. 选择 Capture Mosaic( 捕获拼接图) 。

高放大倍率拼接图绘制在前一个拼接图的顶部，并且缩略图图像会添加到结果面板的拼接图选项卡中。
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快照

快照是从摄像机视图中查看的样品表面的单个图像。

❖ 捕获快照

1. 在 Session( 工作阶段) 视图中，打开 Camera View( 摄像机视图) 。

2. 单击快照工具。快照将添加到拼接图选项卡中。

探索拼接图

使用导航工具可放大或缩小以及查看拼接图的不同区域。

拼接图俯视图

俯视图显示拼接图的高层图像。当您放大以查看拼接图时，俯视图将显示您正在查看的样品表面位置。

您还可以使用俯视图导航拼接图。单击俯视图上的一个区域可移动到该位置。单击并拖动对焦区域的边界可放大

或缩小。
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导航工具

l 放大或缩小

o 使用鼠标滚轮可放大和缩小拼接图。

o 稍微放大后，即可使用拼接图俯视图进行缩放。在俯视图上，单击并拖动对焦区域的边界可以使它变大或

变小。

l 要查看拼接图的不同区域，请选择平移工具。选择平移工具后，单击并拖动拼接图像。

分析样品

测量背景谱图

采集样品数据之前，必须测量背景谱图。背景是在没有任何样品的情况下，对仪器采样条件的测量。在测量背景

和样品后，将样品数据与背景测量值进行比值，以创建最终的样品光谱。

使用的最佳位置或材料会根据样品类型或应用而有所不同。下表提供了一些采集背景的建议。

样品类型和应用 背景建议

透射，悬浮在空气中的样品 空气

透射，盐板上的样品 没有样品材料的盐板区域

透射，压缩单元中的样品 样品旁边同一压缩单元中的 KBr( 或其他卤化物盐) 晶体

镜面反射 镜子或抛光金属

漫反射 粉碎的 KBr、碳化硅纸或其他粗糙、不吸收红外线的材料

反射吸收 镜子或抛光金属，或样品支架上没有样品材料的区域

衰减全反射 空气

❖ 测量背景谱图

1. 开始一个工作阶段并捕获低放大倍率拼接图。

2. 在悬浮工具栏中，选择 Background( 背景) 工具。

3. 在要测量背景的点单击拼接图。光谱窗格将显示一个实时单光束光谱。要移动背景点，请再次单击拼接图。

4. 对背景的单光束光谱感到满意后，单击 Accept Background( 接受背景) 。

5. 单击 Measure Background( 测量背景) 。将采集背景谱图。完成后，该谱图将会添加到 Spectra( 光谱) 选项
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卡的 Background( 背景) 选项卡中。

完成背景测量后，即可放置区域、线和点并测量样品。

如果您在一段长时间内测量多个区域，请定期更换背景测量。通常，在测量样品之前，您应该始终对背景进行最

近的测量。

Analyze particles( 分析颗粒 )

使用 Particle Analysis( 颗粒分析) 工具可定位、表征和鉴别微粒。

❖ 分析颗粒

1. 准备样品

2. 在控制面板上，选择 Analyze particles( 分析颗粒) 。

3. "捕获拼接图"

4. 在 Session( 工作阶段) 视图中，查看拼接图并对对焦和照明进行任何必要的更改。如果需要，捕获高放大率

拼接图。

5. "测量背景谱图".

6. Analyze particles( 分析颗粒) 。
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a. 选择 Particle Analysis( 颗粒分析) 工具，然后单击并拖动以在拼接图上绘制一个矩形。这是目标区域，软

件将在此处检测颗粒。绘制区域后，将打开 Particle Analysis( 颗粒分析) 窗格。

b. 使用选项和选择工具优化您的选择。更新设置后选择 Recalculate( 重新计算) 以更新颗粒。有关颗粒分

析工具和设置的详细说明，请参阅 OMNIC Paradigm指南和教程。

c. 对选择感到满意后，单击 Accept( 接受) 。这将保存选择设置，但尚未测量数据。

d. 单击 Sample( 样品) 。

分析区域、点和线

通过指定一个或多个要分析的区域来创建样品表面区域的化学图像。您还可以使用线工具和点工具测量线和个别

的点。您可以同时测量区域、线和点。

测量区域、线和点

测量区域、线和点需要首先捕获拼接图和测量背景。

❖ 分析区域、点和线

1. "捕获拼接图"

2. "测量背景谱图".

3. 指定要分析的区域、线和点。您可以将多个区域、线和点添加到单个分析中。

要分析 选择此工具 执行以下步骤
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区域

1. 选择区域工具。

2. 单击并拖动拼接图以绘制区域。

线

1.选择线工具。

2.单击并拖动以绘制线。

点

1.选择点工具。

2.单击以添加一个点。

使用光标工具选择或删除区域、点和线。

4. 完成添加区域、线和点后，单击 Sample( 样品) 。

完成测量后，可在新的选项卡中查看结果。

使用偏振器

带有偏振器选件的显微镜包括用于可见光和红外光的个别偏振器。

对于每个光源，显微镜都包括两个偏光滤光片，称为偏振器和分析仪。

l 偏振器：位于光源和样品之间

l 分析仪：位于样品与摄像机或目镜与检测器之间

使用偏振器时，可以单独插入偏振器，用于平面偏振光，也可以插入偏振器和分析仪，用于交叉偏振光。偏振器

和分析仪可以一起旋转，也可以个别旋转。

使用偏振器和分析仪

要使用偏振器，首先要在摄像机视图中查看样品。在这里，可以预览偏振器设置并调整可见光偏振器和分析仪。

在摄像机视图中预览样品可帮助您找到在样品测量期间使用的理想设置。

❖ 在摄像机视图中使用偏振器和分析仪

1. 在控制面板上，选择 Enable Polarizer acquisition( 启用偏振器采集) 。

选择此选项后，将使用偏振器来测量区域。如果未更改任何设置，将使用默认的偏振器和分析仪设置。您可以

在工作阶段期间改变主意，并在采集数据之前启用或禁用偏振器。

2. 使用透射或反射分析类型，像往常一样开始显微镜工作阶段。您不能在使用衰减全反射 (ATR)分析类型时使用
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偏振器。

3. 在 Microscopy Setup( 显微镜设置) 视图中，打开 Camera View( 摄像机视图) 并进入 Polarizer( 偏振器) 选

项卡。

图 4-1:Camera View( 摄像机视图) 中的 Polarizer( 偏振器) 选项卡

4. 选择 Visual( 视觉) 可使用可见光偏振器。选择 Spectral/IR( 光谱 /IR) 可使用 IR 偏振器。

l 在调整可见光偏振器设置时，在 Camera View( 摄像机视图) 中查看样品图像。

l 要预览 IR 偏振器设置，请打开 Live Spectra( 实时光谱) 视图并查看光谱。

设置 说明

Visual( 视觉) 选择此设置可启用可见光偏振器。

Spectral/IR( 光谱 /IR) 选择此设置可启用 IR 偏振器。

Link dials( 联结转盘)
如果选择此设置，能够以相同的速率旋转偏振器和分析仪。改变其中一个的角度也

会改变另一个的角度。

Polarizer angle( 偏振

器角度)
设置偏振器的角度。

Analyzer angle( 分析

仪角度)
设置分析仪的角度。

No analyzer( 无分析

仪)
如果选择此设置，将从光束路径中移除分析仪，并且仅使用偏振器。( “平面偏振

光”)

表 4-1:Camera View( 摄像机视图) 中的 Polarizer( 偏振器) 设置

使用偏振器采集红外数据

在启用偏振器的情况下测量样品时，可以通过两种方式进行测量：
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l 在单个固定角度测量偏振器( 和分析仪) 的整个区域。

l 在测量过程中自动旋转分析仪，并以指定的间隔采集数据，例如每旋转 5 度。

图 4-2:Polarizer Setup( 偏振器设置) 选项

❖ 使用偏振器和分析仪采集数据

1. 在 Microscopy Setup( 显微镜设置) 视图中，单击工具栏中的 Polarizer Setup( 偏振器设置) 查看偏振器设

置。

2. 选择 Enable Polarizer acquisition( 启用偏振器采集) 。

3. 编辑并查看您的偏振器设置。

l 要使用单个固定角度，请将 # of steps( 步数) 设为 1。仅使用分析仪的起始位置。

l 对于阶梯式采集，…​

a. 设置偏振器的角度。

b. 设置分析仪的起始和结束角度。

c. 设置 # of steps( 步数) 或 Degrees/step( 度 /步) 。

5. 定义一个或多个区域并像往常一样测量样品。

在每个分析仪角度自动测量背景点，以与样品相对应。采集样品过程中，在每个角度测量每个点。

表 2：偏振器采集设置

设置 说明

Enable Polarizer acquisition( 启用偏振器采

集)
选择此设置可在数据采集中使用偏振器( 以及选择使用分析

仪) 。

Starting position( 起始位置)

Polarizer( 偏振器) 偏振器的固定角度
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设置 说明

Analyzer( 分析仪)
分析仪的起始角度。如果将步数设为 0，这是唯一使用的角

度。

No Analyzer( 无分析仪)
选择此设置可从光束路径中移除分析仪，并且仅使用偏振

器。

Ending position( 结束位置)

Analyzer( 分析仪) 分析仪结束角度。

Degrees/step( 度 /步) 输入度 /步或步数。另一个值将自动计算。

# of steps( 步数) 输入度 /步或步数。另一个值将自动计算。

探索偏振数据

使用偏振器采集数据后，结果将显示在 Analysis( 分析) 选项卡中。查看使用偏振器采集的数据时，可以使用角度

滑块查看在采集中所使用每个角度的轮廓图像。

应用方案

方案设置定义了应用于测量中每个光谱的数学算法，包括所选区域或点，以创建化学图像。该算法将每个光谱转

换为一个数字，该数字由化学图像中的颜色表示。

应用方案

您可以在开始工作阶段之前选择默认方案，并且可以在测量数据后快速更改方案。

l 开始工作阶段之前，从控制面板上的 Profiles( 方案) 列表中选择一个方案。这是在测量区域、线或点后首先

显示的方案。

l 测量区域、线或点后，选择 Profiles( 方案) 选项卡，然后从 Profile type( 方案类型) 列表中选择一个选项。

单击 Update( 更新) 应用更改。

以下是可用方案类型的描述。

方案 说明

Correlation(相关性 )
相关性方案显示化学图像中每个采样点与所选相关光谱之间的相关性。

方案强度刻度中的每种颜色代表与相关光谱的相关程度。
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方案 说明

Area(峰面积 )
“峰面积”方案显示化学图像中每个采样点指定峰的校正面积。化学图像中的颜色代

表每个采样点指定峰的相对面积。较高的强度值( 更靠近方案强度刻度的顶部)
表示较大的峰面积。

Peak(峰 )
“峰”方案显示化学图像中每个采样点指定峰的校正高度。化学图像中的颜色代表每

个采样点指定峰的相对强度。较高的强度值( 更靠近方案强度刻度的顶部) 表示

较大的峰。

Area Ratio(面积比 )

“峰面积比”方案显示化学图像中每个采样点两个指定峰的校正面积比。使用两个峰

的比率可以查看：

l 样品材料的变化( 一些峰会增加，而另一些可能会减少)

l 两个样品组分的变化

l 峰面积变化针对另一个峰进行标准化，以确保物理变化( 例如对焦) 不会导致

所测量峰面积的变化

l 有关分层样品( 例如石墨烯) 中存在的层数和材料质量的信息

化学图像中的颜色代表指定峰的相对比例面积。较高的强度值( 更靠近方案强度

刻度的顶部) 表示较大的峰面积比。

Peak Ratio(峰比 )
“峰高比”方案显示化学图像中每个采样点两个指定峰的校正高度比。化学图像中的

颜色代表指定峰的相对比例高度。较高的强度值( 更靠近方案强度刻度的顶部)
表示较大的峰高比。

Chemigram(化学图谱 )
“化学图谱”方案显示化学图像中每个采样点指定区域的未校正面积。化学图像中的

颜色代表每个采样点指定区域下的相对面积。较高的强度值( 更靠近方案强度刻

度的顶部) 表示较大的峰面积。

Peak position(峰位 )
“峰位”方案显示指定峰的位置沿 X轴的偏移。测量基于化学图像中每个采样点指定

区域中的最大峰值。方案强度刻度中的颜色及其相关的 X轴值表示指定区域中最

大峰值的相对位置。

Peak Width(峰宽 )
“峰宽”方案显示化学图像中每个采样点指定峰的宽度。测量基于指定高度处的全峰

宽。化学图像中的颜色代表每个采样点指定峰的相对宽度。较高的强度值( 更靠

近方案强度刻度的顶部) 表示较宽的峰。

Quant(定量 )

使用通过 TQ Analyst软件创建的自定义分析方法。

要设置方法，请进入 Identify > Quantify Setup( 鉴别 >量化设置) 然后选择一个

QNT文件。

有关开发和校准方法的更多信息，请参阅 TQ Analyst软件中的帮助内容。

MCR
MCR 方案根据( 计算的) 纯组分光谱在样品数据中查找组分，并显示它们在化学

图像中的位置。
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收藏夹和工作阶段方案

您可以将方案设置保存到您的收藏夹或您的工作阶段方案中。

l 收藏夹将保存以供您未来的所有工作阶段使用。例如，如果您经常使用的峰位方案使用相同的峰位，您可以将

具有该峰位的方案保存到您的收藏夹，这样即可在每次使用该方案时无需指定位置。

l 工作阶段方案仅与工作阶段数据一起保存。当您日后打开工作阶段时，您的方案设置将仍然存在，但在其他工

作阶段期间将不可用。当您想要保存特定工作阶段的方案设置，而不想定期使用这些设置时，此功能将很有

用。

❖ 保存您的方案设置

1. 在 Profiles( 方案) 选项卡中，选择方案类型并设置您的首选选项。

2. 输入名称，然后单击 Save( 保存) 。

3. 要将收藏夹方案移到您的工作阶段方案，请在 Favorites( 收藏夹) 选项卡上，选择方案并单击 Save to session
( 保存到会话) 。

在光谱视图中探索光谱

在工作阶段视图中查看测量结果时，您可能希望使用工作阶段视图中不提供的工具来更详细地探索特定光谱。幸

运的是，您可以轻松地将光谱保存到您的测量中，然后在光谱视图中将它打开。

❖ 在 Spectra( 光谱) 视图中查看工作阶段分析中的光谱

1. 在 Session Analysis( 工作阶段分析) 视图选项卡中，选择 Cursor( 光标) 工具并单击要分析的点。

2. 打开光谱窗格( 如果尚未打开) 查看所选点的光谱。

3. 右击光谱并选择 Add selected spectrum to dashboard measurements( 将所选光谱添加到控制面板测量) 。注意

光谱的 X和 Y位置，如光谱窗格中所示。

4. 单击控制面板图标返回控制面板。

5. 在 Measurements( 测量) 下，查找您的光谱。光谱使用 X和 Y位置命名。

6. 右击光谱并在 Spectra( 光谱) 视图中将它打开。

报告您的显微镜分析结果

创建和自定义显微镜报告

分析样品后，您可以打印或保存报告以记录您的发现。
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❖ 创建显微镜报告

1. 从 Session Analysis( 工作阶段分析) 选项卡，进入 File > Create Report( 文件 > 创建报告) 。

2. 输入报告的标题，选择格式和模板。可用模板取决于您执行的分析类型。

3. 要自定义报告，请选择 Options( 选项) 并选择要包含或排除的元素。

4. 单击 Create( 创建) 。
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4.5 使用工作流

使用工作流可自动化您的任务，确保每次都以完全相同的方式执行分析和处理。

本节包含以下内容：

关于工作流 178

密码保护工作流 182

创建模板工作流 184

工作流磁贴参比 189

关于工作流

您可以使用 OMNIC Paradigm软件中的工作流功能来自动化重要的程序和频繁的任务。工作流是一系列可以通过点

击按钮启动的软件操作。软件操作以磁贴表示，可以将其拖放到 OMNIC Paradigm软件的工作流画布上。您可以指

定收集数据的设置，为操作员提供说明，并提前定义数据处理、报告和存档。创建工作流后，操作员即可每次重

复使用它来以相同的方式完成相关步骤。

本文概述了这些基本工作流功能和工具：

l Workflow( 工作流) 窗格

l Run Workflow( 运行工作流) 窗口

l 工作流编辑器

工作流窗格

工作流窗格始终位于 OMNIC Paradigm控制面板的底部。此空间可用于预览和运行您创建的工作流，以及打开工作

流编辑器来编辑或创建新的工作流。
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图 4-1:OMNIC Paradigm Dashboard( OMNIC Paradigm控制面板) 上的 Workflow Pane( 工作流窗格)

1. 最近的工作流( 点击一次可预览工作流；点击两次可将其打开)

2. 右击某个工作流可显示更多选项

3. 预览选定的工作流

4. 放大或缩小工作流窗格

执行下列操作 ... 采取此行动

Select and preview a workflow( 选择和预览工作流) 点击工作流名称一次

Test or run a workflow( 测试或运行工作流)
双击该工作流并选择 Run( 运行) 。此操作将打开运

行工作流窗口，您可以在该窗口中逐步执行工作流任

务。

Edit, rename, duplicate, delete or export the selected
workflow( 编辑、重命名、复制、删除或导出所选工

作流)
右击工作流并从快捷菜单中选择一个选项。

表 4-1:
从工作流窗格使用现有工作流
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运行工作流窗口

运行工作流窗口可用于测试或运行工作流。要打开运行工作流窗口，请右击某个工作流并选择 Run( 运行) 。

图 4-2:双击某个工作流并选择 Run( 运行)

1. 选定的工作流( 双击可打开此工作流)

从Run Workflow( 运行工作流) 窗口，使用箭号按钮可移动到工作流中的下一个任务。工作流将完全按照设计运

行，并按照工作流的指示显示任务和操作员消息。

图 4-3:运行工作流窗口

要停止工作流并返回控制面板，请在 Play Workflow( 播放工作流) 窗口中点击 Stop( 停止) 按钮。( 如果工作流

没有 Stop( 停止) 按钮，则点击工具栏上的 Dashboard( 控制面板) 按钮来停止工作流。)

工作流编辑器

工作流编辑器包含用于创建工作流的所有工具，包括工作流菜单、工具栏、磁贴选择栏和画布。要打开工作流编

辑器，请右击控制面板上的工作流名称，然后从快捷菜单中选择 Edit( 编辑) 。

您还可以通过选择下列选项，从 OMNIC Paradigm主窗口打开工作流编辑器：

File( 文件) ( 菜单) > Workflows( 工作流) > Create Workflow( 创建工作流)
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工作流画布是您选择和设置您希望工作流执行的任务并将任务连接在一起以创建工作流的地方。工作流编辑器将

打开，画布上显示强制性的“Workflow Start( 工作流起始) ”和“Workflow End( 工作流结束) ”磁贴。当前工作流中

每个磁贴的可用设置位于画布下方的可扩展部分。用于滚动、缩放和重置画布视图的工具位于右侧。画布上方有

一个便于使用的工具栏。

图 4-4:工作流编辑器

1. 工具栏

2. 磁贴选择栏

3. 画布

4. 磁贴设置

5. 用于调整和重置画布的工具

6. 起始磁贴

7. 结束磁贴

每个任务都由磁贴选择栏中的彩色磁贴表示。以下是一些常用的示例：
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用于创建、打开和导出工作流的工具位于 Workflow( 工作流) 子菜单中( 可从 OMNIC Paradigm File( 文件) 菜单

中获得) 。此处提供的示例工作流是一个很好的起点，您也可以从光谱的历史记录创建工作流。有关详细信息，

请参阅“Create and Run Your First Workflow( 创建和运行您的第一个工作流) ”。

可以添加、移动、复制和删除磁贴以创建所需的工作流。有关更多信息，请参阅标题为“Edit a Workflow( 编辑工作

流) ”的文章。

密码保护工作流

使用密码锁定工作流，使其他人无法编辑。锁定的工作流无法编辑、删除或复制，也不会显示预览。锁定工作流

后，仍然可以重命名或导出该工作流。

锁定和解锁工作流

您只能从 OMNIC Paradigm软件的桌面界面锁定和解锁工作流。

❖ 锁定工作流

1. 在工作流编辑器中，选择 Lock( 锁定 ) 。

2. 输入并确认密码然后单击 OK( 确定 ) 。

3. 保存您的更改。
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❖ 解锁工作流

1. 在控制面板上，右击该工作流并选择 Unlock( 解锁) 。

2. 输入正确的密码然后单击 OK( 确定) 。

重置丢失的密码

如果您丢失或忘记了工作流的密码，可以重置密码以解锁工作流。

您只能在 Windows中使用管理员帐户类型重置工作流密码。要重置密码，请以管理员身份运行 OMNIC Paradigm
软件。请注意，如果您使用的是 Security Suite 软件，即使您授予帐户访问 Reset Workflow Password( 重置工作流

密码) 控件的权限，用户仍必须以管理员身份运行 OMNIC Paradigm。

❖ 重置工作流密码

1. 在 Windows桌面的 Start( 开始) 菜单中，导航至 Thermo Scientific > OMNIC Paradigm。右击 OMNIC Paradigm
并选择 Run as administrator( 以管理员身份运行) 。

2. 在 OMNIC Paradigm中，使用桌面界面，选择要重置密码的锁定工作流程。

3. 选择 File > Workflow > Reset Password( 文件 >工作流 >重置密码) 。此选项仅在您以 Administrator( 管理

员) 身份运行 OMNIC Paradigm软件时出现。

密码将从工作流中删除并解锁工作流。
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创建模板工作流

模板工作流允许您创建可以根据情况使用动态值运行的单个工作流。例如，使用模板工作流，您可以创建一个可

以使用多个不同采样附件运行的工作流。操作员可以选择一个附件，工作流将自动更新以使用与该附件匹配的图

像、定量方法和变量。

要创建模板工作流，请使用 Workflow Table( 工作流表格) 磁贴。您可以使用 Workflow Table( 工作流表格) 磁贴

从 CSV文件导入选项表和相应值。然后在整个工作流程中使用这些值。

使用 Workflow Table( 工作流表格) 磁贴，您可以…

l 一次导入多个文件和变量

l 允许操作员从选项列表中进行选择或自动化选择

l 导入自定义变量或引用外部文件，例如图像或 QNT文件

若要使用 Workflow Table( 工作流表格) 磁贴，您需要构建要包含的选项和数据的 CSV文件、配置 Workflow Table
( 工作流表格) 磁贴，以及使用包含的数据。

❖ 使用 Workflow Table( 工作流表格) 磁贴创建模板工作流

步骤 1：创建您数据的 CSV文件

1. 使用 Workflow Table( 工作流表格) 磁贴创建要导入的 CSV文件。

图 4-1:以下示例显示了具有三个附件选项的表

l 构建表。创建表格时，每一行都反映一个选项或一类相关值。例如，您可以将每一行用于一个附件，并将

列用于与该附件关联的数据和文件。开发工作流程时，列标题将用作变量。您可以直接将表格创建为 CSV
文件，但在电子表格程序中使用表格然后将数据导出为 CSV文件可能更容易。

l 组织您的外部资源。引用外部资源( 例如图像或 QNT文件) 时，请确保您的文件井井有条。这将使它们

更容易导入 Workflow Table( 工作流表格) 磁贴中并在以后更新。

图 4-2:确保引用的资源井井有条
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2. 将表格另存为 CSV文件。

图 4-3:此图像将表格显示为 CSV文件

步骤 2：创建工作流和配置 Workflow Table( 工作流表格) 磁贴。

1. 在 OMNIC Paradigm软件中，转到 File > Workflows > Create( 文件 > 工作流 > 创建) 。命名该工作流并选择

OK( 确定) 打开工作流编辑器。

2. 将所需的任何文件添加到工作流中。

3. 将 Workflow Table( 工作流表格) 磁贴添加到工作流中。Workflow Table( 工作流表格) 磁贴的放置取决于您

的个人要求。

图 4-4:此示例工作流使用靠近开始处的“工作流表格”磁贴

4. 双击 Workflow Table( 工作流表格) 磁贴打开磁贴设置。

5. 配置 Workflow Table( 工作流表格) 磁贴。

a. 选择 Browse( 浏览) 并打开您的 CSV 文件。

如果 CSV文件包含对图像、QNT或 SPA文件的引用，磁贴将表明模板需要其他文件并提供用于添加和管

理文件的按钮。
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b. 对于所需文件的每个类别，选择 Add( 添加) 并打开您在 CSV文件中列出的关联文件。文件名必须与您

在 CSV文件中包含的内容完全匹配。

图 4-5:这些图像文件匹配 CSV文件中的文件名

c. 要提示操作员选择一个选项，请选择 Operator Selection( 操作员选择) 并选择一个列。选项的列索引决

定哪一列数据用于提供给操作员的选项。第一个列是列 1。您还可以使用选项指定要显示的图像列。如果

不显示图像，可将索引设为 0。
要自动选择行，则选择 Select row automatically( 自动选择行) 。第一行是行 1。您可以输入特定值或使

用变量。例如，使用 Variable( 变量) 磁贴将 Repeat( 重复次数) 磁贴的 Repeat_Count变量增加 1，然

后使用新变量自动循环所有选项。

步骤 3：使用导入的文件和变量
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1. 从 Workflow Table( 工作流表格) 磁贴中选择要使用数据的另一个磁贴。您如何使用 Workflow Table( 工作流

表格) 磁贴中的值将取决于您的特定需求。请考虑以下示例：

l 若要使用 QNT 文件：在 TQ Analyst磁贴设置中，选择 +图标以选择一个变量。选择对应于 CSV文件中的

QNT文件的 Workflow Table( 工作流表格) 变量。
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l 若要使用 Instruction( 说明) 磁贴中的图像。在 Instruction( 说明) 磁贴中，单击 Image( 图像) 添加一

个图像。右击图像占位符并选择适当的 Workflow Table( 工作流表) 值。

l 若要将值用作变量。在磁贴设置中选择 + 图标并选择一个 Workflow Table( 工作流表格) 变量。

2. 保存工作流。

步骤 4：测试您的工作流

测试您的工作流程以确保一切都已加载并按预期工作是一个良好的措施。

如果您的工作流包含测量数据，您可能需要使用 Simulator( 模拟器) 模式来简化测试。
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1. ( 可选) 。切换到 Simulator( 模拟器) 模式。

a. 返回控制面板。

b. 转到 Configure > Connectivity( 配置 > 连接) 。

c. 选择 Simulator( 模拟器) 并选择 Connect( 连接) 。

d. 选择要模拟的仪器并选择 OK( 确定) 。软件可能需要一些时间切换到新的模拟仪器。

2. 在工作流编辑器中打开工作流。

3. 选择 Run( 运行) 以运行工作流。

请注意，如果您的工作流有进行数据测量，测量结果将保存到您的数据库中，如同标准工作流中的流程。您可

能需要删除这些使用模拟数据的测量。

工作流磁贴参比

工作流磁贴是代表工作流可以执行的任务的图标。每个磁贴都具有定义了磁贴在工作流运行时所执行操作的设

置。要查看磁贴的设置，请将磁贴添加到工作流画布上的工作流，然后双击该磁贴。

此工作流磁贴参比按字母顺序组织。每个磁贴说明都包含可用设置的说明。

ATR 校正

校正 ATR 光谱以了解 ATR 技术中出现的穿透深度变化和红外吸收带移动的影响。

设置 说明

Crystal type
( 晶体类型)

选择用于测量样品的晶体类型。

Angle of
incidence( 入

射角)

输入用于测量样品的入射角。请参阅附件的规格以获取此值。

Everest ATR Accessory( Everest ATR 附件) ：45°

默认值为 45.00

Sample
refractive index
( 样品折射

率)

输入样品在 1000 cm-1 处的折射率。大多数有机材料在 1000 cm-1 处的范围介于 1.45 和 1.55 之

间。含有炭黑的材料具有更高的折射率值( 1.7 或更高) 。如果您不知道样品材料在 1000 cm-1
处的折射率，我们建议使用默认值 1.5。

Number of
bounces( 反射

次数)

输入 ATR 晶体中发生的红外光束的预期内部反射次数。有关晶体材料、入射角和反射次数的信

息，请参阅 ATR 附件的文档。

默认值为 1.00

Select
spectrum( 选

择光谱)
ATR 校正应用至指定的光谱。
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设置 说明

Tile name( 磁

贴名称)
设置工作流画布中磁贴的名称。

决策

使用 Decision( 决策) 磁贴，可以根据您指定的条件控制工作流的流程。例如，您可以根据相关性搜索结果的匹

配值是否高于指定阈值来提供两个独立的路径。

设置 说明

Pass/Fail
( 通过 /失
败)

选择“通过 /失败”决策类型可将先前生成的通过 /失败结果用作决策标准。

例如，Peak Analysis( 峰分析) 磁贴可以根据峰高的测量结果生成通过 /失败结果。例如，您可以指

定如果峰高高于给定值，则生成通过结果，如果低于该值，则生成失败结果。然后，您可以根据该结

果，使用“决策”磁贴在两个独立的路径中继续工作流。

Numeric
Value
( 数值)

选择要在决策中使用的数值。该值可以是先前工作流磁贴中生成的数据，也可以是操作员使用

Instruction( 指令) 磁贴输入的值。

例如，您可以检查搜索结果的匹配值是否高于指定的阈值，并根据该条件继续工作流。

String
Value
( 链值)

选择要在决策中使用的链值。该链可以是先前工作流磁贴中生成的数据，也可以是操作员使用

Instruction( 指令) 磁贴输入的文本。

使用链值，您可以检查所选值是否等于或包含您的测试链。

例如，如果您选择 Contains( 包含) 并提供“Poly”作为测试链，则如果所选值是 Polystyrene( 聚苯乙

烯) ，决策磁贴将评估为 True( 真) 。

Spectrum
Age( 谱

图年龄)

根据谱图的年龄控制工作流的流程。

例如，您可以在进入工作流的另一个步骤之前检查背景谱图是否超过 20 分钟，然后在必要时测量新

背景。

Tile name
( 磁贴名

称)
设置工作流画布中磁贴的名称。

延迟

继续之前，在指定的时段内暂停工作流。

设置 说明

Delay (seconds)( 延迟( 秒) ) 工作流将保持暂停的秒数。

Message( 消息) 该消息在延迟期间向操作员显示。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称。

嵌入式工作流

使用 Embedded Workflow( 嵌入式工作流) 磁贴可将一个工作流包含在另一个工作流中。
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使用 Embedded Workflow( 嵌入式工作流) 磁贴，您可以为通用磁贴或流程的子集创建一个工作流，然后在许多

其他工作流中重复使用该工作流。如果要更改嵌入工作流中的设置或更新磁贴，您可以一次过进行这些更改，而

不必在每个工作流中手动编辑设置。

您可以在工作流编辑器中更新任何嵌入式工作流。打开包含 Embedded Workflow( 嵌入式工作流) 磁贴的工作

流，右击画布上的空白区域，然后单击 Update Embedded Workflow(s)( 更新嵌入式工作流) 。然后选择要更新的

任何嵌入式工作流。

建议您始终使嵌入式工作流保持最新状态，以确保工作流按预期运行。

设置 说明

Select a Workflow file to import( 选择

要导入的工作流文件)

浏览到要用作嵌入式工作流的工作流文件。

如果要更新嵌入式工作流，您必须浏览到该工作流并重新加载它，否则

所进行的更改将不会反映在该工作流中。

结束

每个工作流都具有至少一个 End( 结束) 磁贴。如果您的工作流包括 Decision( 决策) 或 Selection( 选择) 磁

贴，则可能具有超过一个可能的结束。

设置 说明

End type
( 结束类

型)

选择 Success( 成功) 或 Failure( 失败) 可获得工作流结束状态的直观指示。结束类型不会影响工作

流中的数据。它仅向工作流开发人员提供视觉提示。

Note
(注释)

使用 Note( 注释) 字段可输入将光标悬停在工作流画布中的磁贴上时出现的工具提示的文本。这对

于向工作流开发人员提供提醒很有用。例如，如果用于 Failure( 失败) 结束类型，注释可以总结导

致失败的测试。

Tile name
( 磁贴名

称)
设置工作流画布中磁贴的名称。

公式

Equation( 公式) 磁贴是用于评估复杂公式的高级磁贴。您可以在公式中包含来自其他磁贴的变量，并使用内置函

数解决常见问题，例如计算平均值或四舍五入。您还可以使用函数来查找峰高或峰位置或对光谱执行其他运算。

下表列出了有效的运算符和函数。

运算符 说明 示例

+ 加 15 + 4 = 19

- 减 15 - 4 = 11

* 乘 15 * 4 = 60

/ 除 15 / 4 = 3.75

表 4-1:
算术运算
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运算符 说明 示例

- 负数 -15 + 4 = -11

mod
(取余)

模除运算

( 返回余数)
15 mod 4 = 3

& 文本串联 “abc” + “def” = “abcdef”

比较运算符返回 O表示 false 或 1 表示 true。

运算符 说明 示例 结果

< 小于 2 < 3 true

> 大于 3 > 2 true

<= 小于或等于 2 <= 3 true

>= 大于或等于 3 >= 2 true

=, == 等于 3 = 3, 3 == 3 true, true

!=, <> 不等于 3 != 3 false

true true = 1 true

false false = 0 true

表 4-2:
比较运算

运算符 说明 示例

AND 如果两个操作数都是 true，则为 True x AND y

OR 如果任一操作数是 true，则为 True x OR y

表 4-3:
逻辑运算

在下表中，方括号 ([])中的参数是可选的。

运算符 说明

Average(列表) 数字列表的平均值( 总和除以项目数)

Avg(列表) 数字列表的平均值( 总和除以项目数)

Max(列表) 列表中的最高值

Min(列表) 列表中的最低值

AMax(列表) 最大值的绝对值

表 4-4:
函数
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运算符 说明

AMin(列表) 最小值的绝对值

Sum(列表) 数字列表的总和

StdDeviation
(列表)

标准差

Std(列表) 标准差

acos(数字) 以弧度为单位的数字的反余弦

asin(数字) 以弧度为单位的数字的反正弦

atan(数字) 以弧度为单位的数字的反正切

aTan2(X1,X2) 以弧度为单位的 X1 的反正切除以 X2。两个自变量的符号用于确定返回值的象限。

cos(弧度) 以弧度为单位测量的角度的余弦。

cosh(弧度) 以弧度为单位测量的角度的双曲余弦值。

sin(弧度) 以弧度为单位测量的角度的正弦值。

sinh(弧度) 以弧度为单位测量的角度的双曲正弦值。

tan(弧度) 以弧度为单位测量的角度的正切。

tanh(弧度) 以弧度为单位测量的角度的双曲正切值

Pi() 圆的周长与其直径之比

abs(数字) 一个数字的绝对值。

Ceiling(数字) 大于或等于 <数字>的最小整数。示例：Ceiling(2.2) is 3.0

Floor(数字)
小于或等于 <数字>的最大整数。

示例：Floor(2.7) is 2.0

Round(数字) 将浮点值四舍五入到最接近的整数值。( 将四舍五入绑定到最接近的偶整数。) 3.5 -> 4; 4.5 -> 4

sqrt(数字) 一个数字的平方根。

Truncate(数字)
截断的数字。小数点右边的所有内容都被删除，只留下数字的整数部分。返回的值未四舍五

入。

Random() 0 到 1 之间的随机分数

exp(数字) 常数 e (2.7182818)的指定数 (e^<数字>)次幂的结果

Pow(基值 ,次
幂)

基值的次幂。

示例：pow(2,3) = 8

log10(数字) 以 10为基础的数字对数

log(数字) 以 10为基础的数字对数

ln(数字) 一个数字的自然对数( 以 e 为基础的对数)

expneg(次幂) 常数 e (2.7182818)的指定数 (e^<-数字>)的负幂的结果

ten(次幂) 10 的次幂
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tenneg(次幂) 10 的负幂

negln(数字) 负自然对数

neglog(数字) 以 -10 为基础的负数对数

invsqrt(数字) 平方根的倒数

toNumber(文
本)

将文本编号转换为可在公式中使用的数字。(“10” to 10)

textLength(文
本)

所指定文本中的字符数，包括空格。CRLF计为两个字符。

Y(位置 [,基线 ]
[,基线2])

给定位置的 Y轴值，带有两点基线

Area(开始 ,结
束 [,基线 ] [,基
线2])

使用两点基线的两个光谱限值之间的面积

Pmin(开始 ,结
束 [,基线 ] [,基
线2])

使用两点基线校正光谱，然后报告两个光谱限值之间的最小 Y轴值

Pmax(开始 ,结
束 [,基线 ] [,基
线2])

使用两点基线校正光谱，然后报告两个光谱限值之间的最大 Y轴值

Ploc(开始 ,结束

[,基线 ] [,基线2])
使用两点基线校正光谱，然后报告最大 Y轴值出现在两个光谱限值之间的位置( X轴值)

Pavg(开始 ,结
束 [,基线 ] [,基
线2])

确定两个光谱限值之间的光谱平均值

PkHgt(开始 ,结
束 [,基线 ] [,基
线2])

查找峰的高度

PkArea(开始 ,
结束 [,基线 ] [,
基线2])

使用两点基线的两个光谱限值之间的面积

PkLoc(开始 ,结
束 [,基线 ] [,基
线2])

使用两点基线校正光谱，然后报告最大 Y轴值出现在两个光谱限值之间的位置( X轴值)

PkMin(开始 ,结
束 [,基线 ] [,基
线2])

使用两点基线校正光谱，然后报告两个光谱限值之间的最小 Y轴值

PkMax(开始 ,结
束 [,基线 ] [,基
线2])

使用两点基线校正光谱，然后报告两个光谱限值之间的最大 Y轴值
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运算符 说明

Pwidth(开始 ,
结束 [,%高度 ])

确定两个光谱限值之间的峰宽。报告峰达到峰最大值的指定百分比时的宽度。

Pcut(开始 ,结
束 [,%高度 ])

确定指定光谱区域中切入点或截止点的位置( X轴值) 。例如，对于 Y值增加的区域，当增加量

达到该区域总增加量的指定百分比时，就会出现一个切入点。以下示例显示了“百分比”设为 60
的切入点：

Ghalfwidth( 起

点，终点)
查找一半峰高处的峰宽

Slope(x1, y1,
x2, y2, x3, y3,
...):

返回斜率 (y=mx+b)

Intercept(x1,
y1, x2, y2, x3,
y3, ...):

返回截取点

ZSlope(x1, y1,
x2, y2, x3, y3,
...):

返回 zslope (y=mx)

CorCoef(x1,
y1, x2, y2, x3,
y3, ...):

相关系数

Laser(x1, y1,
x2, y2, x3, y3,
...)

在测量光谱的条件下计算仪器的最佳激光频率。

x1、x2、x3 ...指光谱的峰或特征的测量值。

y1、y2、y3 ...指相应峰或特征的真实值。

该函数的输出是使测量值尽可能接近真实值的激光频率值。

DoesFileExist
(文件名):

接受引号中的完整文件路径并返回 true(1)或 false(2)。
示例：DoesFileExist(“C:\Users\MyFiles\MyMethod.qnt”)
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M(名称) 返回使用的测量方法

V(名称) 返回复合物组分

C(名称) 返回组分 (名称)的浓度

U(名称):
返回与组分 (名称)浓度相关的不确定性

TQ_Y(值): 输入 Y文件的索引值。第一个元素是索引 1。

TQ_Z(值) 输入 Z文件的索引值。第一个元素是索引 1。

U_Set(索引 ,值) 设置索引处的值

TQ_UU(值) 访问附加到 TQ方法的用户值

UU_Set(索引 ,值)
设置指定索引处的用户值

表 4-5:
TQ函数：这些函数允许您处理来自 TQ方法的信息

导出

将数据和报告发送到用户指定的位置。此位置可以在您的本地系统上，也可以在网络或闪存驱动器上作为备用存

储。

设置 说明

Select data to archive
( 选择要存档的数据)

在工作流期间，从创建或导入的可用光谱和报告中进行选择。

File base name( 文件

基本名称)

基本名称附加在完整文件名的前面。

存档的文件将根据以下模板命名：

<基本名称>_<工作流名称>.<用于创建数据的磁贴名称>.<变量名称>_YYYY_MM_DD_
HHMMSS_<格林威治标准时间的时区>.<文件扩展名>

例如，如果基本名称为“example”，工作流名称为“my workflow”，在 Measure( 测量) 磁

贴上采集的光谱将按以下方式存档：

“example_my workflow.Measure.Sample_
2019_06_25_104928_GMT-0500.spa”

Append date and time to
file name( 将日期和时

间附加到文件名中)

如果选择此设置，系统会将保存数据的日期和时间附加到文件名中。这可确保每次运行

工作流时都会创建一个新文件。

如果未选择此设置，每次运行工作流时，新文件将会覆盖先前导出的文件。如果要更新

一个文件而不是创建新文件，这将很有用。

File location( 文件位

置)
用于存档文件的目录。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称。
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Instruction( 说明 )

使用 Instruction( 说明) 可以为工作流操作员提供附加说明。 Instruction( 说明) 磁贴还可以包含供操作员输入文本

或数字数据的输入字段。这些条目稍后可在工作流中使用。例如，可以将操作员输入的文本添加到自定义报告

中。

设置 说明

Add Image( 添加图像)

添加操作员在工作流期间将在说明屏幕上看到的图像。有效的文

件类型包括：

.PNG

.JPG

.GIF

.BMP

Add Text Box( 添加文本框)
用于添加文本。这对于为操作员提供说明以及在文本和数字输入

字段中添加标签很有用。

Add or Remove PDF( 添加或删除 PDF)
提供操作员可以单击或点按以查看指定 PDF的按钮。

添加文档按钮后，点击该按钮可指定 PDF文件。

Add or Remove Cancel Button( 添加或删除

Cancel( 取消) 按钮)
提供操作员可以单击或点按以停止工作流的“取消”按钮。

+ Text Entry( +文本输入)
允许操作员输入稍后可在工作流中使用的文本。

例如，操作员可以输入可在 Archive( 磁贴) 中使用的文件路径。

+ Numeric Entry( +数字输入)

允许操作员输入一个稍后可在其他磁贴中用作变量的数值。

例如，输入的数值可以在 Decision( 决策) 磁贴中用作 Numeric
Value( 数值) 决策中的条件。

+ Value( +值) 显示来自变量的数据，例如相关性搜索结果的匹配值。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称。

加载光谱

加载要在工作流期间使用的 SPA文件。您可以浏览到仪器计算机或闪存驱动器或网络位置上的文件位置，或者您

可以从数据库加载光谱。

这对于导入保存的光谱用作参比很有用。例如，您可能想要导入参比谱图用于减法运算。

设置 说明

From file( 从文件)
从系统或网络上的位置加载 SPA文件。

File name( 文件名) ：浏览到 SPA文件以包含光谱。
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From database( 自数据

库)

选择此设置可从数据库加载光谱。

Select spectrum( 所选谱图) ：从数据库中选择一个光谱。

Choose during workflow execution( 在执行工作流期间选择) ：允许操作员在工作流期

间选择光谱。

Show only experiments containing this text( 仅显示包含文本的实验) ：将操作员的选

择限制为仅在标题或标签中包含指定文本的光谱。

Import spectrum every run
( 每次运行时导入谱

图)

如果选择此项，将会在运行工作流时从文件系统导入光谱。如果更新了光频文件，工

作流将始终使用最新版本的光频。

如果未选择此项，将会在创建工作流时导入光谱文件的副本。此光谱只有在您手动编

辑工作流并更新光谱文件时才会发生变化。

请注意，如果您共享此工作流或将其添加到工作包中，您将需要个别共享 SPA文件，

并且必须以 Import Spectrum( 导入光谱) 磁贴中指定的完全相同的文件路径将它保存

在任何其他系统上。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称。

测量

使用 Measure( 测量) 磁贴可测量背景和样品以及设置测量设置。在工作流中创建的光谱和报告会保存到数据库

中，并且可以使用 Archive( 存档) 磁贴进行存档。

设置 说明

Background settings( 背景设置)
指定工作流将提示操作员采集新背景、使用工作流中另一个磁贴的光谱，

还是仅测量背景而不测量样品。

Correction settings( 校正设置) 应用大气抑制和 /或 Kramers-Kronig 校正。

Use internal polystyrene sample( 使

用内部聚苯乙烯样品)
如果选择此项，将使用安装在仪器中的内部聚苯乙烯参比样品来验证仪器

的性能。

Use sample prompt( 使用样品提

示)
选择此项可在测量样品之前为操作员提供指示。您可能需要指示操作员插

入样品。

Use background prompt( 使用背景提

示)
选择此项可在测量背景之前为操作员提供指示。指示操作员准备测量背景

是一个良好的措施。

Allow other workflows to access result
of measurement( 允许其他工作流访

问测量结果)

如果选择此项，您可以在其他工作流中包括来自此工作流的光谱。例如，

一旦运行此工作流并测量了样品，个别的工作流可以将采集的光谱用作参

比谱图或在报告中使用。

Show spectrum during measurement
( 测量期间显示光谱)

选择此项可在测量期间查看光频。如果未选择此项，操作员将仅看到进度

指示。

Progress text( 进度文本) 在测量背景和样品期间为操作员提供自定义消息。
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设置 说明

Other Measurement Settings( 其他测

量设置)

自定义此工作流中使用的测量设置或匹配用于另一个光谱的设置。

Number of scans( 扫描次数) ：将扫描样品的次数。更多次的扫描通常意

味着将会产生更准确的数据，但也需要更长的时间进行测量。

Match Settings( 匹配设置) ：选择此项可匹配用于所指定 SPA或 QNT文

件的测量设置。选择 All Settings( 所有设置) 可查看用于此测量的所有设

置。

Spectrum Title( 谱图标题) ：选择此项可将变量数据附加到谱图标题。

有关其他设置的说明，请参阅 Measurement Settings( 测量设置) 和

Advanced Measurement settings( 高级测量设置) 。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称。

Peak Analysis( 峰分析 )

查找峰位置或分析光谱的 Peak Height( 峰高) 或 Peak Ratio( 峰比) 。

设置 说明

Peak Height( 峰

高)

测量从零吸光度( 或透过率100%) 开始的峰高，不考虑基线的位置，或从基线开始测量。

如果从基线测量，该测量值称为“已校正峰高”。

Peak position( 峰位) ：输入要测量的峰的波数。

Corrected( 已校正) ：选择此项从光谱基线而不是从零吸光度( 或透过率100%) 测量峰高

Reference point( 参比点) ：选择此项可使用一个点作为基线参比进行单点校正。

Reference range( 参比范围) ：选择此项可使用峰两侧的点计算基线来进行两点校正。

Generate pass/fail result( 生成“通过 /失败”结果) ：选择此项可创建能够在 Decision( 决策)
磁贴中使用的通过 /失败结果。

Peak Ratio( 峰

比)

运算两个峰之间的高度比。可以从零吸光度单位或已校正基线计算峰。

Not corrected( 未校正) ：从零吸光度( 或从透过率100%) 开始测量峰高

Single-point corrected( 单点校正) ：将从您输入的波数处的基线开始测量峰高。

Two-point corrected( 两点校正) ：峰两侧的点将用于计算基线。

Generate pass/fail result( 生成“通过 /失败”结果) ：选择此项可创建能够在 Decision( 决策)
磁贴中使用的通过 /失败结果。

Find Peaks( 峰查

找)
查找光谱中的峰位置。带有标记峰的结果光谱可作为 Report( 报告) 磁贴中的光谱和

Template Report( 模板报告) 磁贴中的模板选项使用。

Select spectrum
( 选择光谱)

选择要在峰分析中使用的光谱。您可以选择工作流中生成的光谱，也可以选择使用 Load
Spectrum( 加载光谱) 磁贴导入的光谱。

Tile name( 磁贴名

称)
设置工作流画布中磁贴的名称
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处理

Processing( 处理) 磁贴包含多个用于处理光谱数据的工具，包括减法、标准化、相关性、基本谱图数学运算和基

线校正。

设置 说明

SpectralMath( 谱图

数学运算 )
使用样品光谱和参比谱图执行基本运算。有关谱图数学运算的更多信息，请参阅"将基本公式应用

至采集的数据"

Sample
spectrum
( 样品光

谱 )

将应用运算的起始光谱。

Reference
spectrum
( 参比谱

图 )

用于运算的参比谱图。

Operation
( 运算 )

Add( 加 )
Subtract( 减 )
Divide( 除 )
Multiply( 乘 )

SpectralMath
Type( 谱图

数学运算类

型 )

选择一种谱图数学运算。可用的选项包括

l Factor( 系数)

l Pathlength( 光程)

l Range( 范围)

Normalization( 标

准化)

使用 Normalize( 标准化) 可将所选光谱的 Y轴刻度更改为“标准”刻度，其中数据点范围的

Y值从最低点的 0 吸光度单位到最高峰的 1 吸光度单位( 对于类似吸光度的光谱) 或从

10% 到 100% 的透过率( 对于类似透射的光谱) 。这些标准刻度是商业谱库中光谱的典型

刻度。

标准化光谱后，除非您知道缩放系数并相应地调整定量结果，否则无法将其用于定量分

析。

Select
spectrum
( 选择光

谱)

将应用运算的起始光谱。

Max range
(cm-1)( 最

大范围

(cm-1))

用于设置标准化中使用的范围。

Min range
(cm-1)( 最

小范围

(cm-1))

用于设置标准化中使用的范围。
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设置 说明

Target
value( 目

标值)
目标值以吸光度单位指定。

Derivative( 导数 ) 将光谱转换为其一阶或二阶导数，以帮助您找到峰的位置或强度。

Select
spectrum
( 选择光

谱 )

将应用运算的光谱。

Order( 阶

次 )
选择一阶或二阶导数。

Correlation( 相关

性)
返回第一个和第二个光谱之间的匹配值。与 QCheck一样，匹配值介于 0.0 和 1.0 之间，1.0
反映完美匹配。

First
spectrum
( 第一个光

谱)

选择与第二个光谱进行比较的起始光谱。

Second
spectrum
( 第二个光

谱)

选择一个参比谱图。

Spectral
range( 光

谱范围)
使用光谱范围从相关性搜索中排除完全吸收峰。

Scalar Math( 标量

数学运算)
对单个光谱应用运算。

Spectrum
( 光谱)

选择将应用运算的光谱。

Operation
( 运算)

Add( 加)
Subtract( 减)
Divide( 除)
Multiply( 乘)

Factor
(系数)

增加或减少光频的幅度，使其与另一个光频的相比更好。

Baseline Correction
( 基线校正)

用于校正偏移的基线。

Select
spectrum
( 选择光

谱)

选择将校正基线的光谱。
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Polynomial
order( 多

项式阶次)
指定用于校正的多项式阶次。

Conversion( 转换 ) 将光谱转换为另一个单位。

Select
spectrum
( 选择光

谱 )

选择要转换的光谱。

Conversion
type( 转换

类型 )

转换为以下单位之一：

l Absorbance( 吸光度)

l % Transmittance( 透过率%)

l % Reflectance( 反射率%)

l Log 1/Reflectance( 记录 1/反射率%)

l Kubelka-Munk

Blank
regio-
ns
(空白

区域)

清除光谱中一个或多个区域的数据。有关空白区域的更多信息，请参阅"空白光谱中的区域

"。

设置要空白的区域的起点和终点。单击 Add( 添加) 可添加更多区域。

Statis-
tical
spec-
tra
(统计

光谱)

计算 2 个或更多光谱的平均值和标准偏差。在 Report( 报告) 磁贴中查看结果光谱。 .有关

计算光谱平均值或标准偏差的更多信息，请参阅"计算平均和标准偏差光谱"。

选择 2 个或更多光谱、要执行的计算以及计算中使用的数据格式。

Tile name( 磁贴名

称)
设置工作流画布中磁贴的名称

重复次数

循环工作流的一部分以重复步骤。

设置 说明

Repeat ___ times( 重复 ___ 次) 设置工作流的循环部分将重复的次数。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称。

报告

创建可存储、存档或打印的自定义报告。工作流中生成的报告可在控制面板的 Reports( 报告) 部分使用。

Thermo Scientific OMNIC Paradigm 软件用户指南 202

4. 操作指南



4. 操作指南

设置 说明

Add image( 添加图像)

添加操作员在工作流期间将在 Reports( 报告) 屏幕上看到的图像。有效的文

件类型包括：

.PNG

.JPG

.GIF

.BMP

Add Text( 添加文本)
用于添加文本。这对于为操作员提供说明以及在文本和数字输入字段中添加

标签很有用。

Add or remove document( 添加或

删除文档)

提供操作员可以单击或点按以查看指定 PDF的按钮。

添加文档按钮后，点击该按钮可指定 PDF文件。

Add spectrum( 添加光谱) 将光谱添加到报告中。选择之前在工作流中生成或加载的任何光谱。

Add variable( 添加变量)
将另一个工作流磁贴中的值添加到报告中。例如，如果工作流包括测量和搜

索，您可以包括来自搜索结果的数据。

Add table( 添加表 )
显示结果表，例如来自 TQAnalyst/Quant方法或峰分析的结果。显示先前的运行工作

流实例的结果，而不仅仅是当前运行的结果。

Add or remove print button( 添加

或删除“打印”按钮)
使用“打印”按钮，操作员可以在查看报告屏幕的同时打印报告。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称

运行程序

使用 Run Program( 运行程序) 可以使您的工作流运行可执行文件。例如，使用此磁贴可在您的工作流中创建一个

步骤，用于运行第三方自动采样附件。

将此磁贴与 Variable( 变量) 磁贴或其他磁贴结合使用，可创建强大的工作流。例如，使用 Repeat( 重复次数)
磁贴中的计数变量可以自动递增传递给可执行文件的自变量。

Run Program( 运行程序) 磁贴只能运行不需要任何用户交互且没有用户界面的可执行文件。

设置 说明

File name( 文件名 )
要运行的可执行文件。请注意，如果您在另一台计算机上运行此工作流，该计算机必须在完

全相同的文件路径中具有相同的 EXE。

Arguments( 自变量 )

将自变量传递给可执行文件。要在命令中包含变量，可从列表中选择一个变量并单击

Add to Arguments List( 添加到自变量列表) 。输入自变量时，请遵守以下语法要求：

l 每个自变量必须用双引号 (“”)括起来

l 用空格分隔自变量

示例：“-p 6” “workflowname.variable.myVariable”
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Verify program file integrity at
run time( 在运行时验证程

序文件的完整性 )

确保可执行文件在运行时是完全相同的文件。

创建工作流时，软件会存储可执行文件的位置和名称。

如果文件被具有相同名称的新可执行文件替换，系统将运行该文件。选择此选项可确

保该文件与您在创建工作流时选择的文件完全相同。

我们建议保留选定此设置以确保 exe 未被其他文件替换。如果您有意更新 exe，还必

须更新工作流。

如果您希望定期更新 EXE而不想更新工作流，关闭此设置将很有用。但是，这可能会

带来安全风险。

保存结果

将收集的数据导出到 CSV文件。

设置 说明

Select data to export( 选

择要导出的数据)
选择可导出到 CSV文件的可用数据，例如峰高或搜索结果匹配值。

Append to file( 附加到文

件)

如果选择此项，会将导出的数据附加到现有的 CSV文件中。

要将数据附加到现有文件，请在 File Name( 文件名) 字段中输入文件名。如果该文

件不存在，将使用您输入的名称创建一个新文件。

File name( 文件名)
( 仅在选择 Append to File [附加到文件 ]时可用)

输入要附加数据的文件的名称。如果该文件不存在，将创建一个新文件。

File base name( 文件基本

名称)

( 仅在未选择 Append to File [附加到文件 ]时可用)

文件基本名称将添加到日期和时间之前的文件名。

File location( 文件位置) 将附加或创建文件的目录。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称。

检索

执行相关性或多组分搜索。

设置 说明

Available libraries( 可用

谱库)

将谱库从 Available Libraries( 可用谱库) 列拖动到 Selected Libraries( 所选谱库) 以

便在搜索中使用它们。

单击 Refresh( 刷新) 更新可用谱库列表。
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设置 说明

Search type( 搜索类

型)

设置要执行的搜索类型。

Correlation( 相关性) ：用于鉴别未知样品。

Number of results( 结果数) ：设置要显示的结果数。

Multi-component( 多组分) ：用于鉴别样品的组分。

Number of components( 组分数量) ：设置要显示的组分数量。

Spectral Ranges( 光谱

范围)
添加要搜索的区域的起始和结束值。

Select spectrum( 选择光

谱)
指定要在搜索中使用的光谱。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称

选择

使用 Selection( 选择) 磁贴，操作员可以选择工作流应遵循的路径。

设置 说明

Add image( 添加图

像)

添加操作员在工作流期间将在 Selection( 报告) 屏幕上看到的图像。有效的文件类型包

括：

.PNG

.JPG

.GIF

.BMP

Add Text( 添加文

本)
用于添加文本。这对于向操作员提供说明很有用。

Add value( 添加值)
将另一个工作流磁贴中的值添加到报告中。例如，如果工作流包括测量和搜索，您可以包

括来自搜索结果的数据。

Selection label( 选择

标签)
编辑选择标签以更改工作流画布上显示的文本。

起始

这是每个工作流中的第一个磁贴。每次创建新工作流时，都会自动在工作流画布中添加 Start( 起始) 磁贴。

设置 说明

Workflow image( 工作流图

像)

确定运行工作流时显示的图像。接受图像文件的文件路径。

以下文件类型有效：

.PNG

.JPG

.GIF

.BMP
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Desired aspect ratio( 所需宽高

比)

指定高宽比可优化工作流在运行时的外观。高宽比应尽可能与操作员使用的显示

器相匹配。

示例：

4:3 适用于较旧的计算机显示器

16:9 是高清视频的标准，是目前计算机显示器常用的

接受以下高宽比：

1:1
4:3
5:4
16:9
16:10
3:2
2:1

标记谱图

将标签应用到工作流期间创建的光谱。

设置 说明

Tag( 标签) 将标签应用到光谱。

Select spectrum( 选择光谱) 选择要应用标签的光谱。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称。

模板报告

从模板生成报告。工作流中生成的报告可在控制面板的 Reports( 报告) 部分使用。模板报告的大多数设置取决于

所选的模板类型。

设置 说明

Template type( 模板类型)

从下列模板类型中进行选择：

ValPro style( ValPro 样式)

Single spectrum( 单个谱图)

Multiple spectra( 多个谱图)

Search results( 搜索结果)

Single quantification( 单个定量)

QCheck

Multiple run quantification( 多个运行定量)
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设置 说明

Automatically advance workflow after
displaying report for 5 seconds( 显示报告 5
秒后自动继续工作流)

如果选择此项，工作流将在显示报告 5 秒后继续。如果未选择此

项，操作员将手动继续工作流。

Generate pass/fail result( 生成通过 /失败结

果)

如果选择此项，请指定将触发失败结果的文本。例如，如果您指

定“fail( 失败) ”，并且报告包含“fail( 失败) ”文本，“模板报告”磁
贴将生成失败结果。

TQ Analyst

使用指定的定量方法对样品的组分进行定量。

设置 说明

Quantification method( 定量方法) 选择用于定量方法的 QNT文件。

Select spectrum( 选择光谱) 选择要用于定量的光谱。

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称。

变量

使用 Variable( 变量) 磁贴可以为现有变量分配一个新值或创建新的自定义变量。使用 Variable( 变量) 磁贴创建

或编辑的变量可用于其他磁贴。

设置 说明

Operation( 操

作)

选择一个操作类型。您选择的操作决定了可用的其他设置。

Set Variable( 设置变量) ：用于设置当前变量的值。

Create Variable( 创建变量) ：用于创建新变量。

Set Variable
( 设置变量)

Variable to set( 要设置的变量) ：选择一个变量以更改值。

Current variables( 当前变量) ：提供工作流中当前变量的列表。选择一个变量并单击 Add to
Expression( 添加到表达式中) 将该变量包含在表达式中。

Create
Variable( 创建

变量)

Numeric( 数字) 或 Text( 文本) ：为该变量的值选择一种类型。类型决定了对该变量有效的操

作。例如，如果您将类型设为 Text( 文本) ，您将无法使用此变量的值进行计算。

Variable name( 变量名称) ：输入变量的名称

Initial value( 初始值) ：输入该变量的起始值

工作流表格

导入 CSV文件以用作工作流的模板。

使用 Workflow Table( 工作流表格) 磁贴，您可以导入要在整个工作流中使用的选项表。例如，您可以使用此磁贴

在开始工作流时选择一个选项，然后在整个工作流中自动加载与该选项对应的特定变量、方法和图像。
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设置 说明

CSV file( CSV文件)
浏览到要导入的 CSV文件。

浏览以选择一个新文件。重新加载以检查文件是否有更新。

Select row automatically
( 自动选择行)

自动从 CSV文件中选择一行。

Operator selection( 操作

员选择)

工作流操作员在工作流期间手动选择一行。

Operator prompt( Operator提示) ：为操作员显示的文本指示。

Column index for selection options( 选项的列索引) ：指定要用作可用选项的列。第一

列是索引 1。

Column index for selection images( 选项图像的列索引) ：您还可以将图像连同选择选

项一起显示。如果不使用图像，则将索引设为 0。

Included files( 包含的文

件)

显示根据 CSV文件的预期文件以及工作流中包含的文件数。

l 选择 Add( 添加) 可添加一个或多个文件。

l 选择 Manage( 管理) 可查看或删除包含的文件

Tile name( 磁贴名称) 设置工作流画布中磁贴的名称。
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4.6 自定义解决方案

使用工作包编辑器捆绑和共享工作流，并使用 Operator( 操作员) 界面打开和运行工作包。

在本节中：

自定义解决方案 209

创建或编辑工作包 211

Operator Administrator( 操作员管理员) 214

自定义解决方案

本页简要概述了使用工作包和 OMNIC Paradigm软件中的 Operator( 操作员) 界面来开发和运行自定义解决方案。

如果可用，请按照链接查找有关使用特定功能的更多详细信息。

什么是自定义解决方案？

使用 OMNIC Paradigm软件中的自定义解决方案，您可以设计和捆绑工作流以供其他操作员使用。

开发人员设计工作流并将其与所有需要的文件捆绑到 Packages( 工作包) 中，然后将工作包作为 RDEP文件共

享。

然后管理员即可打开这些工作包，从而可以使用 Operator( 操作员) 界面运行工作流。

工作包和工作包编辑器

工作包是一个有组织的工作流集合，可以轻松共享。如果将工作流捆绑到一个工作包时，该工作包将包含在另一

个系统上运行工作流所需的所有文件和信息，包括任何参比谱图、图像和 QNT文件。

创建和导出工作包时，另一个地点的管理员可以在 Operator( 操作员) 界面中打开该工作包，以便用户可以运行

所有包含的工作流。

有关创建和导出工作包的详细信息，请参阅"创建或编辑工作包"。
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图 4-1:工作包编辑器

一个工作包有两个主要元素：

l Workflows( 工作流) ：工作流是一组预先确定的程序和设置，可确保每次都以完全相同的方式执行程序。有

关工作流的更多信息，请参阅"关于工作流"。

l Categories( 类别) ：在工作包中，工作流按类别进行组织。您可以按照对您的组织有意义的任何方式将工作

流分组；但是，一个工作流只能包含在一个类别中。不能将同一工作流包含在多个类别中。

导出工作包时，工作流中使用的所有必需文件也会包装成套，确保操作员在打开工作包时拥有运行工作流所需的

所有文件。

Operator( 操作员 ) 界面

Operator( 操作员) 界面用于运行从工作包加载的工作流以及管理工作包。打开工作包后，操作员会看到一个简化

的界面，用于运行工作包工作流。

Operator Administrator( 操作员管理员) 可以通过打开或删除工作包来控制哪些工作流可用。
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图 4-2:Operator( 操作员) 界面

Operator( 操作员) 界面类似于 OMNIC Paradigm软件的触摸屏界面，但仅显示来自已打开工作包的工作流。

Operator Administrator( 操作员管理员) 可以使用管理员控件打开、更新和删除工作包。有关打开和删除工作包的

详细信息，请参阅"Operator Administrator( 操作员管理员) "。

关于如何使用工作包的提示

创建工作流和工作包时，跟踪依赖项可能具有挑战性，例如定量方法和嵌入式工作流。以下提示可帮助您管理文

件并确保您的工作流是最新的且易于维护。

l 组织您的文件以便易于更新和维护。例如，您可能想要为工作流中使用的资源创建一个文件夹。然后，在该文

件夹中，为相关项目创建特定文件夹，例如定量方法、图像和光谱文件。然后，将文件夹保留在同一位置并保

持文件名相同。然后，您可以使用工作流编辑器中的 Update( 更新) 命令快速更新工作流的所有依赖项。

l 使您的工作流尽可能简单。例如，Embedded Workflow( 嵌入式工作流) 磁贴是一个功能强大的工具，但它增

加了项目的复杂性。每当更新嵌入式工作流时，您都需要手动更新使用该工作流的所有其他工作流。

创建或编辑工作包

您可以使用工作包编辑器创建新工作包或者打开和编辑现有工作包。

创建工作包之前，您将需要至少一个工作流。有关创建和使用工作流的更多信息，请参阅"关于工作流"。

只能在 OMNIC Paradigm软件的桌面界面中创建工作包。
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创建新工作包

❖ 创建新工作包

1. 使用桌面界面，转到 File > Packages > Create( 文件 > 工作包 > 创建) 。

2. 输入工作包的名称并选择 OK( 确定) 。工作包编辑器将打开并包含一个默认类别。您可以添加更多类别或在

类别中添加工作流。

3. 要添加工作流，请选择一个类别然后选择 Add Workflow( 添加工作流) 。

工作流只能包含在一个类别中。您不能在多个类别中使用相同的工作流。

4. 要添加类别，请选择 Add Category( 添加类别) 。

5. 选择 Save( 保存) 以保存工作包。保存的工作包可在控制面板的 Packages( 工作包) 窗格中使用。返回控制

面板时会自动保存工作包，但如果从工作包编辑器退出软件，则不会自动保存工作包。

6. 要共享工作包，请选择 Export( 导出) 。导出工作包时，该工作包会以 .rdep 文件扩展名保存。

关于组织工作流和类别的提示

组织工作包中的工作流和类别时，需要考虑几个重要因素。

l 一个工作流只能包含在一个类别中。您不能在多个类别中使用相同的工作流。如果要在类别之间共享工作流，

您只需要为这些共享的工作流创建一个独立的类别。此情况也适用于具有多个工作包的情况。如果先前加载的

工作包已经包含同名的工作流，若该工作流处于另一个类别中，Operator Administrator( 操作员管理员) 将无

法打开包含该工作流的新工作包。

l 类别也必须具有一个唯一的名称。当操作员打开工作包时，使用与先前工作包中的类别相同名称的任何类别都

将被合并。例如，如果新工作包包含名为类别 A的类别，并且先前的工作包已包含了类别 A，则这些类别将合

并为一个类别，包括来自两个类别的所有工作流。

请考虑以下示例：

l 类别 A( 第一个工作包)

o 工作流 1

o 工作流 2

l 类别 A( 第二个工作包)

o 工作流 3

显示为 :

l 类别 A

o 工作流 1
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o 工作流 2

o 工作流 3

编辑工作包

您可以从控制面板的 Packages( 工作包) 窗格或从保存的 RDEP文件打开和编辑工作包。

❖ 编辑工作包

l 从桌面界面的控制面板

1. 滚动至 Workflows( 工作流) 窗格并从列表中选择 Packages( 工作包) 。

2. 右击一个工作包并选择 Edit( 编辑) 。该工作包将在工作包编辑器中打开。

l 从保存的 RDEP文件

1. 从控制面板，转到 File > Packages > Open( 文件 > 工作包 > 打开) 。

2. 选择一个 RDEP文件并选择 Open( 打开) 。该文件将会添加到控制面板上的工作包列表中。

3. 在 Packages( 工作包) 窗格中，右击工作包并选择 Edit( 编辑) 。

如果从工作包编辑器打开 RDEP 文件，工作包将会自动在工作包编辑器中打开。

更新工作流

工作包编辑器包含多个用于更新工作流及其相关文件的工具。

将工作流添加到工作包时，工作流文件将复制到工作包中。任何更新仅适用于此工作包副本，不会反映在原始文

件或复制该工作流文件的任何其他工作包中。

要使工作流文件及其关联文件( 例如图像或 QNT文件) 保持同步，您必须在工作流编辑器中手动更新它们。要避

免意外行为或结果，您可能需要使用工作流编辑器直接更新工作流，然后仅使用工作包编辑器中的 Update
Workflow( 更新工作流) 命令。

命令 说明

Update Workflow( 更新

工作流)
重新加载选定的工作流程并更新任何更改，包括工作流程中包含的任何文件( 例

如，更改的图像文件) 。

Update Embedded( 更新

嵌入式)
更新使用 Embedded Workflow( 嵌入式工作流) 磁贴嵌入的任何工作流。

Update Quant( 更新

Quant)
重新加载工作流中包含的所有 .QNT文件。

Update Image( 更新图

像)
重新加载工作流中使用的任何图像文件。
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测试工作包

导出工作包之前，使用 Run( 运行) 命令测试工作包。通过运行工作包，可以查看和运行将在 Operator( 操作

员) 界面中显示的类别和工作流。

注释如果在运行工作包时运行任何收集数据的工作流，测量值将会添加到数据库中，就像正常运行工作流一

样。

自动运行工作流

可以使用 Auto Run( 自动运行) 将工作流设为自动运行。如果启用自动运行，工作流将在没有任何操作员输入的

情况下运行。当您使用该软件时，工作流将在后台运行。如果工作流在后台运行，操作员将需要等待它完成才能

运行另一个工作流。

可以将工作流设为仅在不需要任何用户输入时自动运行。

如果将多个工作流计划为使用 Auto Run( 自动运行) 运行，这些工作流将会被添加到一个队列中。例如，如果一

个工作流每小时运行一次，另一个工作流每两小时运行一次，则它们都将在重叠的时间运行并且不会相互干扰。

❖ 启用 Auto Run( 自动运行)

1. 在工作包编辑器中，右击一个工作流并选择 Set Up Auto Run( 设置自动运行) 。

2. 选择 Enable automatic running for this workflow( 启用此工作流的自动运行) 并输入频率值( 以小时为单

位) 。您也可以输入部分小时数。例如，输入 0.5 将使工作流每 30 分钟运行一次。

3. 选择 OK( 确定) 。

在 Operator( 操作员) 界面中打开工作包后，工作流将自动运行。

Operator Administrator( 操作员管理员 )

使用 Operator( 操作员) 界面中的 Administrator( 管理员) 控件可管理工作包、更改管理员密码以及返回桌面界

面。

要访问管理员控件，请从 Operator( 操作员) 界面中选择 Administrator( 管理员) ，然后输入正确的密码。默认密

码为 Password。安装软件后，管理员应立即更改密码。

管理工作包

使用 Administrator( 管理员) 视图中的 Package Maintenance( 工作包维护) 选项卡可管理工作包。

打开工作包

打开工作包可将工作包类别和工作流加载到 Operator( 管理员) 界面中。打开工作包后，操作员可以选择类别和

运行工作流。设为自动运行的任何工作流将会按计划开始运行。
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打开新工作包时，新的类别和工作流将会添加到先前打开的工作包的类别和工作流中。例如，如果管理员打开“工
作包 A”，然后打开“工作包 B”，操作员将会看到两个工作包的类别和工作流程。

❖ 打开工作包

1. 使用 Operator( 操作员) 界面，打开菜单并转到 Administrator( 管理员) 。

2. 输入密码以访问管理员控件。

3. 在 Package Maintenance( 工作包维护) 选项卡中，选择 Open( 打开) 。

4. 选择一个工作包文件并选择 Open( 打开) 。工作包文件具有 .rdep 文件扩展名。

更新工作包

打开一个与先前打开的工作包同名的工作包时，该工作包将会更新。

例如，如果您之前已经打开了一个名为“工作包 A”的工作包，当您打开一个也称为“工作包 A ”的新工作包时，新工

作包将替换之前的工作包。

删除工作包

删除工作包会从 Operator( 操作员) 界面中删除该工作包的类别和工作流。

❖ 删除工作包

1. 使用 Operator( 操作员) 界面，打开菜单并转到 Administrator( 管理员) 。

2. 输入密码以访问管理员控件。

3. 从工作包列表中选择一个或多个工作包。

4. 选择 Delete( 删除) 并在确认对话框中确认您的选择。

更改管理员密码

使用 Change Password( 更改密码) 选项卡可更改 Operator Administrator( 操作员管理员) 的密码。
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4.7 保护您的数据

将 OMNIC Paradigm软件与 Security Suite 软件搭配使用，可以确保您的数据完整性和安全性。

在本节中：

使用 OMNIC Paradigm软件确保数据的安全性和完整性 217
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使用 OMNIC Paradigm软件确保数据的安全性和完整性

为确保数据的安全性和完整性并帮助您的实验室遵守 21 CFR 第 11 部分或其他法规，请将 OMNIC™ Paradigm软件

与 Thermo Scientific Security Suite 软件搭配使用。

Security Suite 是一个全面的数据安全工具集，允许您执行以下任务：

l 限制和控制对 OMNIC Paradigm软件和其他仪器应用程序中的功能和工具的访问。

l 设置和管理安全策略以确保正确的数据处理。

l 自定义和强制执行数字签名以建立责任。

l 记录和查看安全事件。

您可以购买 Security Suite 软件来管理单个系统或管理分布在网络上的多台仪器。安装后，只需片刻即可完成配置

OMNIC Paradigm应用程序的安全性。

有关 Security Suite 软件如何帮助您遵守 21 CFR 第 11 部分的讨论，请参阅 21 CFR 第 11 部分合规性。
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